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BEFORE YOU START - -    
 
** If you have just installed the FieldManager program, enter admin for the user 
ID and enter password for the password to access the program.  FieldManager 
will be the default datasource. 
  
**  No contracts are automatically in the contracts list when you load 
FieldManager for the first time.  In order to view some of the functions you must 
import a contract first BUT before you can import contracts, you must import the 
current reference file. 
 
**   Some screen prints in the users guide may be for a contract different from 
any of the practice contracts.  These prints were used simply so you could see 
an example of each topic. 
 
**  You can either import the contracts into the FieldManager datasource that 
already exists in FieldManager or you can add a Training datasource and import 
the contracts there.  If you add the Training datasource, you will also need to 
import the current ACP file, add yourself as a user, set your preferences, and 
import the reference file before importing a contract and entering information. 
 
 
It is my hope that someone who has never seen the FieldManager program will 
be able to successfully follow the instructions and exercises in this users guide, 
learn a lot about what can and can’t be done in the program, and have a bit of 
fun doing it. 
 
 
 
 
 

 
 Janet Wasteney 
  December, 2013 
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FieldManager - FieldBook 
 

FieldManager is the program that the FM user uses to document all 
activities pertaining to the contract.  FieldManager user is simply a term to 
designate the individual(s) who make entries in the FieldManager program not a 
newly created position dedicated to these functions.  The functions of the 
FieldManager user involve, among other things, contract documentation 
changes,  IDR’s (inspector daily reports), daily diaries (where working days are 
charged), contract modifications, stockpiles, estimates, and a multitude of 
inquiries and reports.   
 

Terminology Change -  
IDR’s include temperatures, weather, daily comments, time 
charges, and item postings.   

 
Daily Diaries combine temperatures, weather, comments, item 
postings, and time charges from all IDR’s for a given day and is 
also where sunrise/sunset information is entered. 

 
The FM user creates a daily diary for each day desired on the contract.  

This diary is made up of any and all IDR’s (Inspectors Daily Reports) that have 
been generated by the inspectors using FieldBook or the FM user using 
FieldManager.  There can be many IDR’s for a day because each inspector and 
FM user involved can create one or more for any given day.   There can, 
however, be only ONE diary per day per contract and that is created by the FM 
user in the FieldManager program. 

Besides creating a diary and importing IDRs from inspectors, it is also the 
FM user’s responsibility through the FieldManager program to create the 
stockpiles, change orders, and estimates.  These functions CANNOT be done in 
the FieldBook program. 
 

THERE CAN BE ONLY ONE WORKING CONTRACT IN 
FIELDMANAGER - IF THE SAME CONTRACT IS IN ANOTHER 
FIELDMANAGER COMPUTER, IT MUST BE READ-ONLY.  Except for unique 
circumstances, the workstation that process estimates (uploads and downloads 
them to and from the mainframe) should be the one with the working copy of the 
contract.  Any other FieldManager machines with the same contract should have 
a read only copy.     

As some entries are made, files are created automatically and placed in 
the FieldMgr\Outbox folder where they remain until processing time.  Do NOT 
transfer the working copy of the contract from machine to machine 
throughout the life of the contract just because you can! 
 

FieldBook is the program that inspectors use in laptops to create IDR’s to 
document certain activities pertaining to the contract.  This program contains 
several inquiries but no reports.  Any IDR’s created here are exported to 
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FieldManager by flash drive or by using the server.  FieldBook users CANNOT 
create daily diaries, contract modifications, stockpiles, or estimates.  They do, 
however, make entries to reflect item progress and charge working days as well 
as enter comments. 

. 
Once IDR’s have been created and exported from FieldBook and imported 

into FieldManager a turn-around-file (TAF) is automatically created which is given 
to the inspector to import back into FieldBook.  This turn-around-file updates 
FieldBook  so item progress is as current as possible.  Work can continue on all 
machines during the interim period between exporting and importing IDRs. 
 
The following chart might be helpful in showing exactly which functions each 
program can perform. 
 

 
 

 
FieldManager 

 
FieldBook 

 
IDR’s 

 
X 

 
X 

 
Daily Diaries 

 
X 

 
 

 
Cont Mods 

 
X 

 
 

 
Stockpiles 

 
X 

 
 

 
Estimates 

 
X 

 
 

 
Inquiries 

 
X 

 
X 

 
Reports 

 
X 

 
 

 
GENERATE - A mighty important word in FieldManager 

Unless an IDR has been generated, none of the documentation in it will be 
included in a diary. 

Unless a diary has been generated, the working day charge for that day 
will not be included in an estimate or the weekly report of working 
days.   

Unless an IDR has been generated, the item postings will not be included 
in an estimate. 

Unless an estimate has been generated, it will not be saved and/or 
processed for payment. 

Unless a weekly report of working days is generated, it will continue to  
have DRAFT across the report. 

 
 
Starting FieldManager -  

Find the blue and gold icon and double click on it.   FieldManager always 
begins with the Login screen.   
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 The Datasource field is a part of the log on process.  Do NOT change this 
field unless specifically instructed by Janet to do so.  The datasource will be 
entered during the installation of the program.  Having this datasource field 
named FieldManager is very important when using the Excel queries. 
 
For those who have been using FM on this computer - 

If you have previously been using FieldManager, the Datasource field will 
probably display FieldManager.  If that is the case, go ahead and log on as you 
normally do, using your own ID and password. 

 
If you have multiple datasources (unlikely for the DOT but possible), the 

name will be black.  You can put a checkmark to designate whichever 
datasource you want to have for the default.  Again, almost 100% of the time for 
DOT users the datasource name will be FieldManager – and that will be the 
default. 
 
 If you wish your ID to default as the user ID when you start up the 
FieldManager program, enter it in the ID box and then put a checkmark in the 
Default User ID field.  You can enter anyone here you wish but in order for this to 
work, of course, that user ID must be displayed in the users list for this 
datasource. 
 
For those who have had FM newly installed on this computer - 

If this is the first time you’ve logged on, FieldManager should be the 
default in the Datasource field.  Type in admin for the user ID and press the Tab 
key.  (It is important you log on with your own ID once we add you to the user’s 
list since this is the tracking method for entries.)    Type in password for the 
password and press the Enter key.  (Neither the ID or password are case 
sensitive.) 
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If this is the first time you’ve started FieldManager, no contracts will be in 
the list.  A practice contract does not come with the FieldManager program. 
 

(If you receive a warning that you must change your password, it is 
because the program requires the password to be changed every 60 days.   
Passwords must be a minimum of 5 characters.  More about changing passwords 
in that section of this chapter – now that’s a promise, not a threat!!!) 

 
You can see the user ID who is logged into FM and the datasource name 

by looking in the lower right corner of the screen. 
 
 
 
 
 

Loading a Contract   
We will load 2 contracts for use in this users guide.  The file name is 50a 

FM TrainingContracts.001..  This file can be found in the 50a Training folder which 
is located in the following path - 
W:\Highway\Construction\FieldManagerInformation\50a Training.  Feel free to 
COPY this file in order to import it into FieldManager.  Do NOT import it directly 
into FieldManager from the W drive.  Copy it either to a flash drive or somewhere 
on your hard drive (C drive) first and then import from there.    

When FieldManager imports a file containing contract(s), that file 
disappears from the source.  For example, once a contract has been 
imported from a flash drive, the file containing the contract will no longer 
exist on that flash drive. 

This 50a FM TrainingContracts.001 file will bring in both practice contracts 
at once.  
 
 
Do NOT use the Import-FB icon in the Window toolbar in the contracts list to 
import contracts.  That is for importing IDR’s from FieldBook. 
 
You will receive the following error if you try to import contracts prior to importing 
a reference file in a new datasource.   
 

 

 
 
 

December, 2013 Chapter 1 Page 5 
 



Click OK to the error and then import (File > Import > File) the file titled 
FMGRREF.REF from the 
W:\Highway\Construction\FieldManagerInformation\FMFiles folder.  If you do not 
have access to that location, contact Janet (641-782-2096) and I’ll get the 
reference file to you. 
 

To load the practice contracts into FM that you’ve copied to a flash drive from the 
W drive - 

At the Contracts List - 
Click File > Import > File 
If needed, change the “Look In” field to display E:\ (or the location 

of your flash drive) 
Click the down arrow and change the “Files of Type” field to either  

   Contract Files(*.*) or All Files(*.*) 
Highlight the 50a FM TrainingContracts.001 file   
Click Open and the import process will begin 

Once the import process is complete the new contracts will 
appear in your contracts list AND will disappear from the 
source, in this case the flash drive 

Click OK at the import message displaying the contract(s) that were  
 imported 

 
Once the contracts are imported, notice that in the bottom left corner of the 
screen that the status bar will reveal the number of rows (1 row per contract) 
seen as compared to the total number.  If not all contracts can be seen at once, 
there will be a scroll bar available.   The lower right will reveal the user logged on 
(ADMIN or your own user ID) and the datasource (FieldManager) in use. 
 
 
Janitorial Issues - 

 

 
 
 
Contracts Screen 

The contracts screen is always the first screen to appear when you logon 
to FieldManager.  This is a list of all contracts available for your use on your 
computer.  The column titled “Closed” indicates whether a final estimate has 

December, 2013 Chapter 1 Page 6 
 



been created – Yes means a final has been generated and a No means a final 
has not been generated.   

The Access column indicates whether the contract is a working copy, a 
read only copy, or a contractor read-only.  If the contract was imported as a read-
only copy, it will display read-only in the Access column.  If the contract was 
imported as a working copy but that working copy was transferred and a read-
only copy was kept, the Access column will display read-only followed by the 
date the working copy was transferred.  Contractor Read-Only will be displayed 
only for those contracts that were imported as the contractor read only copy.   

The farthest right column, Prime Contractor, displays the prime 
contractor’s name. 

 
A contract CAN be in more than one FieldManager computer at once BUT 

there can be only one working contract.  The same contract on another 
workstation must be read only. 
 The Managing Office Comments field comes from the field with the same 
name in the Docu button > Gen tab and is a good place, if desired, to enter the 
inspector’s name and/or paren nos. if a multiple project, etc. 
 
 
Bars  

This, like many Windows programs, has a menu bar but it also has two 
button toolbars.  The menu bar has the same choices as other Windows 
programs.  It is located above the top button bar and contains File, Edit, View, 
Utilities, Window, and Help. 

By default the Window toolbar is just under the menu bar across the top of 
the screen.  (This is called a Window toolbar because the buttons available are 
dependent on the window that’s open.)  The Close button is always in the far left 
corner of every screen and the Cont Status button appears somewhere in this 
toolbar with every window except Inquiries.  The Refresh button is always the 
farthest to the right of every screen.   The other buttons, as mentioned before, 
will change depending upon the window that is active at the time.  

The Application toolbar is by default along the left side of the screen.  
These buttons remain the same no matter what window is active.   

You can change the position of either button bar by choosing Utilities > 
User Preferences and then clicking on the Toolbar tab.  Here you can also 
choose whether or not to have the text of the button bar shown and whether or 
not to have the tips shown when you place your cursor over a button. 
 
 
The Quick Query Fly-Out Toolbar Button 

There is a narrow “button” just to the right of the Cont Status button.  If you 
click the down arrow in that area, depending on the screen that is active at the 
time, other inquiry options will be available immediately.  These same inquiries 
plus more are available through the Inquiries button - this is just a quick and easy 
way to access some of the more popular ones. 
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If you always like to view a specific inquiry for a screen, there is a default 
option for that.  Details in the User Preferences area of this chapter. 
 

Highlight Contract 78-0061-114 
Click the Items button (on the left) 
Click the fly-out button and see all the options!!!! 
Click the Close button 
Click the Estimates button (on the left) 
Click the fly-out button and see other options 
Click the Close button 
Click any of the other buttons in the Applications toolbar then the fly-out  

button. 
Several applications buttons have only the Cont Status available 

when selecting the fly-out button. 
Close all windows and return to the contracts list. 

 
 
To Add, Modify, or Delete Users 
 
 

In order to add, modify, or delete a user you must be logged on with an ID 
that has system administrator privileges.   No other type of user is allowed to 
maintain users.  There should be only 1 to 3 in each office with system 
administrative privileges. 
 

Users can be added, changed, or deleted in FieldManager by clicking 
Utilities in the menu bar and then selecting System Management > Maintain 
Users.   

 

 
 
Anyone who is using the program should have his or her own ID and 

should log on with that ID.   Unless a user has been added to this list, his/her 
name will not appear in the drop down list of inspectors when creating an IDR, 
diary, etc. in FieldManager.  More importantly, if the user is not listed in the 
FieldManager datasource, that ID and password is not exported with the contract 
to FieldBook so the user is not allowed to log on to the FB program. 
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As noted previously, neither the user ID nor the password is case 
sensitive.   
 
To add, modify, or delete a user 
 
 It is important to have all your FieldManager and FieldBook users ID’s and 
passwords listed in the FieldManager datasource.  Be consistent when assigning 
user ID’s and, for ease, enter the same password (e.g. password) for everyone 
when you add a new user.  Each user should then change their own password 
the first time they log on to the program. 
 When a contract is exported from FieldManager to a FieldBook machine, 
all the user ID’s and passwords in that contract’s datasource are exported along 
with the contract information. 
 

Since you are logged on with system administrator privileges click Utilities 
> System Management > Maintain Users.  This will bring up a list of the users 
and their respective security level assigned to the FieldManager datasource you 
are in.   If your name is not in this list, we will add it shortly!!   (If System 
Management is gray, you are not  logged on as a system administrator and do 
not have access to this function.) 

 
 
To add a new user - 

Click the Add button.   
 

 
 
 
 
 

 
 
 
 
 
 
 

This will bring up the Add User form which must be completed.  Enter the 
following information for a new user, pressing the Tab key to get to the next field. 
 

User ID - jdoe 
User Initials - JD (Can be 2 - 4 letters &/or digits) 
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If you enter initials that are the same as someone already listed as 
a user, you’ll be asked before exiting to change them to 
make them unique.  

User Name - John Doe (this is entered last name first) 
Type the user name exactly as you wish to see it printed on reports,  
etc. 

Phone No. - is not a required field - I usually leave it blank 
Password – type in password (must be a minimum of 5 characters - can 

be letters, numbers or a combination) 
Re-enter Password –type in password (type in your password again) 
Security Level - Highlight “FieldManager User” from the list of 4 levels of 

security 
 

FieldManager User - Has read/write access to everything in the 
system excluding the User information. Cannot transfer a 
working copy of a contract or import an ACP file 

FieldBook User - Has read/write access to FieldBook functionality 
and read access to the rest of the system except the User 
information.  (Can add or change data ONLY in the 
FieldBook functions of the FM program.   

Read Only - Has read only access to the entire system except the 
System Management options.      

System Administrator - Has read/write access to everything in the 
system, including the user information.  Can transfer a 
working copy of a contract.  Can change contract level 
settings.  Can import the Agency Configuration Program file 
via a menu option. 

 
As stated previously, user ID and/or initials cannot be the same for any 

two users in the FieldManager and/or FieldBook program.  If you enter either a 
duplicate set of initials or a duplicate user ID, you’ll get the following message. 
 
 
 
 
 
 
 
 
 
 

Click OK 
 
 
If you’re not already listed as a user, we’ll add you now! 

Click the Add button and enter the following information. 
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User ID - your name 
User Initials - your initials 
User Name - your full name 
Phone No. - your decision, enter something or leave it blank! 
Password - type PASSS for a password (Remember, it must be a  

minimum of 5 characters) 
Re-enter Password - type in your password again 
Security Level - Select System Administrator 

When finished, click OK and then close back to the Contracts list 
 
Click File > Exit and Log On as Different User 
Answer NO to the back up question 
 
This time log on using your own ID and password.   

You will be required to change passwords to begin the 60 day count.  
Change it from PASSS to your choice of passwords.  Be sure to remember it! 
 
 
To change user information - 

Click Utilities > System Management > Maintain Users 
Highlight the user you wish to change - We’ll highlight John Doe 
Click the Change button - this brings up the Change User Information form 
We’ll change John Doe’s security level so.. 

Click the Security Level field 
Select FieldBook User 

Click OK 
Stay at the users list 

 
 
To delete a user - 

Be VERY cautious about deleting a user from the list for any reason.  It’s 
much safer to change the user to a read-only status instead for contracts in 
progress.  Once all contracts involving that user are completed the user ID can 
be safely deleted. 
 Highlight the user John Doe 

Click the Delete button 
If you are sure you wish to delete this user, click Yes 
Close back to the contracts list 

 
 
 
Setting Preferences - 

From the menu bar select Utilities > User Preferences.  A screen with 
multiple folder tabs appears.  You will notice folder tabs being used throughout 
the program to separate and organize.  We’ll check out each folder tab on this 
screen before we quit!! 
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General Folder Tab – 
 

 
 
 

The Default and Current Datasource fields cannot be changed here. They 
should be displayed as FieldManager. 

 
The Default Database Backup Location is listed automatically based on 

the program installation.  You may or may not need to change this – check with 
Janet before changing it.  This program is written to back up first to the C drive 
and then give you the option to copy that backup information to another location.  
We’ll work on this one later!! 
 

If you wish the program to confirm when you exit FieldManager, click so a 
checkmark appears in the Warn User When Exiting Application.  If you do not 
wish this confirmation, leave the box blank. 
 
Click the Window Settings folder tab. 
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Window Settings Folder Tab – 
 

 

 
 
 
Include column headers in a copy  

Leave a checkmark in this box and any time you copy and paste 
information from columns, the column headers will automatically 
copy as well. 

Save list window settings when closing list   
Be sure a checkmark is in this box and anytime you change the 
size of a column, sort a list, etc. those preferences will stay until 
you change them again. 

 Save modal window settings when closing list 
  A modal window is a “window within a window” such as when you  
  currently view a second smaller version of the items list.  Be sure a  
  checkmark is in this box and anytime you change the size of a  
  column, sort a list, etc. those preferences will stay until you change  
  them again.   
 Save built-in filter settings when closing list. 

This would be good to have checked under certain conditions.  For 
example, if you’re working on only certain items on a contract (e.g. 
only items in a specific project and/or category) and you filter the 
lists so you see only those items, this option will keep that filter until 
you remove it. 
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Click the Entry Defaults folder tab.  
 
 
 
 
Entry Defaults Folder Tab - 
 

  
 

If you prefer that the last entered station or location fields in your item 
posting entries remain in those same fields for the next posting no matter what 
item it is for, you should have a checkmark in the box.  If you want those fields to 
be blank each time, leave the box without a checkmark.  (There MUST be an 
entry in either the Station or Location field for each item before you can save an 
IDR.)  For now, put a checkmark in the Station and Location fields… box.   

If you prefer that the last remarks you entered remain in that field for all 
future items, you should have a checkmark in that box.  Although this might be 
handy during audit times, it is normally not something you would want so be sure 
there is no checkmark in that field.   

Since we are not using the materials portion of the program, it doesn’t 
matter if those 5 options are checked or not. 
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Import Folder Tab - 
 There is a default location for importing IDR’s from FieldBook.  If you want 
a different location to automatically appear in your drop down list, that location 
can be added here.  This list of locations is automatically updated when a user 
types in a new location while performing an IDR import.   We’re not going to do it 
now but if you need to add a new location -  
 Click the Add Location button 
 Enter the new location 
 Click OK 
 
 
Export Folder Tab – 
 There is a default location for exporting contracts to FieldBook.  If you 
want a different location to automatically appear in your drop down list, that 
location can be added here.  This list of locations is automatically updated when 
a user types in a new location while performing an export to FB.  We’re not going 
to do it now but if you need to add a new location -  
 Click the Add Location button 
 Enter the new location 
 Click OK 
 
 
Toolbar Tab – 
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This tab gives you the option to locate the toolbars other than where they 
currently are shown.  By default the application toolbar is in a vertical position on 
the left side of the screen and the windows toolbar is in a horizontal position 
across the top of the screen.    
 By default there is a checkmark in each of the 2 options, 1 to display the 
button text and the other to display the power tips.  If you remove the checkmark 
to display the button text, only the “picture” will remain in the button – no words.  
If you remove the checkmark to display the power tips, when you move the 
cursor over top of a button, it will not display what that button is used for.   
 It is an extremely good idea to leave this tab as is – at least until you 
become very familiar with the program. 
 
 
Inquiries Tab – 
 You have the option to sort inquiries that contain a list of items.  The sort 
choices are by – Item Description, Proposal Line Number, and Item Code.  
Simply put the dot in front of your choice and that will be the sort order for every 
contract until you change it to something else. 
 If you consistently like to view a specific inquiry that is displayed in the 
quick query button when a screen is active, put a checkmark in the Save Quick 
Queries Selection option.  An example of this – when I look at the stockpile list, I 
always use the SP Summary inquiry.  By having a checkmark in the option, the 
SP Summary button would be displayed instead of the Cont Status button. 
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 Click OK.  Changes you made in all the tabs will now be saved. 
 Remember, all preferences chosen are only for the user logged on to the 
datasource in use.  A different user can have different preferences in that same 
datasource. 
 
 
To Change Your Password - 

Once you have initially installed the FieldManager program you will need 
to login using admin as the user ID and password as the password.   Once you 
have done that, the first thing you should do is add yourself as a user and enter 
your password as explained on a previous page.  You are not to share this 
password with anyone else.  

Passwords must be changed every 60 days and must be a minimum of 5 
characters in length.  You will receive a warning beginning 10 days prior to the 
deadline for changing your password.  If you do not change it within the allotted 
time period, the next time you log on to the program you will be required to 
change your password before continuing. 

To do so - 
Click Utilities in the menu bar then Change Password.  
    

 
 
 
 
 
 
 
 
 
 
 
 
 

You must type in your current password once and then your new 
password twice.  If the new password isn’t exactly the same each time it’s typed, 
you’ll be given an error message stating so.  If that happens, simply start that 
process again - and type it in correctly both times!!!! 

We’re not going to change the password now so click the Cancel button 
 
The inspectors’ IDs and passwords are first entered in FieldManager and 

then exported with the contract(s) to FieldBook.  The inspector can then change 
his/her password in FieldBook using the same process as described above.   

 
  Assigning Your District Number 
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This number distinguishes your program so it’s unique for your office.  A 
working copy of a contract will not import into your machine unless the 
entry in the District Number matches the code in that contract’s file.  A read 
only copy of a contract will import whether or not the district number matches. 
 

Click Utilities > System Management > System Configuration 

 
 

Once you first receive your new program, you should enter your District number 
and cost center in the District Number field in the General Folder tab.  (For the 
Council Bluffs Office which is in the 4th District and is Cost Center 5242, the 
District Number is 45242.  For the Jefferson Office which is in District 1 and is 
Cost Center 5213, the District Number is 15213.)   Also check to see that the 
inbox, outbox, and archive paths are C:\ProgramData/FieldManager\Inbox, 
C:\ProgramData/FieldManager\Outbox, and 
C:\ProgramData/FieldManager\Archive, respectively. 
 
Notice in the upper right corner, the date the reference file was last created and 
imported is displayed.  Also shown are the ACP creation and import dates.  The 
ACP dates won’t be important to you on a daily basis – but sooner or later this will 
be good information to have available. 
 
We will not be using the FieldNet option so skip this folder tab. 
Click OK and you should return to the contracts list. 
 
 Program Shutdown 
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Once the FieldManager program has been opened, if it is idle for 180 
minutes, the program will shut down.  Any unsaved data at the time of 
the shutdown will be lost.    By clicking the mouse anywhere on a 
screen, the 180 minute count will begin again.  You will receive a warning 
60 seconds prior to the shutdown – just in time to enter your password 
again so you can continue!! 
 
BE AWARE OF THE 180 MINUTE SHUT DOWN SO IF YOU GET 
CALLED AWAY, ETC., YOU WILL NOT LOSE DATA. 

December, 2013 Chapter 1 Page 19 
 



FieldManager Cruisin’ 
Let’s get acquainted with some of the buttons now that we have some 

contracts imported.  Remember, the buttons in the Application toolbar (along the 
left side)  will always remain the same but the buttons in the Window toolbar (top) 
will be completely dependent on which screen is active.   

Many screens will be divided into areas by the use of folder tabs. 
 

Highlight Contract 78-0061-114 in the contracts list. 
We’ll explore the Application toolbar (left side) first. 
Click the Docu button 

 
 
Docu Button - 

 
This shows the contract documentation and is divided into areas by five 

folder tabs.  We’ll look at each field in each folder tab now but will make entries 
later.  
 
General Folder Tab - 
 

The information in the top portion of the screen is read only and is updated 
through the FieldManager processes.  Some information can be entered and/or 
changed in the lower portion of the screen. 
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Managing Office - This is the RCE office, county, or consultant that is 
responsible for the inspection and payments to the contractor.  

Managing Office Comments – Whatever is typed here will be displayed on  
the contracts list screen.  A good place to enter data of your choice 
but can also be left blank if desired.   

 
Construction Started Date - This is the date physical work actually  

began on the project.  Please enter this date even though is it not  
required by the program.  The date entered here will be displayed  
in the corresponding field on the weekly working day report. 

Closed to Traffic Date – Enter the date the project was closed to traffic if 
you wish.    

Open to Traffic Date – Enter the date the project was opened to traffic 
All Contract Work Completed - This is the date all the actual physical 

work on the contract was completed.   This is NOT necessarily 
the project acceptance date.   (This date must be entered before 
generating a semi-final estimate.)   

Traffic Comments – This optional field will hold 255 characters of text  
 
Create Electronic Files - The default is Yes and it can’t be changed 
StandAlone Contract - THIS DEFAULT MUST STAY AS IT IS  

If you change this to Yes and save it, you will not be allowed to 
change it back!  (Only System Administrators have access to 
change this.) 

Contract Closed - The NO default stays until a FINAL estimate is 
generated.  At that time it is automatically switched to YES.  Once 
this field is YES, the contract is locked and no more work can be 
done on it.   

  If, for some reason, the final estimate has been generated 
but is incorrect and must be re-done, you must click the No, then 
Save/Close before deleting the final estimate.  The rollback file that 
is created during this process must also be deleted.  You are to 
call Janet, Central Const., or Jen in the Creston Const Office 
(641-782-4518) before changing the field from YES to NO. 

View IDRS in FieldBook for ____ Days - This is the number of calendar 
days you want IDRs available for viewing in FieldBook.   The 
default number is 9999 but can be changed from one contract to 
another.  Be aware, the number of days to be viewed is calendar 
days and is based on the computer’s date - - 15 days from the  
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 computer date is far different from the last 15 entries made 
irregardless of the entry date.  The number of days that IDR’s are 
available for viewing determines how much inquiry information can 
be viewed in FB. 

 View IDR Attachments in FieldBook for _____Days – This is the number  
of calendar days for which you want to be able to view attachments  
in FB.  This can be changed from one contract to another.  The  
default number is 14. 

 
 
 
Contract Level Settings Button – (see graphic below) 
 If you are a system administrator and your program has been set up to allow for 
contract specific changes, you can access this button.  Any changes you make 
are strictly for this contract only, they will not affect any other contract in 
FieldManager. 
 

  RCE OFFICES - Do NOT make any changes to the General tab except 
in the Report Item Sort Order and/or the Group Items By Project/Category.  
Again, do NOT change any other fields in this tab. 

 COUNTIES – You can change the above and also put your agency logo, 
if desired, in the General tab.  Do NOT change any other fields. 

EVERYONE –  Do NOT change the option in the Quantity Overruns 
fields or the Proposal Line and Project Line  increment for new items fields.  
There could be very nasty results if changes are made in these areas. 
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Click the Estimates tab 
 
Do NOT make any changes to the Estimate Signature Block TEXT in the 
Estimates tab.   (see graphic below) 
 

 
  
If you prefer that a signature label displays something other than the default for a 
specific contract, you can change it here.   Remember, the changes you make 
here affect only the contract you’re working with at that time but will remain for 
that contract until changed again. 
 
RCE Offices – do NOT make changes in the estimate signature labels or the 
block text area 
 
Click the Cont Mod Signatures tab - 

 
Some changes such as the signatures required can be made in the cont 

Mod Signatures tab (the graphic is on the following page).  Once again, 
remember, the changes you make here affect only the contract you’re working 
with at this time.  
 
Counties – you may wish to change a signature label.  If you unsure as to 
which one or what to do, contact Janet, Central Const, or Jen in the 
Creston Const Office (641-782-4518). 
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RCE Offices and Counties - 
 Do NOT make any changes to the Contract Modification Signature 
Block TEXT. 

 

 
 
Since we didn’t change anything, click Cancel and return to the General tab of 
the Docu button 
 
 
Administrators Tab – 
 The upper portion of this tab is in blue and is the same as what is 
displayed on the General tab.  Three fields that were previously on the General 
tab are now located here - -  
 RCE or County Engineer’s Name – This should be the RCE’s (or county 

engineer’s) name.  This name will print out automatically at the 
bottom of the working day reports so type it in as you wish to see it 
in print. 

 Managing Office – The city or county of the office handling this contract.    
  This is already completed for you. 
 Inspector – The lead inspector main inspector on the project 
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New fields that we have added to this tab are optional so you may or may not 
enter data in them.  They are strictly for your convenience so populate and use 
them accordingly.   
 Accounting ID 
 Letting Date (LD) / Bid Order No (BON) 
 Late Start Date 
 Wage Decision – enter the wage decision number 
 Liquidated Damages – enter the LD rate/day or total LDs due – your  
  interpretation of what you want to see. 
 Status of Audit 
 Final Quantities to Contractor 
  
 
Site Times Folder Tab – 
 

This shows both the original and the authorized number of working days 
allowed for each site on the contract as well as any additional number of days 
that might be pending due to a time extension contract modification.  The original 
number of days will be the same as the authorized unless a time extension cont 
mod has been approved to increase that number.   The total days charged in 
FieldManager and in estimates are also displayed on this screen. 
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 The Time Charges Start Date should be entered for each site.  If it’s not 
entered, you’ll receive a warning when each estimate is created.  This date is the 
first day you charge a working day.  When a time charge start or stop date is 
entered and saved, a file is created automatically and put in the FieldMgr\Outbox 
folder.  The filename is STDTSxxx.EXP. 

 
  

 
If there is an entry in the start date field and then you change it to a 

different date and press the tab key, you will immediately get a warning.  Simply 
click the Yes and continue - it should be OK!!   If you have a contract that does 
not have any working days to charge (only has a completion date) and are 
concerned, call Janet, Central Const, or Jen in the Creston Const Office (641-
782-4518) and discuss it. 
 
Breakdowns Folder Tab - 

This is a method of dividing items out further than the category level.  For 
example, if you wanted all items broken out according to plan sheets, this could 
be possible.  The bonus is that you can see exactly where each item is going 
BUT you must know exactly the amount of each line item that is going to specific 
places and enter them accordingly.   We will NOT be using this feature at this 
time. 
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Site Events Folder Tab - 

This is a list of events that may affect any or all sites on the contract.  
Perhaps the contract must be suspended for a period of time due to 
circumstances beyond the contractor’s control.  That event could be entered 
here.   This is an optional entry - not required.   Be aware, once a site event entry 
is created and saved, it cannot be deleted.   The Delete button is grayed out 
once the site event has been saved.    

Once a site event is created and saved, a corresponding file is 
automatically created and put in the FieldMgr\Outbox folder.  The filename is 
STEVTxxx.EXP. 
 
Attachments Folder Tab - 
 An attachment can be added here.  The attachment can be a file that has 
already been created or something that is created with another program on this 
same machine.  All attachments are kept in the FieldManager program, whereas 
only a limited number are kept in the FieldBook program. 
 
Click the Close button (do not save, if asked) and return to the contracts list. 
 
 
Contractors Button – 
 

 
This is the screen where subcontractors are added or deleted to the  
contract (the prime will always be there).  Our graphic shows that  
Cedar Valley Corp. is the prime (it’s displayed in bold, italicized print) and  
there are 7 subcontractors listed.    
 
 

Using the .CON File - -  
 Contractors must furnish a .CON file for each of their contracts that has a 
subcontractor.  This file contains all their subcontract information, including the 
items linked to each sub.   When your contract is ready (inited) you will be given 
this file. 
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 After you have imported the new contract, import (File > Import > File) the 
.CON file that has been given to you.  You can see that this automatically 
populates the subcontract $ amount fields and links the appropriate items when 
you highlight a sub and click Change or double click on it.  You must enter a work 
type code from the drop down list for each contractor displayed so it is displayed 
on the contractor evaluations. You will need to enter the address if you wish it to 
be displayed. 
 If you receive a late subcontract request, the prime contractor must submit 
a revised .CON file.  You import that file, print the import report offered when the 
import is complete if you wish, and then forward it to the Office of Contracts after 
the RCE has authorized it. 
 The only time you should receive a paper subcontract report is when it 
involves a new item to the contract being done by a subcontractor. 
 If you print the .CON file, a cover sheet will also be printed that gives you 
a total for all subs.  Much more about the .CON file in Chapter 8. 

 
 
To Add Subs by Hand - -  
 To associate a subcontractor to a contract you must select the 
subcontractor’s name from the master list which you can view by clicking the Add 
button.   If the subcontractor is not in the list, that sub cannot be added until the 
Office of Contracts adds them to the list and you import an updated reference file 
into your FieldManager program.  In other words, you cannot type in a 
subcontractor’s name – you must select it from the list.  If you are sure that a 
subcontractor should be in the list but is missing, call Janet.  The sub might 
have been added since our current reference file was created so once a new 
reference file is created, we can check it to be sure that subcontractor is there.  
Once we know it’s there, you can import the new reference file into FieldManager 
and then continue adding subcontractors. 
 
 Once you have selected a subcontractor from the list, the General tab of 
the Add Contractor screen will be displayed.  Here you enter the sub’s address, 
work type, and dollar amount of the subcontract.   
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To link additional items to a subcontractor, click the Items folder tab, click Add,  
and highlight  the item(s).   All items added by contract modification will be added 
to the appropriate contractor at the time the item is selected in the cont mod. 
  
Close back to the contracts list and do not save, if asked. 
 
IDRs Button 
 

 
 
 This is a list of IDR’s (Inspector’s Daily Reports) created to date in 
FieldManager and/or created in FieldBook and imported into the FieldManager 
machine. Since each inspector on a project can create one or more IDR’s each 
day, there may be several IDR’s listed for an inspector on any given day.  If that 
is the case, as displayed in the graphic, the first one created will be Sequence 1, 
the next will be Sequence 2, etc. 

The column titled Gen indicates whether or not that IDR has been 
generated.  Since all IDRs must be generated before they can be exported from 
FB, any IDR that has been imported from that program will have Yes in the 
Generated column unless it has been revised and saved but not generated again 
in FieldManager.  If the IDR was created in FieldManager, the IDR must be 
generated in that program.  None of the information contained in an IDR will be 
included in an estimate unless the IDR has been generated 

If the IDR contains an attachment, the number of them in that IDR will be 
displayed in an Attach column.  If no attachments, a 0 is displayed. 

To see details of a specific IDR, highlight that day then click Review in the 
Window toolbar.   
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When reviewing (not changing) an IDR, if there is not room for all the 

Comments to be displayed, double click on  <<more>> and the entire comment 
field will be displayed along with a scroll bar if needed. 

 
IDRs created in FieldBook and imported into FieldManager can be revised 

by any FieldManager user.  All information in any generated IDR can be modified 
up until that IDR is included in an estimate.  Once, however, an IDR has been 
included in an estimate only information NOT pertaining to the quantities paid 
can be changed.  For example, you could change the weather field but you could 
not change the quantity field in the item posting. 

 
Click the Close button (twice probably) to return to the contracts list. 

 
  Contract 78-0061-114 should still be highlighted. 
 
 
 
Diaries Button 

 
The diary is a compilation of all IDR’s for a given date.  The first 

screen shows a list of all diaries that have been created to date.  There can be 
only one diary per day per contract.   

If the diary contains an attachment(s), the number of them in that 
diary will be displayed in a new Attach column. 

Like the IDR screen, the Gen column shows whether or not that day’s 
diary has been generated.  A diary must be generated in order for the working 
day charge for that day to be included in an estimate and to be displayed in the 
weekly working day report. 
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Information in the diary can be modified at any time but if the diary has 

already been generated, saving those changes will change the status to un-
generated.  Once the diary has been saved, simply re-generate it. 

After a diary date has been included in an estimate, a time charge 
adjustment may be done ONCE for any original working day charge.  After that 
the Adjust Time Records button near the bottom of the Site Times folder tab is 
gray and is not available for use for the original charge BUT you can adjust the 
adjustment! .  BEFORE the time  adjustment can be made, however, you must 
first delete every site’s Weekly Report of Time Charges report including that 
date.  If you forget to do so, the message shown below will be displayed. 

 

 
 

Click the Close button and return to the contracts list. 
 
Contract 78-0061-114 should still be highlighted. 
 
 
 
 
Items Button 

 
This shows a list of all items in the contract, both original items and those 

added by contract modification.  If a new item was added by contract 
modification, the cont mod number will be displayed in the far right column titled 
Cont. Mod. Number.   By default, the Initial Quantity will be just to the right of the 
Authorized Quantity column.   Those 2 numbers will be the same unless the 
item’s quantity has been increased or decreased by contract modification. 

The items viewed can be limited based on the selection in the Project,  
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Category, and Contractor fields near the top of the screen.  The data in the items 
screen is updated automatically by the program and is as current as the last 
entry generated, the last IDR imported, and/or the last estimate processed, 
depending on the column you’re viewing. 
 

 
  Viewing Item Selection 

If the contract has more than 1 project, All will appear in the Project field.   
If there is only 1 project, that project number will automatically be in the Project 
field.  Notice our contract shows the project number in the Project field so we 
know there is only 1 project in this contract.   

If there are more categories than 1, All will appear in the Category field.  If 
there is only 1 category, the Category field will show 0001.  Notice that the 
Category field shows All.  That indicates to us that there are multiple categories 
associated with the project.  Click the arrow by the Category column and a list of 
all categories associated with the selected project will be shown.  Click anywhere 
outside that drop down box and it will disappear. 

If you select a specific project from a multiple project contract and a 
specific category, only those items associated with both will appear in the list.  
Similarly, if there is only one project in the contract and you have All in the 
Category field, the list will show every item in the contract.   

“All” will be displayed in the Contractor field whether you have associated 
subcontractors to the contract or not.  Until subcontractors have been linked to 
specific items, all items will be linked only to the prime contractor.  Once, 
however, subs have been linked to specific items, you can select a subcontractor 
from the Contractor drop down list and only those items linked to that 
subcontractor will be displayed. 
    
 Changing Columns 

The width of the columns in either the list windows or the modal windows  
can be increased or decreased by placing the cursor in the header on a solid 
vertical line.  Once the cursor turns to a crossbar you can drag the line to either 
increase or decrease the width of the column.   Columns can be moved from one 
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location to another by clicking once in the header of the desired column, holding 
the left mouse key down, dragging the column to the new location, and letting go.   
If there is a checkmark in the Save List Window Settings When Closing List and 
the Save Modal Window Settings When Closing List options of the Utilities > 
User Preferences > Window Settings folder tab, the changes you make to the 
columns will remain that way until you change them again or click the Reset 
Settings button.   If you click the Reset Settings button, all preferences will revert 
to the program defaults for that option. 
 
 
Sorting 

Items can be sorted in any column by double clicking in the header of that 
column.   The first sort will be done in ascending order.  If you double click again 
in the same header the order will be reversed (descending).  If you chose  to 
save the settings as an option when you were in the Utilities >User 
Preferences>Window Settings folder tab area, the changes you make will remain 
until you change them again.   

The Find field which is found just below the Contractor field will be 
dependent on which column you use to sort.  In other words, if you sort the list by 
Item Description, it will be Find Item Description.  If you sort the list by Proposal 
Line Item No., it will be Find Prop Line. 
 
 
    Searching (Find) 

If the item list is lengthy the Find field can be helpful.  The search will 
begin as soon as you type in the first digit or letter of the requested information.  
Remember, the Find field is dependent upon which column was used for the sort 
– as described above. 
 
 
If it isn’t already, have “All” displayed in the Category and Contractor fields. 
 
 
    Filter 

If you do not want to see the entire list you may want to create a filter so 
only items meeting certain conditions will be shown.  This filter can be kept 
permanently or used only temporarily, whichever you prefer. 
 

We’ll create a temporary filter for practice  
Click the Filter button. 
In the Column field, select Item Description from the drop down list 

or with the Column field blue, click the letter I three times 
In the Operator field, select Contains from the drop down list 

or with the Operator field blue, click the letter C 
In the Value field, type SILT (This is NOT case sensitive) 
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Click the OK button and a list of only the items containing the word silt will 
be shown 

Click the arrow beside the Filter field and select <Show All> to see the 
entire list of items again 

 
If the Category and Contractor fields aren’t still displaying All, change them so 
they are.   Highlight Line No. 0420 and click the Change button (or double click 
on Line 0420).  This will bring up the - 
 
 General Folder Tab - 
 

A list of all projects and/or categories that contain (there will be a 
checkmark)  that line item is listed in the lower portion of the General Folder tab 
screen.  The top portion of this screen shows data for that line item based on the 
entire contract rather than a specific category.  

 
 

 
 
   Documentation Folder Tab -   

(Graphic on following page) 
 
When work on an item is completed, it should be noted on this folder tab.  

Click the Yes radio button if work on the item has been completed; otherwise, 
leave the choice as No, the default.  All items must be marked as complete 
before a final estimate can be created for a contract. 
A more efficient method if you have several items to be marked as complete at 
once is –  

Click the Items button  
 Highlight each item to be marked complete (Hold the Control key  

down as you click on each item)  
Click Edit > Mark Items Completed 
Answer OK to the warning and the “Are you sure” question 
The No will change to Yes in the Item Cpt column. 
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There is an area for documentation and another for notes on the Documentation 
folder tab.  Both are available but not required.  If an item is added by cont mod, 
the reason entered for that item will auto populate the Notes field on this 
Documentation tab. 
 
If you want to mark this item for Attention, an explanation is required in the Notes 
field.  An item that is marked for attention here will have a checkmark in the Atten 
column of the Estimate > Item Usage folder tab when that item is included in an 
estimate. 
 

 
  
Materials Folder Tab & Breakdowns Folder Tab 

We will not be using these folder tabs.      
   

 
Contractors Folder Tab 
 (Graphic on following page) 
 

By default, all line items are linked to the prime contractor.  We previously 
acknowledged that, eventually, items will be linked to subs automatically when 
you import the file you’ll be given at the time of the contract’s init.  You can also 
associate items to subs in this location.   Whether you link here or at the 
Contractors button, you are expected if not required to do so.  There are many 
helpful reports that can be accessed and created by linking items and subs that 
could prove to be very helpful due, for example, to the prompt payment 
requirements.    

More than one subcontractor can be associated to each item if needed.   
A contractor field has been added to every form so each time a posting is made 

December, 2013 Chapter 1 Page 35 
 



for an item, a contractor must be selected.  If only one contractor is linked to that 
specific item, that name will automatically populate the contractor field.  If more 
than one contractor is linked to an item, the user must select the appropriate 
contractor for that posting before being allowed to save the entry.  

If the wrong contractor was associated to the item when it was added by 
cont mod, that association can be removed here and added to the correct 
contractor. 
 

 
 
Close back to the contracts list 

 
 
 
Materials Button 

Although there is a materials section available with FieldManager, we will 
not be using it at this time. 
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Contract 78-0061-114 should still be highlighted 
 
 
Stockpiles Button 

This screen lists all stockpiles created for the contract and shows the 
dollar amount remaining in the stockpile.  A final estimate will alert you if there is 
a balance remaining in the stockpile.  The balance must be zero before a final 
can be created and processed.  
 

 
The stockpile can be modified at any time and can even be deleted UP UNTIL a 
payment involving it has occurred - after that it can’t be deleted - only modified.   
The stockpile wizard steps you through entering the required information screen 
by screen. 

Close back to the contracts list. 
 

 
Estimates Button 

This screen lists the estimates that have been created for this contract.   
The term estimate is used with the contract.  Voucher is the term used for project 
payments.  The total of all the vouchers equals the estimate.  If there is only one 
project in the contract, the dollar amount for the estimate and the voucher will be 
the same. 

 

 
 
The Status column displays whether the estimate is Exported or 

Refreshed.  If the status is Refreshed, the estimate has been created, processed, 
and the turn around file has been imported into FieldManager.  If the status is 
Exported, the estimate has been generated – it may or may not have been 
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processed yet – but the turn around file has not been imported into FieldManager.  
You cannot create another estimate until the previous one has a status of 
Refreshed.   If you have a status of Exported but you are sure that you have 
processed the estimate and you need to create another estimate, call Janet,  
Central Const, or Jen in the Creston Const Office (641-782-4518).  Probably 
giving you a download file from CPS to import into FieldManager will take care of 
the problem. 

 
Another method to check to see if the estimate processed correctly is by clicking 
the Cont Status button.    

 
 If the Amount Paid to Date (FM) is the same as the Amount Paid to Date (CAS), 
the estimate created in FieldManager (FM) has been sent to, processed by the 
mainframe, and imported back into FieldManager.  If the FM number is larger 
than the CAS number, either the estimate has not yet been processed by the 
mainframe or it has been processed but not yet imported back into 
FieldManager.  Only when you have created a negative estimate in FM will the 
CAS number be larger than the FM number!  If that happens, check with Janet, 
Central Const, or Jen in the Creston Const Office (641-782-4518) before 
continuing.   
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See the last couple of pages in this chapter for more details. 
 
The lower portion of the cont status screen (not seen in the graphic) reflects the 
amount paid for original and contract modification items as well as the working 
days charged for each site 

Click the Close button to get back to the estimate screen. 
Click Close again to return to the contracts list. 
If it isn’t already, highlight Contract 78-0061-114 
 

Cont Mods Button 
 
If we had any contract modifications, this screen would show a list of all 

contract modifications that have been created for this contract (there are none for 
our training contract) as well as their status, description, dollar amount, etc.  

 
 
If a generated contract modification has been deleted the number will NOT 
disappear from the list but will be left in the list and be given a status of “Deleted”.   
 
If the cont mod was the last one created and had never been generated, it will 
disappear from the list entirely rather than be given a status of Deleted.  In this 
case the contract modification number will be re-used. 
 
If the contract modification was created, saved and/or generated, and then 
modified, the revision column will have a number shown indicating how many 
times this contract modification has been revised.  Revisions can take place as 
many times as you need until the contract modification is approved.  If the 
contract modification has not been generated or saved and closed it can be 
revised over and over and no revision number will be assigned.  The revision 
number will not be a factor until the contract modification has been either 
generated or saved and closed. 
 
The contract mod date will be updated each time the cont mod is generated. 
 

Click the Close button. 
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Misc Rpts Button – 

 
 There are only 3 reports in FieldManager which, unlike inquiries, can be 
saved.  The report you’ll probably use most often is the Weekly Report of Time 
Charges.  Since the miscellaneous report list is in alphabetical order, the weekly 
report is at the bottom of the list.  Because the program defaults to the top report 
it would be much more convenient if the weekly report was at the top of the list.  
To do so, double click in the Miscellaneous Reports heading and the list will be in 
reverse order with the Weekly Report of Time Charges being at the top.  
Assuming you have a checkmark in the Save List Window Settings When 
Closing List option of the Utilities > User Preferences > List Window folder tab, 
the list will remain in this new order. 
 
The FieldBook Import Report gives specific information concerning imports from 
FieldBook into FieldManager.  This report is especially helpful when an error 
occurs during the import process. 
 
The Contractor’s Performance Evaluation report is to be used to create an 
evaluation for the prime and every subcontractor working on a project, no matter 
the dollar value of the subcontract amount.  A final evaluation must be approved 
for every contractor listed before a final estimate can be created. 
 
 
Inquiries Button 

This lists over 50 inquiries available in FieldManager.  An inquiry is 
actually a snapshot of the database at a given time.  If you request an inquiry 
today and request the same inquiry tomorrow, chances are the information will 
be different since work has been done in FieldManager in between the two times 
and the inquiry reflects the information in the database as of the moment of the 
request. 
 

 Any inquiry can be viewed and can be printed but cannot be saved.   
 

Close back to the contracts list if you’re not there already. 
 
 
 
Now that we have explored the Application toolbar and even made entries in 
some areas, let’s check out the Window toolbar for the contracts list screen and 
start making some entries! 
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Contracts List Window Buttons – 
 

 
 
The Import-FB and the Export-FB buttons are used strictly for passing 

information to and from the FieldBook program. 
Import-FB - This is used to import IDR’s from inspectors who are using the 

FieldBook program on a laptop.  This is NOT to import the contract init file or 
after mainframe processing of an estimate.    

Export-FB - This is used to export contract(s) as desired to the FieldBook 
program which is located on an inspector’s laptop. 

Cont Status - This button is available on all screens except Inquiries.  This 
screen will give basic information concerning the contract . Especially helpful on 
this screen is the information in the Amount Paid to Date (FM) and Amount Paid 
to Date (CAS) fields.  If the dollar amounts shown in these two fields are the 
same, the contract voucher has been closed out in FieldManager, processed by 
the mainframe, and imported back into FieldManager.  If the dollar amounts are 
different - ((FM) is more than (CAS) - the contract voucher has been generated in 
FieldManager but has NOT been imported back in after processing or has not yet 
been sent for processing.   Also helpful is the total working day charged 
information and the Item Types dollar amounts and percentages. 

Filter - This icon is available on many screens and can be especially 
helpful if you have a long list but only want to see specific information.  Any list 
window can have a temporary and/or an advanced filter created. 

Sort - This icon allows you to sort a list using up to 3 selections.  
Remember you can also do a simple sort by double clicking in the heading of a 
column to result in ascending or descending order for that column. 

 The Filter and Sort buttons are available for use with every  
Application button except the Docu button. 

MultCont Inq – This gives the option to see certain data for multiple 
contracts.  There are 3 options available as shown in the graphic.  These 
inquiries can be printed but cannot be saved.  
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Print - If you select the print button at any of the following screens 

displaying a list – IDRs, Diaries, Estimates, or Cont Mods – you will be given a 
printing option.   

1. Print the list 
or 

2. Print the selected report(s) 
 

 
 

  The Print button is available with every Application button. 
Refresh – This button does exactly as it says – it refreshes data.  Rather 

than having to close the active screen and then re-open it to see updated data, 
you can click the Refresh button instead. 

 The Refresh button is available for use with every Application  
button. 
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Entering documentation information -  
 
We have already loaded contracts for use - so let’s do something with them!!  During the 
import process most information about the contract was brought in automatically from our 
preconstruction programs.  There is some other information you should add.   
 

Highlight Contract 78-0061-114 if it isn’t already in the contracts list 
Click the Docu button.   

General folder tab 

 
The top portion of the screen shows basic information which cannot be changed.  In the 
lower portion of the screen some information is entered for you and some you enter.  
 
At the General folder tab enter the following information -   

Managing Office - Type in the RCE Office, County Name, or Consultant  
The Managing Office field MUST be completed before either a 
contract modification can be generated or an estimate can be created 
or contract exported to FieldBook. 

Managing Office Comments – Some offices like to use this field to enter the 
name of the inspector.  Enter something of your choice.  Remember, 
whatever you enter here is displayed on the list of contracts. 
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Notice to Proceed Date, Create Electronic Files, and StandAlone Contracts 
are blue - you can’t change or make entries for either 

Contract Closed - Leave the default as NO so progress can be shown and 
payments can be made on this contract.  When a final estimate is 
generated, the program will automatically switch this to YES. 

View IDRS in FieldBook for ____ Days – Change the default of 9999 to 100.  
This is the number of days inspectors will be able to view IDRS which 
have been passed from  FieldManager.  This will be 100 calendar 
days from the date shown on the FieldManager computer - not 
the last 100 entries made.  A default number of 9999 has been set 
but as you can see, it can be changed from one contract to another. 

It would be rare that you’ll ever want to change the 9999 
default.  We did it simply so you could see that it can be done.  
FB inquiries include only the data contained in the number of 
IDR’s they are allowed to view – in our case now only 100.  If 
the contract had 150 IDRs, the inspector’s inquiries would 
display only a limited portion of the total data for the contract. 

View IDR Attachments in FieldBook for ____Days – Enter 10 for the number  
of days we will be able to view IDR attachments which have been  
passed to FieldManager.  This will be 10 calendar days based on the  
date in the FieldManager machine – not the last 10 attachments  
created.  The default number can be changed if desired from one  
contract to another.  Be cautious of including a large number of  
attachments due to the potential size of the file passed between FM  
and FB.  All attachments will always be available for viewing in the  
FieldManager program. 

Construction Started Date – Enter today’s date  
 This should be the first day actual physical work began on the project 
Closed to Traffic Date – Leave this blank 
Open to Traffic Date – Leave this blank 
All Contract Work Completed - Leave this blank 
 This should be the day all physical work on the project is complete. 
This is NOT necessarily the project acceptance date. 
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Contract Level Settings on General Tab – 
 Many settings are determined in the Agency Configuration Program (ACP)  
long before you receive any contracts.  Most of those settings will and must 
remain as they are throughout the life of the contract.  Some settings, however, 
can be changed under certain circumstances.  Let’s take a look at how you can 
change certain fields and which ones you can as well as which ones you should 
never change.  Pay attention to what can and what should not be changed. 

  
You should still be at the General Tab of the Docu button for Contract 78-0061-
114.  If you aren’t, go there! 
 
 
Click the Contract Level Settings button 
 

  
 
 
DOT Offices & Consultants – The Report Item Sort Order and Group Items 
by Project/Category are the ONLY options you may change on this screen.  
Change NOTHING else! 
 
Counties – Change ONLY the Report Item Sort Order and Group Items by 
Project/Category options unless you want to put in your own county logo 
and agency name.  Other than those options, change nothing else. 
 
 
Click the Estimates tab 
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The following graphics show signature lines for DOT offices.  Counties using FM 
have a different set of signature lines unique to their needs for both estimate and 
contract modifications. 
 

 
DOT Offices and Consultants – DO NOT CHANGE ANYTHING on the 
Estimates tab  
 
Counties – do NOT change the text.  The signature lines have been 
adjusted in your ACP file for county signatures but you still have the option 
to change them.  You are NOT required to use all signature lines displayed. 
 
 
Click the Cont Mod Signatures tab 
    (graphic on following page) 
 
The Cont Mod Signatures tab is the only tab where you may want to temporarily 
change the signature block – and then you should do so very cautiously!! 
 
If there is a need for an FAA signature, put a checkmark in the “Include FAA 
Block” and that signature block will automatically be added and look very similar 
to the FHWA signature block. 
 
DOT Offices & Consultants – You might want to add another signature line for, 
perhaps, a utility company.  To do so, click the Add Signature Block Row button 
and type the name of the company in the new, blank field just above the word 
“Signature”.  Click the OK button.  Be aware that this additional signature line 
will remain for this contract until you delete it. 
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 When you are ready to delete the new signature line, be sure to put your 
cursor in that row first.  Then click the Delete Signature Block Row. 
 
Counties – The signature lines have been adjusted in your ACP file for county 
signatures but you still have the option to change them.  You are NOT required to 
use all signature lines displayed. 
 

 
 
DO NOT MAKE CHANGES ON THE 3 SCREENS OF THE CONTRACT LEVEL 
SETTINGS EXCEPT THOSE NOTED ON THE PREVIOUS PAGES.    IF YOU 
HAVE A DOUBT ABOUT WHETHER YOU SHOULD CHANGE SOMETHING, 
DON’T!!    
 
Some changes, especially on the General tab, can have a very bad effect on 
how the contract calculates payments.   Call Janet, Jen in the Creston 
Const Office (641-782-4518) if you have a question concerning a change.   
 
 
Click the Cancel button since we’re not making and keeping any changes. 
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Administrators folder tab 
This was a new tab in the 4.9a release.  With this release some of the fields that 
were formerly displayed on the General tab were moved here and we had the 
option to add additional optional fields.  The new fields that were added were 
determined by a vote of the users.   
 
The fields listed below were formerly displayed on the General tab.   

RCE or County Engineer’s Name - Type in the name of the RCE, County 
 Engineer, or Consultant who will be administering the contract.  

Type this as you  
want to see it printed on reports 

Resident Engineer - This is already entered for you based on who the  
 Office of Contracts was told would be administering and/or  
 processing vouchers for this project.  This can be changed  
Managing Office Manager – This can be either the inspector in charge of  
 the project or the same as the project engineer field – it’s your  
 choice! 
 

Listed below are the optional new fields – None of these entries are populated 
automatically and none populate any other field in FieldManager.  Use and 
interpret them to fit your needs.  However, the date the final quantities are sent to 
the contractor is to be entered in the bottom field, Final Quantities to Contractor.  
Do NOT put that date in the Open to Traffic Date field on the General tab. 
 Accounting ID – if the contract has multiple projects, you’ll have multiple  
  Accounting IDs.  Enter all of them or, perhaps, just the one for the  
  contract ID. 
 Letting Date (LD)/Bid Order No (BON) – 
 Late Start Date – 
 Wage Decision – 
 Liquidated Damages – 
 Status of Audit (eg 435 Date) – 
 Final Quantities to Contractor - 
  
  
 
 
 
 
 
 
 
 
 
Site Times folder tab  
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The basic site information is part of the contract data that comes to us so those 
fields are already populated.  Most of the other fields in this screen are updated 
automatically through the diary, contract modification, and estimate entries.   An 
entry you are to make  -  The first day a working day is charged should be 
entered in the Time Charges Start Date field.  
 
Enter today’s date in the Time Charges Start Date field for Site 01 and enter 
3/18/13 for Sites 02 and 03.  Leave Site 00’s Time Charges Start Date field blank 
since there are no days allowed for that site. 
 
There are 3 types of sites – working days, calendar days, and completion date.   
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 Working Day Sites - a time charge of 0, .5, or 1 is made for each day the 
contractor is working. 
 Calendar Day Sites – no time is charged in the FM program.  Total days 
used must be kept externally.  There is an Excel spreadsheet that can meet this 
need.  If you enter the starting date in the Time Charges Start Date field in the 
Docu > Site Times tab, the program will keep track of the number of days left or 
over the number of calendar days allowed and will display that number in blue in 
the upper portion of the screen. 
 Completion Date Sites – no time is charged in the FM program.  
However, if you enter the completion date in the Time Charges Start Date field in 
the Docu > Site Times tab, the number of days until the completion date arrives 
or the number of days past the completion date is displayed in blue in the upper 
portion of the screen. 
 
Breakdown folder tab 

Any breakdown information that is applicable is included when the 
contract comes to us.  Breakdowns are most commonly associated with plan 
sheets and/or structures. We will not be using this folder tab. 
 
Click the Site Events folder tab. 
 
Site Events folder tab 

If you wish to enter an event that could affect and/or document the 
charging of days for any and/or all sites on the contract, or an event 
that you just want to document somewhere other than in the IDR or 
Diary comments field, do so here!    

 
Once you save a Site Event entry, you will NOT be allowed to either  
change it or delete it even though there is a Delete Event button.   
That button is unavailable for use once the site event has been  
saved.  Notice in the following graphic that the Delete Event button is  
unavailable for use – this event has been saved so cannot be  
deleted. 
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Click the Add Event button  
 
Click the drop down arrow and select Site 01 - (if the event affects more 

than one site, you should make a separate entry for each site.  
We’ll make a practice entry for Site 01).   

Click the Action field drop down arrow and select TS: time suspended or 
press the letter T and the first choice in the list beginning with the 
letter T will be brought into that field.  Press the letter T again and 
again until Time Suspended is displayed. 
    Remember, all lists are in alphabetical order 

Press the Tab key 
 

Enter 11/5/2013 in the Date field.  Either type the numbers in without the 
slashes or use the calendar to select the date. 
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To use the calendar, click once on the calendar button, click 
on the appropriate day so the red square surrounds that day, 
then click OK.  If the month is incorrect, the arrows to the 
right and left of the month will move you forward and 
backward through the months respectively. 

Press the Tab key 
Type Beginning of Marathon Run in the Remarks field. 
Press the Tab key and the remarks will be reflected in the top portion of 

the screen. 
 

Click the Add Event button to add an additional event for Site 01 
Add the event, Time Resumed,for the date 11/7/2013 
In the Remarks field, type in Winter Marathon Run Ended  
Click the Save button 
 
A file (STEVTxxx.EXP) is automatically created and put in the FieldMgr\Outbox 
folder for each site event added.  These files will be included for processing at a 
later date. 
 
Let’s look at the C:|\FieldMgr\Outbox folder and see what all is in there! 
 
Notice there are 2 files beginning with STEVT.  Those represent the 2 site events 
we added, the first being STEVT001.EXP and the second being STEVT002.EXP.   

 
    
The file, CTCDT001.EXP, was created when we saved the Construction Started 
Date that we entered on the General folder tab.   
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When we saved the 3 entries we made in the Time Charge Start Date on the Site 
Times folder tab, the files beginning with STDTS00x.EXP were automatically 
created.   
 
All the above files are combined along with any contract modification and 
voucher files that are in the FieldMgr\Outbox when they are sent to the 
mainframe.  Files with a .EXP extension should never be deleted from the 
Outbox unless specifically instructed to do so by Janet. 
 
Minimize Explorer which should return you to the IDR screen with the Site Events 
tab open. 
 
 
Attachments Folder Tab - 
Photos, drawings, etc. can be attached to the FM program.  Beware, however, 
that the size of the contract can increase dramatically depending on the 
attachments. 
   To create a new file and attach it – 
 Click the Add Attachment button 
 
 
 

 
 
 
 Enter the name and then Browse to locate the attachment. 

Enter a short descripton of the attachment 
 Click the Add button 
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 To see the attachment in FM, highlight and then click on the View   
  Attachment button 
 Click the red X to get out of the “view” mode 
 Save 
 
 
To change an attachment in the list – 
 Highlight the attachment iin the list and click Change Attachment 
 Make the appropriate changes in the name or description fields 
 Save 
 
 
To delete an attachment in the list – 
 Highlight the attachment name 
 Click the Delete Attachment button 
 

 
 
Be cautious here ……. 
 
 If you really wanted to delete the attachment, you would answer Yes to the 
“Are you sure…” question to delete.   
  This will delete the attachment everywhere.  To save it 
externally from FieldManager, follow the directions in the Delete Warning 
message as shown in the above graphic. 
 
Since we do NOT want to delete the attachment, answer “No” in the above 
graphic. 
 
Save/Close to return to the contracts list. 
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Contractors - 
 
A .CON file is required for all contacts having subcontractors. 
  
SiteXchange to FieldManager Pass - 
For most contracts, all subcontractors and their items are known at the time of 
the letting because the prime contractors enter that information in a file that they 
send to the Office of Contracts.  The Office of Contracts furnishes the 
SiteXchange file (.CON file) to Janet and then she passes it on to the residencies 
at the time the contract is inited.  Once imported into FM, the .CON file will 
automatically enter all the subcontractors and their items into the appropriate 
contract in FieldManager.    
 
When a new contract has a .CON file, follow the steps below - 
 1.  Using the FM Xfer program, “Receive New Contracts” when you have 
been notified that new inits are available. 
 2.  Import (File > Import > File) the new contract(s) into FM, selecting 
either All Files (*.*) or Contract Files (*.*) as the Files of Type 
 3.  Import the SiteXchange file (File > Import > File) into FM, selecting 
SiteXchange Files (*.con) as the Files of Type 
 

 
 

Once the import of the .CON file is complete, a SiteXchange Import 
Report (shown above) is displayed.  This report displays every subcontractor and 
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linked item(s) imported.  This report can be printed but it can neither be saved 
nor printed at a later time.  This is a “once only” report. 
 If a revised .CON file is imported, the report will be displayed again.  This 
does NOT show only what might have been removed or only the new added.  
Instead, this revised report displays everything current in the revised .CON file 
and leaves the original information in tact. 
 When a revised .CON file is imported, the links that might have been 
removed due to that are not changed in FieldManager.  For instance, if Sub A is 
linked to Items 1, 2, and 3 in the original .CON file but a change is made and the 
revised .CON file has Sub A linked to only Items 1 and 3, FieldManager will still 
show Sub A as being linked to Items 1, 2, and 3.  In that case, you can remove 
that link of Item 2 by hand, if desired. 
 
After the .CON file is imported - -  

1. Click the Contractors button and highlight 1 contractor in the list at a 
time and click Change. 

 2.  Enter the work type for each contractor, including the prime.  This 
information will automatically populate that field in the contractor evaluation.  
 3.  Optional – enter the address for each contractor, if desired.   
 4.  When finished with all contractors, click the Save /Close button 
 
To view the items associated to each contractor – 

1.  Highlight the contractor 
2. Click the Review button 
3. Click the Items tab 

**** NOTICE – The quantities displayed are for ALL subs and the prime 
associated to this item.  The quantities do NOT display quantities for only the 
contractor being reviewed. 
 
If a change to the original .CON file is made, the prime must submit to you a 
revised .CON file.  After you authorize the change, forward the .CON file to the 
Office of Contracts.   

However, if there was originally a .CON file but the revision is due to an 
item being added by contract modification, the prime must submit a paper 
subcontract request and then you must add the sub’s new item(s) by hand into 
FieldManager in addition to forwarding it to the Office of Contracts.  (The hard 
copy of the subcontract request can be scanned and e-mailed.) 
 
A contractor is required to be linked to every new item added by contract 
modification.   
 
Once again -  
If a sub is to be linked to a new item, the prime will furnish you with a paper 
subcontract request.  It is your responsibility to authorize the copy and then 
forward it to the Office of Contracts.  You must enter the information into 
FieldManager by hand.  
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To print the subcontract requests – 
In order to print subcontract requests, you must have a C:\SUBCON folder that 
contains 3 files – SubCon.exe, vendor.bin, and the appropriate .CON file for the 
contract.  The vendor.bin file is periodically updated and it is critical to keep the 
most current copy of it in the C:\SUBCON folder so the appropriate contractor’s 
name prints. 
  
Once you have the 3 files in the C:\SUBCON folder – 

1.  Double click on the SubCon.exe  
2.  Click on Run 
3. Click the Open icon 
4. Highlight the appropriate .CON file and then click Open 
5. Click the Print icon 

All subcontract requests will be printed as well as a summary sheet  
  
 

.   
It’s rare but it could happen that you must add sub info by hand.  To do so – 
To Add a Subcontractor By Hand – 

Highlight Contract 78-0061-114 
Click the Contractors button 
     A list of the prime and all subs already associated to this contract  
            are displayed. 
The  prime contractor is displayed in bold, italicized print  
 
Click the Add button and a list of non-obsolete subcontractors will appear.  

Subcontractors added to any contract MUST be selected from this 
subcontractors list.  If they are not in this list but you know they 
should be there, contact Janet or Jen in the Creston Const Office 
(641-782-4518) – you probably need a new reference file. 

We want to add Rupert Constr Co. –  
           Sort the list by contractor name if it isn’t already and begin typing 
                   Rupert in the Find Contractor Name field.   
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Highlight Rupert Constr Co. 

Once the name is highlighted, click the Select button and it will be added 
to your subcontractor list. 

Add the Work Type.   We’ll choose “PCC Pavement – New” 
Enter the Contractor Address, if desired.  This is an optional field. 

 
Enter the Subcontractor Amount – $10,380.00 

This is an optional field when entering information by hand but is 
automatically populated whe importing a .CON file.   If the 
subcontractor amount is not entered here, it will not be displayed on 
the CPE. 

 
Click the Items folder tab 
 
 
 
To Link Items to the Subs by Hand - 

By default, every line item in the contract is linked to the prime contractor.  
If you received the .CON file to import, the item to sub link will already have been 
done automatically for you.  If subs are added after you received the contract, the 
items/sub link will be taken care of for you in the revised .CON file.  
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If the item was added by contract modification, you are required to enter a 
contractor’s name when adding the item so the link between the contractor and 
item will already be done for you.  If you want to link multiple subs to an item, you 
can do this by hand in FieldManager. 

 
 As stated previously, by default, all items are linked to the prime 

contractor.   It is advised that the link between the prime and all 
items remain even if some of those items are linked to a sub.  
By leaving the prime/items link, the inspector will be required to 
select the appropriate contractor when they post progress for an 
item. 

 
 If more than one subcontractor is going to share work for a specific 

item, both subs should be linked to that item 
 
 
We’ll link 2 items to our new subcontractor - just for the fun of it - and so 

you see how easy it is to do!!!   (You should still have Rupert Constr selected and 
the Items tab open) 

 
Click the Add button 

   (You may want to sort the list by Proposal Line No. before  
continuing) 

Highlight Lines 0100 and 0540 (Hold your Ctrl key down and  
left mouse click on each item) and click the Select key 

If desired, you can enter Remarks for whichever line item is  
highlighted at that time.  One reason for doing so might be  
“partial item”, etc. 

Click Save/Close 
 
 

To see the items linked to Rupert Construction – 
(You may need to click the Refresh button in order to see all  
the changes made to the Items list) 

 
 At the Items list, click the Contractor field and select Rupert Constr 
 Only items linked to that contractor will be displayed 
 To see all the items again, change the Contractor field from Rupert  

Constr to All 
    
 
You may view subcontractors and their linked items in a couple of ways – 

1. Click on the Items button and limit the items displayed by selecting the 
desired contractor from the drop down list in the Contractor field 

December, 2013 Chapter 2.5 Page 5 
 



This will display the TOTAL quantity placed by ALL contractors if 
the item was linked to multiple contractors, not just the contractor 
selected from the contractor drop down list 

 
2. Click the Contractors button and either double click the contractor’s 

name or highlight that name and click the Review button and then click 
the Items tab.  This also displays the TOTAL quantity placed by ALL 
contractors.  It does NOT reflect only what has been posted by a 
specific contractor. 

  
 
Close all windows and return to the contractors list  
 
If a contractor evaluation has been initiated, generated, or approved, it will be so 
noted in the Performance Evaluation Status column.  If no CPE has been 
created, “None Created” will be displayed.  Remember, a final evaluation must 
be approved for EVERY contractor before a final estimate can be created.  There 
is NOT a dollar amount to determine whether or not an evaluation must be done 
– there must be one for every contractor listed, 
 
 
Deleting a Subcontrator - 

If you want to delete a subcontractor – 
Click the Contractors button 
Highlight the subcontractor, Rupert Construction 
 
Click the Delete button.  You’ll get a warning stating that the 
subcontractor is already associated with an item(s) and can’t be 
deleted 
 

 
 . 

Once a subcontractor is linked to an item the subcontractor CANNOT be 
easily deleted.  You must first delete the association with all items and then the 
subcontractor can possibly be deleted if you still wish to do so.  BUT, if any of 
those items have been paid and were linked to the sub during the posting 
process, the sub cannot be deleted – period! 
 
 
Since we don’t really want to delete Rupert Construction, click OK  
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Close back to the Contracts list 
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Entering IDR (Inspector’s Daily Report) Information 
 

IDR’s (Inspector’s Daily Reports) may be created using either the FieldManager or 
the FieldBook program.   

A FieldBook user (inspector) can change anything in any IDR they created in 
FieldBook until it is exported to FieldManager.   As a FieldManager user (office) you can 
change anything in ANY IDR until that IDR is included in an estimate.   

There can be one or many IDR’s per inspector per day on a contract.  The first IDR 
created by an inspector for a given day will be Sequence 1.  The sequence number will 
increase by 1 for each additional IDR created by the same inspector for the same day.  If 
an IDR has been generated and then changed, it will be given a revision number and will 
also log who did the revision and the date of that revision.  If revised more than 1 time, it 
will display only the last revision information.  All this information is displayed in the upper 
portion of the screen when viewing the general folder tab. 
 

IDR’s keep track of all daily activity on a contract and are compiled in the 
FieldManager program to create a diary.  We will create an IDR for Contract 78-0061-114. 
 

Highlight Contract 78-0061-114 in the contracts list if it isn’t already 
Click the IDRs button 

This will bring up a list of all previous IDR’s created by all users for this 
contract.    

Click the Add button and we will get ready to create an IDR for yesterday 
 
    General Folder Tab - 

The General folder tab opens with today’s date (the date the computer shows as  
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today) displayed in the Date/Time Entered field.  That is also the default date for the IDR 
but you may change it to any past  date.  If you had already created one IDR for that date,  
this IDR would become Sequence #2. 
 

AN IDR CANNOT BE CREATED FOR A FUTURE DATE!!! 
 
Some fields in the top portion of the screen are completed already.  Several fields are 
blank since this is your first IDR for the date and it hasn’t been revised!   As stated already, 
the Date/Time Entered field is the actual date the IDR was created – that may or may not 
be the same as the date of the IDR.  Entered By is the individual who was logged into the 
FM program at the time the IDR was created, and “No” is the Generated field default since 
this IDR has not been generated.  
 

Enter yesterday’s date in the IDR Date field by either typing it in OR by clicking the 
calendar and selecting the date. 

Leave your name in the Inspector field.  This does NOT have to be the same ID 
(person) who is logged in to the program as displayed in the “Entered By” 
field.  The person you select from the drop down list is displayed in the 
Author field of the printed IDR. 

Another way to select a name other than clicking the down arrow and 
getting the drop down list is to tab to that field and type the first letter 
of the name.  If there are more names than one that start with the 
same letter, type the same letter again. 
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REMEMBER, ONLY THOSE PEOPLE WHO HAVE BEEN ADDED AS 
USERS TO THIS PROGRAM WILL HAVE THEIR NAME DISPLAYED IN 
THE INSPECTOR’S DROP DOWN LIST. 

 
Press the Tab key  
Type Scattered Showers in the weather field - brief information is best! 
 If you prefer you can select a previous weather entry from the drop down list.   

This drop down list contains the last 20 weather entries saved from previous  
IDR’s. 

Press the Tab key 
Enter 43 in the Low Temp field  

If the contract is in metric units, the temperature must be entered in Celsius 
and will then be converted to Fahrenheit.  If the contract is in English 
measurements, the temperature must be entered in Fahrenheit and will be 
converted to Celsius. 

Press the Tab key  
Enter 65 in the High Temp field 

If the low temperature entered is higher than the high temperature or vice 
versa, the program will display a warning.  In other words, the low 
temperature cannot be higher than the high and the high temperature 
cannot be lower than the low!  

   If more than one inspector creates an IDR for the same date, it is not     
important that they all have the same temperatures.  That difference is       
taken care of by the program in the Diary function. 

 
Press the Tab key again 
Comments may be the equivalent of 3 single spaced typed pages or 32,000 

characters.   
For our practice, type “Abnormally warm and wet for this time of year.  Too wet to 

do much.”  If this were a “real” contract you’d probably type many more 
comments.  Since this is just for practice, feel free to type more only if you 
wish to do so.  Like anybody’s going to do that, huh!!!!!!! 

If it’s easier to view the information in a larger area, double click in the 
Comments field to enlarge that area.  Spell check can still be done 
while working in this format.  Click OK to return to the original format. 

 
  If you use a word that Spell Check doesn’t recognize, click the 

Add to Custom button so it will be included in your custom dictionary 
and won’t be flagged as “Not Found” in the future. 

  
AT LEAST ONE OF THE FOLLOWING FIELDS MUST BE COMPLETED BEFORE AN  

   IDR CAN BE SAVED:  WEATHER,  TEMPERATURE, OR COMMENTS. 
 

If there are no item postings in the IDR, there must be remarks entered in the 
Comments section. 
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Nothing saves automatically when changing screens.  You must click the Save or 
the Save/Close button to save information. 

 
Click the Save button if you haven’t already. 
 
 
 
    Contractors Folder Tab - 

Click the Contractors folder tab to reveal the prime contractor in the top portion of 
the screen as well as any subcontractors that have been added to the contract.  These 
contractors are listed in alphabetical order.  Notice that Rupert Constr Co is listed since we 
added them as a subcontractor in a previous exercise.  The lower left area reveals 
personnel, if any, that has been associated with whichever contractor is highlighted in the 
top portion.  The lower right area reveals equipment, if any, that has been associated with 
the contractor highlighted in the top portion.  The list of contractors is, by default, in 
alphabetical order.  The prime contractor is shown in bold, italicized print to distinguish it 
from the subcontractors. 
 
You may add or delete personnel and/or equipment at any time.  Once you either add or 
delete that information for a contractor, future days will also reflect those changes for that 
same contractor 

 
Click so there is a checkmark in the On Site box in front of Landmark Engineering 

Group, Inc. and River City Barricade. 
 

 
 
 

  
When the contractor’s name is highlighted, any personnel and/or equipment 

previously associated will appear in the lower portion of the screen 
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 Note that the personnel and equipment displayed in the above sample graphics are 

unique for the specific contractor highlighted. 
 
There can be a checkmark designating that the contractor was on site even though 

a working day charge was not made 
 
If you want to include entries for the number and hours in either the personnel or 

the equipment area, do so here.  If you do not want to include a particular 
worker and/or equipment on the list for a given day, simply do not enter any 
number or hours in those fields for that IDR and that particular personnel or 
equipment will not be included in that day’s IDR report but they will remain in 
the master list for use in future IDRs.  Making entries for equipment and 
personnel are optional. 

 
Highlight River City Barricade 

Click the Add Personnel button 
Type in Laborer - Enter 2 in the Number field and 16 in the Hours field 
Click the Add Personnel button. 
Type Foreman - Enter 1 in the Number field and 9 in the Hours field. 
 
The program does not like random order lists but the personnel list for River City 

Barricade seems to be just this way.  Click the Save button and notice how the personnel 
list becomes alphabetized.   FieldManager will always arrange lists in alphabetical or 
numerical order in ascending order first. 

 
 

Highlight Landmark Engineering Group, Inc. 
 Click the Add Personnel button 
 Type Surveyor – Enter 2 in the Number field and 18 in the Hours field 
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The personnel and equipment (if you had entered that also) you have typed in 
these lists becomes the master lists for all future days.  If you delete one of these 
personnel or equipment entries, it will be removed from the list for today AND all future 
days.  If there is a work classification in the list but that worker wasn’t on the project, 
simply leave the Number and Hours fields blank and that work classification will not print 
out on the report but will still be available to have numbers and hours entered for future 
days.  The same is true for equipment. 

 
If you have a work classification or a piece of equipment that will never be back on the 
project, it can be deleted. 
  Highlight River City Barricade 

Highlight the Laborer in the personnel column 
Click the Delete Personnel button 
Answer NO to the “Are you sure?” question. 

If you accidentally created an extra blank line, it can either be deleted or left there for an 
entry at a later date.  Either way is OK. 
 
 

Once again, remember, entries are not automatically saved in this program when 
you switch screens and/or folder tabs.  You must physically save them by clicking the 
Save button (saves the data and you remain at the current screen) or the Save/Close 
button (saves the data and closes the current screen). If you make changes and forget to 
save, you’ll be prompted to do so before continuing. 

Remember, the Save button saves the information and leaves you at the same 
screen.  The Save/Close button saves the information AND returns you to the previous 
screen - it doesn’t save the information and close you out of the program. 
 
Click Save 
 
Site Times Tab - 

This folder tab gives you some information concerning site time(s) and is also 
where you indicate whether or not a working day should be charged to the contract.   
The top portion of the screen is view only and cannot be changed by the user.  The 
totals are updated from estimates and diaries that have been generated.   
 

The middle portion of this screen shows every site for this contract (every 
contract has Site 00 – even though there may be 0 days allowed in that site), the Site 
Description (it could just be a period or a double quote sign), and the type of days being 
charged on this contract (Work Days is the choice almost 100% of the time).  Time is 
charged to the contract NOT to individual projects within the contract.  Liquidated 
damages are not automatically withheld but if you overrun the number of working days 
allowed for any site, you’ll be required to make comments when creating an estimate.  
(A cont mod must be written for liquidated damages if you overrun working days allowed 
in any site.  Once the cont mod has been created, a negative posting must be made to 
that item.) 
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The lower portion of the screen is where you make your entries.  The information  
entered here will be reflected in the diary and ultimately the weekly working day report.  
 
 

 
   
Let’s look at some of the fields. 

In the Days Allowed row - 
Original = The original number of days for the site that’s highlighted in the 

middle portion of the screen  
Authorized = The current number of days for the site that’s highlighted in 

the middle portion of the screen.  This will be the same as the 
original number UNLESS a time extension contract modification 
has been approved to increase the number of working days allowed 
for this site. 
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Pending = The number of days the highlighted site will be increased 
through a time extension contract modification after the contract 
modification is approved. 

In the Days Charged row - 
Diary = The number of days that have been charged to date in saved 

and/or generated diaries in FieldManager. 
Estimate = The number of days that have been charged to date on 

estimates.  This is as current as the last processed estimate.  
 

You make entries in the lower portion of the screen using some or all of the 
following fields -   

Time Charged - An entry of 0, +.5, or +1.0 is valid 
Contractor Working - Click in the Yes or No radio button, depending on the 

correct answer for the day. 
Hours Available 
Hours Worked - These two fields are good supporting documentation for 

charging or not charging a working day but neither field is required. 
Controlling Operation - The information entered here will appear on the 

Weekly Report of Working Days 
Reason for Delays - The information entered here will appear on the 

Weekly Report of Working Days  
Comments - The information entered here will appear in the Daily Diary 

report when you either view it or print it. 
 
 
OK, so I’ve now talked you goofy in this area too, huh!!!  So let’s make some entries and 
use this new found knowledge!!!! 
 

We’re still working with the IDR for Contract 78-0061-114 
Highlight Site 01 in the middle portion of the screen.  (The information we enter now 

will be for this site only, no others.) 
Click so the cursor is in the Time Charge field 
Type in 0 
Press the Tab key  

Notice the updated info. in the middle portion of the screen.   
Click in the Yes radio button for the Contractor Working line 
Press the Tab key so the cursor is in the Hours Available field 
Enter 8 in the Hours Available field 
Press the Tab key 
Enter 2 in the Hours Worked field 
Press the Tab key 
In the Controlling Operation type in “Shaft” 
Press the Tab key 
In the Reason for Delays field, type “Weather Delay”  
Press the Tab key 
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Type “Started out fine, then broken piece on equipment” in the Comments field.  
(You can type in this entire line and then some but it is intended to be a short 
comment.) 
 

Highlight Site 03 in the middle portion of the screen and we’ll make entries for it 
also.   

Follow the process you just finished and enter the following information in the 
correct fields. 

    Time Charge = 1  
    Contractor Working = Yes 
    Hours Available = 4 
    Hours Worked = 4  
    Controlling Operation = Excavation 
    Reason for Delays = leave blank 
    Comments = leave this blank 
 
Click the Save button. 

 
 
 
    CHANGING a Site Time Entry BEFORE the IDR has been included in a diary - 

If you wish to change a site time record, you can do so easily AS LONG AS that 
IDR has not been included in a diary.  Do so by opening the correct IDR > Site Times tab 
and highlighting the site needing the change.  Change the information in the field.  If the 
IDR has already been included in a diary, changes must be made there. 

 You should still be at the Site Times tab of the IDR we created for Contract 78-
0061-114 

Highlight Site 03 
Click in the Time Charge field and change the 1.0 to .5  
Press the Tab key and notice the change in the upper portion of the  

screen for this field.   
Click the Save button 

 
 
 
    DELETING a Site Time Entry BEFORE the IDR has been included in a diary - 

By using the Delete IDR Time Record button at the bottom of the screen, you can 
delete a site time entry for any IDR as long as it has not been included in a diary.  If the 
IDR has been generated, the site time entry can still be deleted as long as the IDR has not 
been included in a diary. 

Highlight Site 03 if it isn’t already 
Click the Delete IDR Time Record button 
 This will delete the information for ONLY the site highlighted in the middle  

portion of the screen. 
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We really don’t want to delete the time charge entry, so answer NO 

 
Postings Folder Tab - 

Click the Postings folder tab. 
 
Item progress for all items in the contract are made here.  Since we have not made 

any item progress yet for this IDR, our screen is blank.   
 
ALL ITEM PROGRESS ENTRIES ARE MADE AT THE CATEGORY LEVEL - NOT THE 
CONTRACT LEVEL.   
 
*************************************************************************************************** 
A reminder - 
Mobilization shows as one of the regular line items but an entry should NEVER be made.  
This item is called an autopay item which means the appropriate amount is automatically 
included in the estimate by the mainframe when the estimate is being processed.  Once 
the estimate is returned from the mainframe and imported into your laptop, the 
mobilization will be updated in the Cat. Qty. Paid field in the Postings folder tab of the IDR 
section.  The Cat. Qty. Placed field should always be blank for this item.  
 
*************************************************************************************************** 
Once you select an item for posting progress, you will be required to select the appropriate 
category (if the item is in more than one category) before you leave the posting  screen 
and also to select the appropriate contractor if the item is linked to more than one 
contractor 
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Click the Add Posting button so we can soon make our first entry. 
 

The entire list of current contract items is shown (as seen in the previous graphic).  If there 
is only 1 project in the contract, that project number will be shown in the Project box.  If 
there is more than 1 project, the word All will be shown.  If there is only 1 category, 0001 
will be shown in the Category box.  If there are multiple categories the word All will be 
shown. 

If you wish to see every item in the contract, leave the default as it is but if, 
for example, you wish to see only items in a certain category of a 
certain project select those choices in the appropriate fields and the 
list of items displayed will be adjusted accordingly.  Whatever 
selection you make at this screen will affect your selection choices in 
the next step. 

  
Our contract has only 1 project so that is in the Project field already.  We are going 

to leave the default choice of All in the Project and Category boxes for this contract. 
 
The list of items is by default in alphabetical order by Item Description but we want 

to sort by Proposal Line for our exercise.  To do so, double click in the Prop Line header. 
 

Highlight Line No. 0030, Excavation, Cl 20 
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Click the Select button 
OR 

  Since Select is the default button, you can just press the Enter key once the  
   item is highlighted. 
 

The top portion of the screen shows category information concerning that 
line item.  If an item was in more than one category, no totals would be shown yet.  
As soon as you select the category in the bottom portion of the screen, the 
authorized quantity, pending changes, dollar authorized amount, quantity placed, 
and quantity paid to date totals for this category will be displayed in the top portion 
of the screen. You make NO entries in the top portion of this screen.  The entries 
you make in the lower portion are reflected there. 

 
The bottom portion of the screen is where you make daily entries for items.  

The form (the blue number in the lower left area of the screen) used is dependent 
and is automatically determined by the item selected. There MUST be an entry 
made in either the location field or the first station field if both show on the form.   
 
 

 
 
Project/Category Box - If the item is in only one category, that category will  
be displayed in the Project/Category field.  We know this item is in only one  
category since this field has 0001 displayed.  Any time the line item is in more  than  
one category you must select a category choice before you can see totals in the top  
portion of the screen and also before you can leave and/or save this screen. 
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To select a category you may click the down arrow and select one 
from the list OR you may click the zero key until the category of your 
choice is shown OR you may click the down arrow on your keyboard 
until you reach the category of your choice.  The zero key will take 
you through the list, over and over again.  The down arrow will take 
you to the bottom of the list and once you’re there, click the up arrow 
to move up the list. 

 
The Attention Box - If this box is checked it is simply an alert that the item should be  

noticed BEFORE the estimate is generated. A checkmark in the Attention 
box does NOT stop anything – it’s just a notice for attention.  If you mark an 
item for attention you are REQUIRED to enter remarks for that item. 

Once you put a checkmark in the Attention field, press the Tab key to 
move to the Remarks field. 

 
The Remarks Field – Once the cursor is in the Remarks field, a scroll bar appears.   

It is highly recommended to make an entry in the Remarks field 
for EVERY posting to serve as additional documentation. 

If you double click in the Remarks field, the viewable area will increase  
dramatically.   Click OK to return to the original field size. 

The Materials Button (bottom left area of this screen) - We will not be using this. 
 
OK, let’s make some item progress entries.  We’ll make several since this is something 
that someone will be doing or helping with on a daily basis whether they’re an inspector or 
in the office using FieldManager or FieldBook!!  In other words, there’s no getting away 
from learning this part!!   
 

As you will probably notice, some entries made here are for practice only - they do 
NOT necessarily reflect reality on a project!! 
 
We’re NOT going to make an entry for Line 0030 at this time so - 

Click the Cancel button at the bottom of the screen  
 
Click the Add Posting button 
Highlight Line 0080, Demonstration Shaft 
Click the Select button 

You can just press the Enter button since Select is the default. 
Notice the information in the top portion of the screen is complete.  
Also the Category field in the entry area displays 0001 letting us know 
this item is in only Category 1 of the Project shown directly above the 
category field. 

Select Par Electrical Contractors, Inc. in the Contractor field.   
You have to make an entry in the Contractor field only if the item is  
linked to more than 1 contractor. 

Sta From = Enter 2652+70 
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You can enter either = or a space instead of the +.  Once you press 
the tab key, the = sign or the space will be replaced by a + 
sign.  

 
In all forms, press the Tab key after each entry to advance to the next field 

 

 
  

 
Quantity = 15   
Remarks = worked on demo shaft until equipment broke 

 
 

Click the Add More button which will return you to the item list to select the 
same or a different item.  Even if you want to make another entry for the same item, 
you still must return to the item list and select it again. 

If you had clicked OK by mistake instead of Add More, you would 
have been taken to a screen that shows all item entries made thus far for this 
IDR.  From there you could click the Add Posting button once again to get 
back to the item list. 

 
  Select Item 0310, Clear & Grubb 
 
  Notice that the Station From field is already populated with the same data as 
the last entry.  This is due to the option we selected in the Utilities > User Preferences, 
Entry Defaults tab.   Although this can be a very helpful tool, it can also be a very big 
pain!!!  This option can be “turned on and turned off” at any time – and it’s time we “turned 
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it off” so go there and take the checkmark out of the “Station and Location fields default to 
last entry” option (Utilities > User Preferences > Entry Defaults folder tab) then click OK. 
 

Sta From = 2652+40 
Quantity = .4  

   Remarks – clearing first day  
   If you got “kicked out” of this form as soon as you began to type the  
   remarks, odds are you forgot to press the Tab key first to get into the  
   Remarks field.  Notice at the bottom of the screen the word Cancel  
   has the C underlined - that means the keystroke for canceling is the  
   letter C.   With the cursor sitting in the Attention field and typing a  

letter C, you are telling the program to cancel the entry!!  That’s why  
it’s crucial to tab to the Remarks field before typing. 

 
 
  Click Add More 
 
  Highlight Line 0270, Excavation, Cl 20 
  Since this is in only 1 category and linked to only 1 contractor, those fields  

are populated for us. 
Station From = 2655+00 
Station To = 2656+00 
Side = Right 

   This field is blue and blank with a drop down arrow.  That means you  
can type in the first letter of the selection and the first instance of an  
item beginning with that letter will automatically appear in that field.  If  
that is not the correct one, press the letter again and the next choice  
beginning with that same letter will be shown 

Length = 100 (calculated already for you) 
Width = 12 
Depth = 2 

  Quantity = 88.889 
  Remarks = enter a remark of your choice 
  Click OK 
  Save 
 
  Click the Add Posting button 
 
You’ve done fine so far – let’s make some more entries just for fun!  OK, OK, so it might 
not be all that much fun – but there are some more things I want you to see and learn! 
 
 Select Proposal Line No. 0580, Painted Pav’t Mark, Waterborne/Solvent 
  Note that this item is in only 1 category since the Project/Category field  

Displays 0003 
Contractor field is blue and blank meaning there is more than 1 contractor  
 assigned to this item.  Select River City Barricade 
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  Station From = 2164+04 
  Station To = 2168+06 
  Side = Right 
  Length = 402 
  Plan Indent (this should be Plan Ident)  = ELW4 
  Permanent – put a checkmark in this circle 
  Meas Factor = 1 
  Quantity = 4.02 (is calculated already for you) 
   Change the 4.02 to 4 
    If the program calculates a different quantity than what you 
enter in the quantity field, the program calculated quantity is displayed beside the Quantity 
field.  If you don’t use the program calculated number, that number will remain in red just 
to the right of the Quantity field. 
  Remarks = Pay only 4  
 

 
 
  
 Any time a number is shown in red anywhere on the form, an explanation should be 
entered in the Remarks field.  By doing so, the auditor knows that you are aware of the 
difference in the program calculated and the entered amount and intend it to be that way. 
 
Click OK 
 
We haven’t saved any entries for awhile so let’s click the SAVE button.  That will save all 
entries in every folder tab for this IDR and will remain at this folder tab. 
 

December, 2013 Chapter 3 Page 16 
 



 
The Postings folder tab lists all item progress entered thus far for this IDR.    The 
 

 
 
 
item that is highlighted will be detailed in the top portion of the screen.  Remember, the top 
portion displays ONLY CATEGORY information for the item.  If the item is in more than 
one category, it does NOT show totals for all categories, just the one involved in the line 
item highlighted. 

 
To see the total quantity placed for the entire contract click the Items button and 

view the quantity placed column.  Only quantities in IDRs that have been saved or 
generated are reflected in this field. 

Items which have postings in our IDR are 0080, 0270, 0310, and 0580  Once the 
IDR with these postings is saved or generated, the amounts posted will 
be reflected in the Qty Placed field.  Until then they are in a sort of 
limbo state – they’re posted but they don’t count!! 

Click the Close button until you are back at the Postings tab of the IDR 
 

Since we want to add another item, click the Add Posting button  
Select 0560, Rmvl of Pavt 
Sta From – enter something of your choice 
Sta To – enter something of your choice 
Side – enter something of your choice 
Quantity – 72  (this is about 1/3 of the authorized quantity 
Remarks – enter something of your choice 
Click Add More 
 
Select Line 0070 
Contractor – Par Electrical Contractors 
Sta From – enter something of your choice 
Quantity – 150 (this is about 1/2 of the authorized quantity 
Remarks – enter something of your choice 
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Click OK 
Save 
 
Since that was so much fun, let’s post progress to another item!!! 
 
Click the Add Posting button 
Select 0590, Traffic Control 
Category field = Selected already  
Contractor = River City Barricade Co 
Location  = start of project 
Pay % = leave this field blank - it is not used  
Quantity = 1.0 

Since this is a lump sum item, the progress must be entered as a 
decimal. 

Remarks = Type in Initial payment  
Click OK to return to view the postings for this IDR 
Click the Save button.   

It’s a good idea to save your information every few entries since it 
sure doesn’t take long to do so.  This saves not only the item postings 
but everything in this IDR you have entered in the other folder tabs as 
well. 

Now that you’ve made a lump sum item entry, let’s review a few lump sum rules: 
* Quantities must be entered in decimal form 
* If a lump sum item is in more than one category, EACH category will have a 

quantity total of 1.0. 
* The total item quantity for a lump sum is 1.0 
* The lump sum quantity of 1.0 CANNOT be overrun at all 
* You do NOT have to place and/or pay 100% of a lump sum item 
* You cannot increase or decrease a lump sum contract item using the 

Increase/Decrease option of a cont mod 
* If you need to increase a lump sum item, you must do so by contract modification, 

adding the item as a new item.  (You can use the same item number 
EXCEPT FOR THE MOBILIZATION LINE ITEM.)  You MUST NOT use the 
mobilization line number for additional mobilization to be paid to the 
contractor.  If you do, it can cause big problems to the contract and for Janet! 

If you need to pay additional mobilization, use a generic lump sum or 
each item and enter “additional mobilization” in the supplemental 
description. 

. 
                   

The error message shown below is a sample of what is displayed when more than 1.0 is 
posted to a lump sum item in any category.  If you receive this message, simply adjust the 
posting for the lump sum item. 
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Remember, lump sums must range from 0 to 1.0 and cannot overrun.  You cannot 
increase or decrease a lump sum item through an increase/decrease contract 
modification.  To increase, create a contract modification for a new item (it can be the 
same description unless the item is mobilization).  To decrease, create a cont mod for a 
new item and, since you cannot have a negative lump sum item, use a generic Each item 
and use a negative quantity of one then enter the amount of dollars you want to reduce. 
 
 
Click the Close button to return to the IDR list 
 
 
 
Generating the IDR - 

You CAN generate an IDR that has not been saved.  When you generate an IDR it 
will automatically save it as part of the generate process.  We’re going to generate this 
IDR so the information can be included in a diary and an estimate.  The IDR can be 
generated from any folder tab or the IDR list, whichever is most convenient. 
 

Highlight the IDR to generate (the one dated yesterday) 
Click the Generate button 
Answer Yes to the “Are you sure” question 
Click the Cancel button at the print screen.  The print option is automatically 

available at the time the IDR is generated.  You can print the IDR at a later date if you wish 
- or never!! 

If you want to print the IDR at a later date - 
At the IDR list highlight the appropriate IDR 
Click the Print button 
Select the option to print the selected IDR 

Notice the Gen column now has a Yes instead of a No for this IDR. 
 
Click the Close button to return to the contracts list. 
 

 
Quantity Overruns 
 Before we look at how to correct posting errors and overpayments for a line item, 
let’s look when items overrun the authorized quantity, why they are sometimes paid in full 
while other times they are not.  Remember, everything is based on the category 
dollars, not the total contract dollar amount. 

***  If an item overruns more than $50,000 in a category, the estimate will pay only 
up to that $50,000 amount (no matter what % of overrun it is) for the item.  Any quantity 
above that will be held until a contract modification to increase the authorized quantity is 
written and approved. 
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Some hints when looking at the item list – 
***  For items displaying more quantity placed than paid, it could be that – 
 1.  An estimate has not been created since the posting(s) was made 
       OR 
 2.  The dollar amount of the item overrun exceeds $50,000 in a category 

   
  

 
Overpayment of a Line Item 

Mistakes happen!!  If you goofed and either overpaid a line item or paid one 
incorrectly there are a couple ways to correct it.  If that entry HAS already been included in 
an estimate, you will need to make an offsetting (correcting) entry in an IDR to take care of 
it in the following estimate.  If that entry HAS NOT been included in an estimate, you can 
simply correct it in the IDR where it was entered or make an offsetting (correcting) entry in 
a following IDR, whichever you prefer!  What a deal, huh!!! 

Just like always, if the correction involves a large negative dollar amount, be sure 
your estimate and/or voucher will have enough payment to offset that negative correction.  
You cannot process a negative estimate or voucher unless it is a semifinal type and will be  
followed by a final. 
 
 
 
 
IF THE OVERPAYMENT HAS NOT BEEN INCLUDED IN AN ESTIMATE . 
   If you don’t know which IDR was involved or if there were several item progress entries 

in more than 1 IDR, the simplest and probably easiest method is as follows - 
 

Highlight Contract 78-0061-114 
Click the IDRs button 
Click the Add button  
General folder tab – today’s date is OK. 
Inspector – leave yourself as the choice 
Comment - IDR to correct item posting for River City Barricade Co 
Click the Postings folder tab 
Click the Add Posting button to bring up the item list 
Select Item No. 0590, Traffic Control 
Category 3 is already selected for you 

The item progress in the top portion of the screen shows 1 but should 
really be .1 so.. 

 Contractor = choose River City Barricade Co 
 Location = correction 

Quantity = -.9 (that’s minus .9) 
Remarks = Correction for previous entry error (you would also include the date of 

the IDR where the error occurred if you knew that) 
Click OK 
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Since the correction has taken place BEFORE being included in an estimate, the correct 
amount of .1 will now be paid instead of the incorrect 1. 

  
 Save/Close 
  
A correcting entry had to be made because we could not go back to the original entry and 

simply change the quantity field. 
 
 
If you DO know which IDR was involved, a simple way to correct the problem is as follows: 
 
 You should still be at the IDR list for Contract 78-0061-114 

 
Highlight the IDR dated 3/21/13, Sequence 2 in the list 

Even though you did not create this IDR, you as a FieldManager user have 
the capability to change anything about any IDR no matter who created it.  
FieldBook users can change or delete ONLY the IDR’s they created - not 
ones created by someone else. 

Click the Change button  (we can change it because it has not been included in an  
estimate) 

Click the Postings folder tab 
Highlight the entry for Line No. 0030, Excavation, Cl 20 
 Click the Change Posting button 
Tab until the cursor is in the Quantity field 
Enter 304 in the Quantity field - You are simply correcting the original entry 

The original entry of 3040 was wrong - it should have been 304.  You do not 
enter -2736 (minus 2736) as a correcting entry since the number 3040 
has not been included in an estimate calculation and you are 
changing the IDR where the original entry was made.  You simply 
enter the correct number so when an estimate is created it will use the 
correct number. 

  
Click OK 
Click the Save/Close button 
Highlight the IDR in the IDR list 
Click the Generate button 

Answer Yes to the “Are you sure” question and the status in the Generate 
column will change from No to Yes 

As soon as the IDR is generated in FieldManager, the print screen automatically 
appears.  If you choose to print the IDR, click the OK button.  If you do not 
choose to print the IDR at this time, click the Cancel button.  You can print 
any IDR at any time. 

Remember, if you want to print the IDR at a later date - 
At the IDR list highlight the appropriate IDR 
Click the Print button 
Click the “Print the Selected Inspector’s Daily Report” option 
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Click OK 
Once you make a selection at the print screen, you’ll be returned to the IDR list. 
 
Close back to the contracts list 
 
 
 
 

 
IF THE OVERPAYMENT HAS ALREADY BEEN INCLUDED IN A VOUCHER.   

Since the incorrect quantity has already been included in a voucher, our only choice 
is to make a correcting entry in another IDR as soon as the error is discovered.  You can 
return to the IDR where the original entry was made but since it has been included in an 
estimate already, the Quantity field is locked and can’t be changed!! 

 
Highlight Contract 78-0061-114 
Click the IDRs button and highlight the IDR we created for today. 
Click the Change button (or double click the IDR) 
Click the Postings folder tab 
Click the Add Posting button to bring up the item list 
Highlight Line No. 0250, (‘Square Yards’ Item) Pavement Surface Repair (Grinding  
 Limestone or Gravel) 
 Click the Select button 
Contractor = Godbersen-Smith Const. 
Sta From = Enter a 0 if you don’t know the exact original entry 
Tab to the Quantity field, leaving the other fields blank 
Quantity = -11880 (The incorrect amount that was already paid for this category 

was 12000.  It should have been 120.  You can see the 12000 in the Cat. 
Qty. Paid field in the top portion of the screen.) 

Mark this item for attention 
Remarks = Correction for previous overpayment to contractor 

Anytime you make a correcting entry you should make some remarks and 
mark the item for attention 

Click the OK button 
Click the Save button 
Once this IDR is generated, the next estimate will now include the -11880 for this 

item quantity and will be reflected with a negative dollar amount for that line item.  When 
you make a correcting entry to reduce an overpayment, be sure you will be paying 
enough for other items on the same voucher to result in a positive dollar amount. 
 
 
 
Attachments Folder Tab 
Photos, drawings, etc. can be attached to the FM program.  Beware, however, that the 
size of the contract can increase dramatically depending on the attachments. 
   To create a new file and attach it – 
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 Click the Add Attachment button 
 

 
 
 
 Enter the name and then Browse to locate the attachment. 

Enter a short descripton of the attachment 
 Click the Add button 
 
 To see the attachment in FM, highlight and then click on the View  
  Attachment button 
 Click the red X to exit the view screen 
 Save 
 
To change an attachment in the list – 
 Highlight the attachment name 
 Make the appropriate changes in the name or description fields 
 Save 
 
To delete an attachment in the list – 
 Highlight the attachment name 
 Click the Delete Attachment button 
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Be cautious here ……  
 
Answer Yes to the “Are you sure…” question to delete.   
  This will delete the attachment everywhere.  To save it externally from 
FieldManager, follow the directions in the Delete Warning message as shown in the 
above graphic. 
  
 
The View Folder Tab - 

Click this folder tab to see the IDR report as it would be if it were printed.  
Attachments are NOT printed as part of the IDR report.   Use either the scroll bar on the 
right to move up and down or click the mouse in the text area and then use the up and 
down arrow keys.  Zoom in and out buttons are available for your convenience.   

If you wish to print the IDR now, click the print button. If the IDR has not been 
generated, the word Draft will print over the top area of the first page.  This will be 
removed once the IDR has been generated. 

Click the Save/Close button to return to the IDR list. 
If you didn’t print while you were in the View tab of the IDR, you can print from the 

IDR list.  While at this list, click the Print button and you’ll be given an option – 
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You can either print the reports of all the IDRs that are highlighted in the list or you 
can print just the list of IDRs.  In the above graphic, the 2 IDR’s that are highlighted in the 
background will have their reports printed.  This would be the same reports you would get 
if you went into each IDR, clicked on the View folder tab and then clicked the Print button.  
It’s just a much quicker and easier method. 

If you choose to print several reports, you can put a checkmark in the Consolidate 
into One Print Job option if desired. 

 
 
 
 
 

Deleting an IDR 
If you have an IDR in your list that you want to delete so it is no longer a part of the 

record you can do so - maybe!!!  Highlight one of the IDR’s in the list (you should still be in 
Contract 78-0061-114) then click the Delete button. 

 

 
 
If the IDR has item postings included in it, you CANNOT delete the IDR.  But, if you 

go into that IDR and delete each one of those item postings individually first, then you will 
be allowed to delete the IDR.  The exception to this is - You cannot delete an IDR that 
has already been included in an estimate (that item postings have been paid). 

In other words, if the IDR (which includes item postings) has been included in an 
estimate, meaning those postings have been included as payment to the contractor, you 
can no longer delete that IDR from the list - period!!  In this case you no longer have the 
option to go into the IDR, delete the individual item postings first, and then delete the IDR 
since the items have been paid. 
 
Click the OK button at the error message to return to the IDR list 
 
 
If you have inspectors who wish to see all IDR’s for the contract, do you remember how to 
change that? 

Click the Docu button 
The lower right of the General folder tab now shows the View IDR’s for 100 days 

since we changed it earlier. 
Change that number back to 9999 as per the inspector’s wishes. 

This choice is contract specific - it can be one number for one contract and a 
different number for another contract.  But all inspectors working on one 
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contract must have the same number - it’s not inspector specific on a 
contract. 

 
Remain at the IDR list for Contract 78-0061-114 
 
 
 
Searches - 
 You sometimes need to go back through many IDRs to find specific information.  
You can either look through each individual IDR or let the program do the searching.  I 
vote for the easy way so let’s create a filter. 
 We’re going to create a filter for an IDR which will filter out every IDR except the 
ones that meet our requirements.  In this example, we want to find every IDR with “warm” 
mentioned in the comments field so… 
 

 
 
 You should still be at the IDR list for Contract 78-0061-114 
 Click the Filter button 
 Select Comments in the Column field 
 Select CONTAINS in the Operator field 
 Type  WARM in the Value field 
   This is not case sensitive 
 To see all the IDRs once again, select Show All in the Filter field (top,  

right of screen) 
 
 
 Close back to the contracts list
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Importing IDRs from Inspectors - Using Flash Drive 
 

IDR’s can be created by inspectors using FieldBook or by someone using 
FieldManager.  If an IDR is created in FieldManager it will automatically indicate that one 
has been made and who made it when a diary is created for the corresponding day.  If the 
IDR is created in FM, it must be generated to have the item postings included in an 
estimate.  If the IDR’s are created in FieldBook, we must have a way to get that 
information into FieldManager. 

Exporting from FieldBook - 
The inspector uses the export process to put the generated IDR information 

on a flash drive for submitting to the office.   
If the IDR is not generated it CANNOT be exported to 
FieldManager.  It will show on the inspector’s list of IDRs 
created but won’t allow it to be selected for exporting to 
FieldManager. 

When the inspector creates the file to be imported into FieldManager, the file 
is automatically named based on the inspector’s initials who is logged 
into the program at that time.  The filename will be XX_IDR1.EBL with 
the XX’s being the inspector’s initials.  If this was not the first file of 
this type on that flash drive, the number would be 2 or 3 rather than 1, 
depending on how many files were there already. 

 
The FM user imports the IDR information -  

At the Contracts list screen in the FieldManager program 
Click Import-FB 
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The program will not ask for the name of the file, just the location.  The files 
created by the inspector are automatically named and have the extension of 
.EBL.  When the FieldManager program imports a file from FieldBook, it 
looks for any file in the specified location with an extension of .EBL and 
imports it. 
Unless you change the location, E:\ will remain as the default for future 
imports. 

   There can be one or several IDR’s for one or more contracts 
imported at the same time, depending on how many IDRs the 
inspector chose to include in the file.   

Click OK 
Click Cancel at the print screen – (it’s up to your office to determine whether  

or not you print the IDR’s and return them to the inspector) 
  Click OK at the import message 

 
Once the IDR information has been imported, a turn-around-file is created 

automatically which the inspector should import back into his/her 
laptop.  This turn-around-file will have the same name EXCEPT the 
IDR1 portion of the file name will be replaced with AUTO. This file, 
once imported into FB, will update the FieldBook contract with 
information as current as when the turn-around-file (TAF) was created 
in FieldManager. 

Once again, the TAF is named automatically based on the initials of the 
inspector who created the original export file in FieldBook.  That is the 
individual to whom you return the disk. 

Repeat for each flash drive received from each inspector.    
Remember, once the original file from FieldBook is imported into 
FieldManager, it will disappear from the source (flash drive) and a turn-
around-file will be created automatically in its place.  That file should then be 
imported into FieldBook. 

 
 
If the FieldBook IDR file is lost before it was imported into the FM program – 
 Go to the FieldBook computer and click the Export – FM button.  Put a checkmark 
in the “Include Previously Exported IDRs” option in the lower left area of the screen.  All 
IDRs except those with a status of Refreshed will be included in the list.  Highlight the 
IDRs you wish to export and “re-export” them!   
 
 
An inquiry that might be helpful after importing IDR’s Into FM - 

This inquiry will display items that inspectors have marked for your attention.  If the 
inspector would like you to take special note of something, they will mark it for attention 
and have a comment.  Since you don’t want to go through every IDR in the contract and 
item to find these items marked for attention, this is the easiest way to spot them. 

Click the Inquiries button 
Double click the inquiry Item Postings by Item That Are Marked for Attention 
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  Click the Select All button at the items list 
 Only the items that have been marked for attention will be displayed 

 
 
 
Importing IDR’s From the Server - 
 
Sometimes it’s impossible for project inspectors to return to the office to physically turn in 
their IDR flash drives.  This process can be done via the server BUT communication is 
critical.  The inspector must notify the office so they know when IDRs are ready to be 
imported.  Also, each inspector must have their own folder on the W drive for placing their 
IDR files.  (This same folder can be used for their backup files) 
  
Each inspector’s IDR’s should be put into their unique folder that was created on the W  
drive specifically for their files – and only their files.  The inspector exports their IDRs  
directly from FieldBook to their folder on the W drive. 
 
The FM user imports the inspector’s IDRs directly from that inspector’s folder on the W 
drive.  Once the import path is entered, that path will remain in your list for future use. 
 
Once the IDR information has been imported into FieldManager, the turn-around-file (TAF) 
is automatically created in the same location (the inspector’s folder on the W drive).  The 
inspector imports the TAF into FieldBook from their folder on the W drive.   
 
Once the TAF import into FieldBook is complete, all information in FB will be as current as 
when the turn-around-file (TAF) was created in FieldManager. 
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Just for your information - 
 

Once the IDR’s have been exported from the inspector’s FieldBook  
program, they will remain in the IDR list but will have a status of Exported.  The 
inspector can view them in the FB program but can no longer make changes to 
those exported IDR’s.   

 
If an IDR with a status of Exported in FB is lost before it has been 

imported into FieldManager, the IDR can be “re-exported” by selecting the 
“Include Previously Exported IDRs” option in the Export-FM button in FB.  
Highlight the appropriate IDRs and export. 

 
Once the inspector imports the turn-around-file received from 

FieldManager, the IDR’s that were exported will have a status of Refreshed.  The 
inspector can view them but cannot make changes to those refreshed IDR’s. 
 

If the inspector cannot change an IDR on his/her machine, they can go to 
the FieldManager machine and change the IDR there up until that IDR is 
included in an estimate. 
 
 
 

The import/export process of IDR’s can be done daily, weekly, or whatever 
time period works best.  The more often the better.  Daily is best, every other day 
is next best.  Receiving IDR’s less than once a week will cause problems due to 
the requirements of creating and mailing the Weekly Report of Time Charges to 
the contractors and getting items paid in a timely manner. 

 
  Once the inspector’s IDR’s have been imported into FieldManager, the 

FM user can edit them as desired.  If changed, the IDR will be given a revision 
number and will log the ID of the person who made the revision. 
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Entering Diary Information        
 

The diary is a combination of all IDR’s for a given date.  It’s also the location 
where working days are charged.  Unlike IDR’s, there can be only one diary per day per 
contract.  The diary can only be created in the FieldManager program.   
 

We’re going to work with Contract 78-0061-114 so highlight it in the contracts list. 
Click the Diaries button in the Applications toolbar and a list of all previously 

created diaries will be shown.  (None for this contract!) 
Click the Add button to create a new diary. 

A diary can be created for today or a previous day that has not had one 
created already but a diary CANNOT be created for a future day.  If 
you attempt to create a second diary for a day a warning will be 
displayed when you try to save it.  See the graphic below. 

 

 
 

    General Folder Tab 
The top portion of the screen has information that cannot be changed by the user.   

The Date/Time Entered = This is based on the computer’s date.   
 
Entered by = These initials are entered based on the user ID who logged in to 

FieldManager.  (This is another reason why it’s important for each user to 
log in using their own ID.)    

 
Generated = This is No until the diary has been generated for inclusion in an 

estimate.  Once the diary has been generated, this field will automatically 
change to Yes.  If changes are made after that and the diary is saved, that 
will “un-generate” the diary and it will need to be generated again to be 
included in a future estimate.     The working day charge for a day will 
not be included in an estimate unless the corresponding diary is 
generated. 

 
Revised By = If the diary has been saved and/or generated and then changed, 

this field will show the user who is responsible for the last revision.  
 
Revision Date = The date the last revision was made.  If it’s been revised more 

than one time, it will show only the last date. 
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Revision Number = The number of times this diary has been revised after being 

saved and/or generated. 
 

 
 

When you select a date and tab out of that field -- 
 
If there are generated IDR’s available for this diary day, they will be listed in blue and  

show the initials of the user(s) who created them.  If a user created more than 
one  IDR for that day, there will be a digit representing the number of IDRs 
following the initials. 

If there are un-generated IDR’s available for this diary day they will be listed in red 
If your diary shows un-generated IDRs, they were probably created in the 

FieldManager program since only generated IDR’s can be exported 
from FieldBook and/or FieldPad.   

If no IDR’s are available for this diary day, a message stating “No IDR’s” will be 
displayed. 
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NOTE:  If you have un-generated IDR’s at the time you create the dairy, you can always 
generate them at a future time so the item postings will be included in an estimate. 
 
You can have an IDR without a diary and you can have a diary without an IDR.  One 
(diary) is responsible for the working day charges in an estimate and the other (IDR) is 
responsible for paying items. 
 

The lower portion of the screen is where you make entries to be included in the 
diary information for this contract.  The fields are as follows - 

 
Diary Date = The default date is the current computer date but you may change 

this to any previous date.   The program will not allow you to create a diary 
for a future date.  Either leave the date as it is, type in the correct date, or 
click the calendar icon and select the date you wish by that method. 

 
Author = The author will default to the user who logged on to FieldManager - 

which should be the same person as whose initials show in the Entered 
By field in the top portion of the screen.  The author may be changed to 
any other person shown in the drop down list and does NOT need to be 
the same person as in the Entered By field.  This is done so someone in 
the office can log on to FieldManager but have someone else enter the 
diary information if desired - and know many days later who did it!!   

 
Low Temperature = 
High Temperature = These can be typed in by the user creating the diary. 

OR 
If there are generated IDR’s shown for this diary date, you 
can click the Bring in Temperature button at the bottom of 
the screen to bring in the high and low temperature 
information as entered by the inspector(s) who created the 
IDR(s).   

If more than one IDR exists for a diary date, the chances that the 
high and low temperatures will match exactly are not very good!!  If 
that is the case, only the lowest low and the highest high selections 
will be brought into those respective fields. 

 
Sunrise 
Sunset = These fields are NOT part of an IDR so must be entered here if you 

wish that information as part of the documentation.  The time may be 
entered as regular time or military time.  The Sunrise field assumes AM so 
it doesn’t need to be typed in.  Likewise, the Sunset field assumes PM so 
that doesn’t have to be typed in either.  The time can be entered using 
either a period, a colon, or a space.  In other words, entries of 8.20 and 
8:20 and 8 space 20 will result in the same time shown.   
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FYI - There is a website where you can view and print the sunrise and sunset times for 
your area for an entire year.  That address is  
  http://aa.usno.navy.mil/AA/data/docs/RS_OneYear.html 
Enter the information for your city and click the Compute Table button. 
Printing hints can be found by scrolling down on the screen where you clicked the  

Compute Table button. 
Weather = Information may be typed in here by the FieldManager user 

OR 
If there is a generated IDR, you can click the Bring in Weather and 
Comments button in the lower right of the screen.   If there is more 
than 1 IDR for this date, the weather data will be displayed in the 
Comments area following the IDR creator’s name.  If there is only 1 
IDR for the date, the weather data will be displayed in the weather 
field. 

 
Comments = You may type in your own comments AND you may bring in the 

comments from generated IDR’s.   
 There is the equivalent of 3 single spaced typed pages or 32,000 
characters available for comments for this diary.  Since there was 
the same amount available for each IDR, there COULD be a space 
problem if there are several IDR’s with very lengthy comments.  
This is a possible problem but most likely not a probable one!! 

 
OK, now that I’ve just talked you goofy about all these fields, let’s put something 

in them!!  We’ve already clicked the Add icon to create a new diary - we just haven’t 
decided on a date yet!! 

Enter the IDR date you created that is generated in the Diary Date field by 
clicking the calendar and then clicking the correct date so the red square 
surrounds it.   

Click the OK button.and tab out of the date field 
If your name doesn’t show in the Author field, click the arrow so the drop down 

list appears and highlight your name there or, if you prefer, type in the first 
letter of your first name and that could bring it in.  If there is more than one 
name that begins with the same letter, press that letter again to go to the 
next selection.  This list, like others in FieldManager, is organized in 
alphabetical order. 

Click the Bring in Temperatures button.   (If you prefer to have a different 
temperature shown, you can change the numbers.)    

Enter 6.45 in the Sunrise field (that’s 6 period 45) 
 You can also press the space bar instead of entering a period to get the  
 same result of a colon 
Press the Tab key 
Enter 8 space 30 in the Sunset field (just so you see 2 of the ways that work!!) 
Press the Tab key 
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(Notice that AM and PM were entered automatically after you pressed the 
Tab key.) 

Click the Bring in Weather and Comments button 
 

 
   

 
Based on the information we just entered, the General folder tab for your diary should 
look similar to the above graphic except for the sunrise and sunset fields. 
 
 
    Site Times Folder Tab - 

This folder tab gives you information concerning site time(s) and is also where 
you charge working days to the contract.   The top portion of the screen is view only and 
cannot be changed by the user.  The totals are updated from estimates and diaries that 
have been generated.   
 

The middle portion of this screen shows the number of sites for this contract 
(every contract has Site 00), the Site Description (it could just be a period or a double 
quote sign), and the type of days being charged on this contract (Work Days is the 
choice most of the time).  Time is charged to the contract NOT to individual projects 
within the contract.  Liquidated damages are no longer automatically withheld but if you 
overrun the number of working days allowed for any site, you’ll be required to make 
comments when creating an estimate.  (A cont mod must be written for liquidated 
damages and a negative posting made to that item.) 
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The lower portion of the screen is where you make your entries.  Some of the 
information entered here will be automatically reflected on the weekly working day 
report. 

 
 

 
 
 
 
Highlight Site 01 and let’s look at some of the fields. 

In the Days Allowed row - 
Original = The original number of days for the site that’s highlighted in the 

middle portion of the screen  
Authorized = The current number of days for the site that’s highlighted in 

the middle portion of the screen.  This will be the same as the 
original number UNLESS a time extension contract modification 
has been approved to increase the number of working days allowed 
for this site. 
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Pending = The number of days the highlighted site will be increased 
through a time extension contract modification after the contract 
modification is approved. 

In the Days Charged row - 
Diary = The number of days that have been charged to date in saved 

and/or generated diaries in FieldManager. 
Estimate = The number of days that have been charged to date on 

estimates.  This is as current as the last processed estimate.  
 

The fields in the lower portion of the screen for each site can be populated 
automatically by clicking the Bring in Site Data button for that site – or you can 
enter the information by hand if you prefer.    H’mm, let me see, click a button or 
type a lot of information – I know which choice I’d pick!!!!    
 
 
Some information about the fields - 

Time Charged - An entry of 0, +.5, or +1.0 is valid 
Contractor Working - Yes or No are the only options 
Hours Available 
Hours Worked - These two fields are good supporting documentation for 

charging or not charging a working day but neither field is required. 
Controlling Operation - The information entered here will appear on the 

Weekly Report of Working Days.   
Reason for Delays - The information entered here will appear on the 

Weekly Report of Working Days.
Comments - The information entered here will appear in the Site 

Information section of the Daily Diary when you either view it or 
print it. 

 
 
OK, so I’ve now talked you goofy in this area too, huh!!!  So let’s make some entries and 
use this new found knowledge!!!! 
 

We’re still working with Contract 78-0061-114 
Since you don’t know which sites have time charged, highlight Site 00 and see if 

the “Bring in Site Data” button is black or grayed out.  If it’s black, click it.  If it’s gray, 
highlight the next site and repeat for each site. 

Highlight Site 01 in the middle portion of the screen.  (The information we enter 
now will be for this site only, no others.) 

Click the Bring in Site Data button 
 

Highlight Site 03 in the middle portion of the screen.  Click the Bring in Site Data 
button 

If you do want to enter time charge information when the Bring in Site Data 
button isn’t available for use, you can type in the information 
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Enter the following information in the correct fields if you have no information to 
bring in for Site 03 by clicking the Bring in Site Data button. 

    Time Charge = 1 
    Contractor Working = Yes 
    Hours Available = 4 
    Hours Worked = 4  
    Controlling Operation = Excavation 
    Reason for Delays = rain in afternoon 
    Comments = leave this blank 
NOTE:  All entries brought in from the FieldBook program can be edited in  
FieldManager. 
 
Highlight Site 02 and notice that it is a Calendar Day Site –  

There is no Time Charged field but you can enter information elsewhere to 
know the number of days left or over the allowed days.  

 
Calendar Day Sites =  

Enter the first day work began on the specific site in the Docu > Time Charges 
Start Date field and then Save/Close. 

Open the Docu > Site Times tab.  There will now be a number displayed in the 
Days Used field in the upper portion of the screen.  If that number is positive, that is the 
number of days over the number of days allowed.  If the number is negative, that is the 
number of days that have been used of the number allowed. 
 
Fixed Completion Date Sites = 
 Enter the completion date in the Docu > Time Charges Start Date field and then 
Save/Close. 
 Open the Docu > Site Times tab.  There will now be a number displayed in the 
Days Used field in the upper portion of the screen.  If that number is negative, that is the 
number of days until the completion date.  If the number is positive, that is the number 
of days past the completion date. 

Calculations for both calendar day and completion date sites are based on the 
date entered in the Docu > Site Times > Time Charges Start Date field.  

 
Click the Save/Close button 
 
 
Multiple IDR Time Charges for the Same Day - 
If there are multiple inspectors working on the same contract and they each 

create an IDR with a time charge, it won’t be a problem even if the time charge is for a 
different amount.  When multiple time charges are imported into FieldManager for the 
same day, a screen (see below) will alert you to such and you will choose the 
appropriate one to use. 
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In the case above, highlight the one you choose to use for that day’s diary and 

then click the Select button. 
 

 
 
    CHANGING a Site Time Entry BEFORE It’s Included in an Estimate - 

If you wish to change a site time record, you can do so easily AS LONG AS that 
record has not been included in an estimate.  Do so by opening the correct daily diary, 
highlighting the site needing the change, and changing the information in the 
appropriate field.  If the diary date has already been included in a weekly working 
day report, that report must be deleted before the diary can be changed. 

Highlight the diary we were just working with in the diary list 
Click the Change button 
Click the Site Times folder tab 
Highlight Site 03 
Click in the Time Charge field and change the 1 to .5  

Press the Tab key and notice that the charge field in the middle portion of 
 the screen reflects the change 
Click the Save/Close button 
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    DELETING a Site Time Entry BEFORE It’s Included in an Estimate - 
By using the Delete Diary Time Record button at the bottom right of the screen, 

you can delete a site time entry for any daily diary AS LONG AS it has not been 
included in an estimate.  If the daily diary has been generated, the site time entry can be 
deleted BUT if the daily diary with the site time record has been included in an estimate, 
you CANNOT delete it using the Delete Diary Time Record button. 

Highlight the same diary again 
Click the Change button 
Click the Site Times folder 
Highlight Site 03 
Click the Delete Diary Time Record button 
 This will delete the information for ONLY the site highlighted in the middle  

portion of the screen. 
 
 
 
 
 
 
 
 
 

Answer Yes to the confirmation of the delete 
Click the Generate button 
Answer Yes to the “Are you sure” question 
Cancel at the Print screen 
Close back to the contracts list 
 

 
 
DELETING a Site Time AFTER It’s Been Included in an Estimate - 

If the diary has been included in an estimate, you CANNOT delete either the 
 diary or the diary time record contained within it. 
 
 
 
 
 
 
 
 
 
Once a time charge has been included in an estimate, it cannot be 
deleted but it can be changed! 
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    CHANGING a Site Time AFTER It’s been Included in an Estimate - 
We’re going to switch contracts for a bit. 
Highlight Contract 78-0061-114 
Click the Diaries button 
We’re going to work with the 3/15/13 diary 
 
To make a change to a site time record AFTER the daily diary is included in an 

estimate you must make a time charge adjustment.  
 If that diary date has already been included in a weekly working  
day report, that weekly report must be deleted before the  
adjustment can be made.   

 
Click the Change button 
Since this diary has been included in a weekly working day report, we can’t 

change it until the corresponding weekly report is deleted.  If there are multiple sites and 
a weekly report has been created for each site for that week, every site must be deleted 
before a change can be made to anything in the diary.  If you try to change the diary 
without deleting the corresponding weekly report, you’ll get the following message – 

 

 
 
Click OK to the message 
 
Click the Misc Rpts button 
Double click on the Weekly Report of Time Charges report or highlight it and click  

the View button 
The only report shown includes the diary date we want to change so, with it  

highlighted, click the Delete button. 
 Answer Yes to the “Are you sure?” question 
 Close 2 times and you’ll be back at the diary list 

Highlight the 3/12/13 diary if it isn’t already 
Click the Change button 
Click the Site Times folder tab 
Highlight Site 03 

 Click the Adjust Time Records button 
This button is grayed out for any diaries NOT included in an estimate. 
    To decrease time charged for the highlighted site on that date, enter a  
    negative number in the Time Charge Adjustment field.  To increase a  
    time charge, enter a positive number in the same field. 
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 The result we want is to have only .5 charged to Site 03 rather than 1.  To do so - 
Enter -.5 (minus .5) in the Time Charge Adjustment field.  Make a 
comment such as “weather change in afternoon” that will be helpful to 
justify why you changed the time charge. 

You may make time adjustment entries in half day increments between -1 and 
+1.  

 
 
 

Click the Save/Close button  
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Since this diary had already been generated and you made changes, when you 
attempt to save and close you’ll get a message that saving it will change the 
status to un-generated and will ask if you really want to do that.  You do want to 
do that to get the change included but, at the very latest, don’t forget to generate 
that diary again once you get back to the diary list. 
 

 Answer Yes to the question in the above graphic concerning saving the diary 
 

Highlight the Diary for 3/15/11 which now shows that it’s not generated.   
Click the Generate button 
Answer Yes at the “Are you sure...” question 
Click Cancel at the print option screen 
 

. 
 
Attachments Folder Tab 
Photos, drawings, etc. can be attached to the FM program.  Beware, however, that the 
size of the contract can increase dramatically depending on the attachments. 
 
Click on the Attachments tab 
 
   To create a new file and attach it – 
 Click the Add Attachment button 
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 Enter the name and then Browse to locate the attachment. 

Enter a short descripton of the attachment 
 Click the Add button 
 
 To see the attachment in FM, highlight and then click on the View  
  Attachment button 
 Click the red X to exit out of the view screen 
 Click the Save button and the attachment will become part of the diary 
 
To change an attachment in the list – 
 Highlight the attachment name 
 Click the Change Attachment button  

Make the appropriate changes in the name or description fields 
 Save 
 
To delete an attachment in the list – 
 Highlight the attachment name 
 Click the Delete Attachment button 
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Be cautious here…. 
 

 Answer Yes to the “Are you sure…” question to delete.   
  This will delete the attachment everywhere.  To save it externally 
from FieldManager, follow the directions in the Delete Warning message as 
shown in the above graphic. 
 
 
 
    View Folder Tab - 

When in a diary, click the View folder tab to see the daily diary as it would be if it 
were printed.  Use either the scroll bar on the right to move up and down or click the 
mouse in the text area and then use the up and down arrows.  Zoom in and out buttons 
are available “for your viewing pleasure”!!! 

If you wish to print the report, click the Print button.   
 

 
 
If you click the Print button while at the list of daily diaries, you will have an option 

to print either the list of diaries or the reports of the highlighted diaries in the list 
Close back to the diary list. 
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Cancel and close back to the Diary list 
 
If any of the diaries in your list show that they have not been generated, generate them 
now. 
 
Cancel at the Print screen 
 
Close back to the contracts list 
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Creating a Weekly Report of Time Charges - 
A weekly working day report should be created each week for each site 

where work is being done in every contract.  If a contract has 4 sites, then 4 
working day reports should be created for that contract and sent to the 
contractor, assuming work is being done on all 4 sites.  Working days can 
overrun one site without affecting the other sites.  Although we’re not 
automatically withholding liquidated damages, the working day report is the only 
way contractors know what specific days have been charged for what sites and 
how close they’re getting to a potential liquidated damage charge in each site.   

Creating only one weekly report for an entire contract with multiple sites is 
not acceptable for the very reasons mentioned above.  The contractors want to 
be shown which specific days are or are not being charged for each site. 
 

Although the weekly working day report is not created automatically at the 
end of a week, most of the data in the report is displayed automatically from what 
is entered in the Site Times folder tab of the diary.  You must have generated 
diaries for the days included in the weekly report before the fields in that 
report are populated. 

 
Let’s view the fields involved and then create a weekly working day report.  

Now you just knew we were going to, didn’t you!!!   
Highlight Contract 78-0061-114 in the contracts list 
Click the Misc Rpts button 
 

   
 

Since the weekly report is the one you’ll be using consistently, sort 
(double click in the header) so the list is shown in reverse alphabetical order.  
Since the program defaults to the top choice in the list, the weekly report will now 
be located there - and will save you from having to highlight it each time. 
 

Highlight Weekly Report of Time Charges 
Double click on it or click the View button  

A list of all previously created weekly reports are shown – none for  
us 

 
Once you create a weekly report, you can’t add, change, or delete a 

diary for any day within that week unless that weekly report 
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has been deleted.  If more than 1 site is involved, all sites must 
be deleted. 

 
The weekly report for each site is assigned a report number but that number is 
not displayed in the weekly report list.  It is, however, displayed on the General 
folder tab and is incremented automatically by one for each site each time a new 
week’s report is created for that site.  The report number can be changed.   
 
Only 1 report per week for each site can be generated.  If a second one is 
created for the same week, the following message will be displayed when you 
attempt to save the duplicate report. 
 

 
 
Since we want the experience of creating a weekly report, we’ll click the Add 
button 
 
Let’s “check out” the fields before continuing. 
 
General Folder Tab 
The information in the upper portion of the screen is automatically populated.   

Date/Time Entered – The date the report was actually created 
Entered By – The person logged in to the program 
Generated – Is No by default 
Received By, Revision Date, Revision Number – If the report has been  

saved and closed then changed, a revision number will be assigned  
and the date and person responsible for the revision will be  
displayed. 
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The information in the lower portion of the screen is entered by the user. 

  Site - If there is more than1 site for this contract, you should create a 
weekly report for EACH site that had activity during that week.  
Select the site from the drop down list.   

 
  Week Ending Saturday - If you type in or select from the calendar any 

date in a given week, once you press the Tab key the date will be 
changed to the Saturday of that week. 

 
  Author – Your name will automatically be displayed.  You may select 

someone else’s if their name should be displayed as the author on 
the printed form.  (The name entered in the Project Engineer field 
on the Docu > General Tab screen is the name that will be printed 
below the signature line.) 

 
  Remarks - Type whatever remarks, if any, you wish to say concerning 

this weekly report.  OK, so maybe that was too broad a statement - 
don’t necessarily type whatever you wish to say but whatever you 
should say!!!  Remarks are not required, you can leave this blank if 
you wish. 

 
  % Complete – The percent of the contract complete based on generated 

IDR’s.   This is automatically calculated for you 
 

  Open to Traffic Days  - This is an optional field 
 
OK, now that we’ve looked at the fields, let’s create a weekly report. 
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Select Site 03  
Click the calendar and select 3/13/13.  (To move to a different month, use 

the arrow keys beside the month and year.)  Click the OK button.  
Notice when you press the tab key, the date of 3/13/13 changes to 
3/16/13 which reflects the last day of that week. 

Author = Your name will automatically be displayed.  If you want another  
name, select it from the drop down list. 

Remarks = Enter something of your choice here - Even just some xxxx’s 
so you can see where the remarks are displayed on the printed 
copy 

Report Number = this is entered automatically – leave it as is 
% Complete =  Leave it as is 
Open to Traffic Days = Leave blank 

 
Click the View folder tab  

This is a preview of the report as you would see it if you printed it.  
Zoom buttons are available for your use.   

 The word DRAFT is displayed across the top of the report until  
it has been generated.  The report can be created, saved, 
and checked by a superior and then, at a later time, 
generated, printed and sent to the contractor. 

 
 Click the Generate button 
 Answer Yes to the “Are you sure…” question 

  
 Cancel at the Print screen 

When the report is generated, the print option is automatically  
made available.   

  
If you wish to print a working day report(s) at a later time you have 2 

options, just as you did with the IDRs and diaries - 
1.  At the weekly report list 
     Highlight the appropriate report 
     Click the Review button 
     Click the View folder tab 
     Click the Print button 
     Repeat for any other reports 

   
  OR 

2. At the weekly report list 
Highlight the appropriate report (s) 
Click the Print button 

You will get a choice of printing the list of or all the report(s) that are 
highlighted.   

The second option as shown below is much friendlier, faster, and easier!! 
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Click the Cancel button 
Close back to the contracts list. 
 
To view the specific working days and totals charged for each site, select the 
inquiry, Daily Diary Time Charges by Site.  The amount of time charged, the diary 
date, and author are displayed as well as the estimate number and estimate date 
if the diary has already been included in an estimate. 
 
If a time adjustment has been made, that adjustment will also be displayed in this 
inquiry.  In that case, there will be 2 entries for the same site and date, 1 for the 
original charge and the 2nd for the adjustment.  The total will reflect both entries. 
 
Notice in the graphic below that 3/15/11 had an original time charge of 1 and that 
time charge was included in Estimate #2.  An adjustment was made of -.5 for that 
day but has not yet been included in an estimate.   
 
 

 
 
Close back to the contracts list. 
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Contract Modifications - 
Contract Modifications are the ONLY way to change item quantity information 

and authorized site time information for a contract.  New items can be added, current 
contract items can be increased or decreased, site time can be extended, and general 
information concerning the contract can be added by the use of a cont mod.  All these 
types can be included in the same contract modification if you wish. 
 

Lump sum item quantities CANNOT be changed. 
 
 Most contract modifications involve more than one folder tab to complete but they ALL 
begin with the General folder tab. 

Highlight Contract 77-0171-016 in the contracts list so you can follow along as 
we look at the screens you’ll soon be using 

Click the Cont Mods button 
 

Click the Add button since we’re wanting to add a new contract modification 
 
General Folder Tab - 

The General Folder Tab will open first - Let’s look at some of those fields. 
 

 
 

Cont Mod Number - This will be entered automatically once the contract 
modification has been either saved or generated.  You cannot 
change this information. 
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Revision Number - Once the contract modification has been created it can 
be changed and saved many times.  Once, however, you generate 
the cont mod, the next time you change it, the program will assign a 
revision number.  You cannot change the number in this field. 

Status - This is entered automatically based on the status of the cont. 
mod.  Draft is the default status when a contract modification has 
been created.  Changes can easily be made or the cont. mod. can 
be deleted while it’s in this status. 

 
Pending Approval is the status of the contract modification once it 
has been generated.  The cont. mod. CAN be changed while it is in 
this status but once it is saved with the changes, the cont. mod. will 
revert back to Draft status. (Will no longer be generated)  It can, 
however, be generated again.  You can change or delete a contract 
modification with pending approval status. 

 
Approved is the final status.  Once the contract modification has 
been approved it CANNOT be changed or deleted.   

 
Amount - The total dollar amount of all items in the contract modification.  

This number appears as soon as the quantity entries are made for 
current or new items. 

Approval Date - The date you approve the cont mod in FieldManager.   
 The approval date for substantial cont mods (both federal aid 

and non-federal aid) is the date of Central Construction Office 
signature. 
The approval date for non-substantial cont mods is the date of 
the DCE signature. 

Cont Mod Date - This is a computer generated date.  Until the contract 
modification is generated, this will be the date the cont mod was 
created.  After that it will be the date the cont mod was generated.  
If the cont mod is changed and re-generated, it will have the date of 
the second generation. 

Short Description - A short description that will be sent to the mainframe to 
be processed. 

Description of Changes - This can be a lengthy description (about 3 typed 
pages) and is not sent to the mainframe. 

 
 
    Inc/Dec Folder Tab - 

If you want to increase or decrease the authorized quantity of a current contract 
item, click this folder tab.  We’ll go through the steps “generically” first so 
you can see the fields - we’ll make some actual entries later. 
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Click the Add Item button at the bottom of the page to select the item to increase 
or decrease from the list of items in this contract. 

Highlight the item and click the Select button 
 Select Line 0070 
 
 
  
 

 
 

If the item is in more than 1 category but you don’t want to make changes 
to all those categories, highlight the appropriate categories by 
holding the Control key down and clicking in each category you 
want to change.  Once the appropriate category lines are 
highlighted, click the Select button.  Only those highlighted category 
lines will then be available for increases or decreases. 

 
If you wish to make changes for the item in all categories, click the Select 

All button and all categories will be available for increases or 
decreases. 

 
Once you click either the Select or Select All button a new screen will appear 

where you can make the changes.  The top portion of this screen shows 
information concerning the line item that is highlighted in the middle  
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portion of the screen.  Any entries made in the bottom portion of the 
screen will be reflected in both the top and middle areas.  These two areas 
are view only so you cannot make entries directly in them. 

The field in the top portion that changes is the Catg Pending Chgs.  
The fields in the middle portion that change are Quantity 
Change (+/-), Dollar Value, and Catg Pending Changes. 

 
 
 

 
 
 
If this item had been marked for attention in the Items>Documentation screen, a 

checkmark would be displayed in the Atten field on this screen (far right column).  
You cannot enter a checkmark in the Atten box here. 

 
Qty Change (+/-) - Enter the change you desire to the original quantity.  The program 

assumes a positive number so if you want a negative result, you must type a 
minus sign in front of the number. 

Reason - Type in the reason for the increase or decrease in the item.  This is a  
required field.  It prints below the item in the cont mod.   

Dollar Value - This will calculate automatically once you make the quantity change  
entry and press the Tab key. 
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What will be the new authorized quantity is displayed in the Catg. Auth. + Pend. 
Quantity column. 
 
 
Since we’re just “checking out” the fields available, we’ll leave this screen and “check 
out” another folder tab.  
 
New Items Folder Tab - 

If you want to add a new item to the contract, click this folder tab. 
Click the Add Item button at the bottom of the screen to start the process of 

selecting the new item.  
 
 
 
 
 
 
 
 

 
 
 
You are then asked whether you wish to “Add a New Item” or “Attach an Item 

Saved Previously”.  You will always choose “Add a New Item” which is 
the default.  The other option is for situations where the field inspector 
can actually add the new item in FieldBook before the contract 
modification has even been created.  Iowa will NOT be using that feature 
at this time. 

 
Always click the OK button at this screen (or press the Enter key since OK is the 

default). 
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Let’s look out the fields we see on this screen. 
 
Item - If you click the down arrow beside the Item field it will bring up the master 

item list that contains only valid bid items.  If the contract is metric, only 
the valid metric items will be displayed.  If the contract is English, only the 
valid English items will be shown. 

This list is updated by importing the reference file into 
FieldManager.  The location of the most current file is 
W:\Highway\Construction\FieldManagerInformation\FM_Files and 
the name of the file is FMGRREF.REF.  You can import directly 
into FieldManager from the W drive or copy it to a flash drive and 
import it from there. 
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By default, the master list of items is sorted in alphabetical order so the 
Find field is for Item Description.  

Find Item Description - As soon as you type in the first letter of the item 
description the search will begin and will continue as long as you 
type letters of the word.  This search feature is NOT case 
sensitive.   You can also sort by either Item Code or Unit and 
search by that number if you prefer. 

 
Highlight an item and click the Select button or press the Enter key   

The item number will appear in the Item field and the description will 
appear to the right of it.  If that is the wrong item, simply click the down 
arrow again and re-select the correct item from the list. 

Supplemental Description - This field is optional but is VERY highly 
recommended if you select a generic item from the list.  The 
supplemental description you type in here WILL appear on the printed 
contract modification following the item description.   

Item Type - Select Supplemental Agreement (SA) - which is also your only 
choice!! 

Unit Price - The unit price for this new item.  THE UNIT PRICE MUST BE A 
POSITIVE NUMBER.     

Reason - This is a required field and is the reason for adding the new item(s).  
The reason is displayed below the item in the cont mod report. 

Section - If there is only 1 project and category in the contract, 0001 will show in 
this field.  If there is more than one project and/or category, there could 
be more than one section listed so that field would be blue and blank. 
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The number of sections in a contract is dependent on a number of things 
but is actually determined by the design engineer for the contract. 

 Whatever section you select from the drop down list, the 
corresponding project with some or all of its categories will appear 
in the bottom part of the screen.  If you select one and it’s wrong, 
simply re-select from this drop down list.   

You can add the item to as many project and/or category options as are 
available in each section.  If you need to add the same or a different 
item to a different section, you must repeat this “add item” process 
for that section.   

 Contractor – The contractor who will be doing the work on this item must be  
  selected from the drop down list. 

Proposed Quantity - The quantity for the new item for this project and category.  
The quantity CAN be a negative number UNLESS it’s a lump sum item.  
You can assign a quantity to as many lines as are available in this section 
without leaving this screen.   (The exception to the negative LS rule is if 
you used the FieldBuilder program to create the contract – and the DOT 
does NOT!!) 

 
If you click the OK button you’ll get a summary of what you have entered - with a 

different look to it! 
 
We will just click the Cancel button and then the Close button and choose NOT 

to save the cont mod.  Normally if you like what you see, you’d click the 
Save/Close button.  Since we’ve just been looking and not really doing, 
we don’t want to save anything we might have entered “just for fun” as 
we’ve been going through this. 

 
Since we’ve talked about increasing and decreasing current contract items, we’ll 
actually do that now as well as add a new item and then increase the number of 
working days allowed all on this same contract modification.  Hang on to your hats - 
here we go!!! 
 
Close back to the contracts list and do not save anything. 
 
We’re going to switch back to Contract 78-0061-114.  Click the Cont Mods button – 
there should be no cont mods shown.   
 

Click the Add button.  We’ll create a cont mod now. 
 
 
At the General Folder Tab - 

Short Description = Adjust qty for 0340, Locating Tile Line, add additional mob, 
increase WD allowed in Site 03 by 10. (Remember, everything in this field 
goes with the voucher to the mainframe.) 
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Description of Changes = Category quantity needs to be adjusted for Line 0340.  
Additional mobilization has been requested.  10 additional working days 
in Site 03 are being given due to extra work required by the contractor.  
(Nothing in this field goes to the mainframe.  It is used for explaining in 
detail the need for the contract modification)  

     Click the Spell Check button - This will spell check all areas of this folder tab 
not just the field where the cursor is located. 

 
At the Inc/Dec folder tab 

(Moving to a different folder tab does not automatically save what you just  
entered on the General folder tab.) 
 
Click the Add Item button 
Highlight Line 0340, Locating Tile Line 
Click the Select button 
  (If the item is in more than 1 category, a screen similar to the 1 shown on 

Page 5-3 would be displayed.  In that case, you would select the category(ies) you 
want to increase and/or decrease.)       
       
 Enter 5 in the Qty Change (+/-) field to increase the quantity for that category 
 Tab to the Reason field and type in Plan Error (this is a required field) 
  
 
If the item was in more than 1 category and if you had selected more categories than 
you wanted to change, you can delete the extra lines from the contract modification or 
you can do nothing to the extra lines so the quantity change field remains zero – then 
once you click Save or Save/Close using the 2nd option, you’d get a warning for each of 
the lines.  You would answer Yes to each warning and the zero item(s) would be 
deleted from the cont mod.  
 
Click the Save button 
 
 
 
Click the New Items Folder Tab - 

Click the Add Item button 
Click the OK button if “Add a New Item” is selected as the default (it should be!) 

Remember, the other choice, Attach an Item Saved Previously, is a 
feature we’re not using. 

Click the down arrow beside the Item field 
The list first appears in alphabetical order by item description so the Find 
field is based on that sort.  If you know the item code and would prefer to 
have them listed and find the item that way, double click in the Item Code 
header and the items will be sorted in ascending order based on the item 
code.  We’ll leave it sorted by item description for our exercises. 
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We need to include an item to pay for additional mobilization but since we  

CANNOT USE the regular MOBILIZATION ITEM, we will use a generic  
item instead along with a supplemental description 

Highlight (‘LUMP SUM’ ITEM) in the item list 
Click the Select button or double click the item and the item will be entered in 

the contract modification and the description will appear to the right of the 
item number 

Press the Tab key once 
In the 1st line of Supplemental Description field type Additional Mobilization 
 You cannot enter data in the second supplemental description line unless 

there is data in the first supplemental description line.  If you try you will 
get the following warning when you try to save the cont mod. 

 

 
Tab to the Item Type field 
Since this field is blue and blank and you want to select Supplemental  

Agreement (SA) with item contract modifications, you can either select  
Supplemental Agreement from the drop down list or type in the letter S 
and it will appear in that field.  Either method will get the same result. 

Press the Tab key 
 
We need to add a generic lump sum item for additional mobilization for $1500 

split evenly between Cat 1 and Cat 2 
We know that a lump sum item has a quantity of 1.  We also know that the 

additional mobilization of $1500 is to be split evenly between the 2 categories. 
To do so we’ll make 2 different entries - 
Type 750 in the Unit Price field.  Do NOT use the $ sign. 

Notice that the units show to the right of this field.  This is your second 
chance to be sure you’ve selected the right item AND unit. 

Reason - This is a required field.  Type “Additional mobilization requested by 
contractor” 

Press the Tab key 
Select Section 1 (this should display Cat 1) 

If that section doesn’t display the correct project and category, select a 
different section.  Continue until the appropriate project and category is 
displayed.  Without looking, there is no way to know which project and category 
is in each section. 
 

December, 2013 Chapter 5
 Page 10 
 



 
 The Contractor field is empty.  Assign this new item to River City  
  Barricade instead by selecting them in the drop down list of contractors. 
 

 
 

Enter a quantity of 1 for Category 1.  Use the Tab key to move from one field to 
the next and the Shift/Tab to move backwards through the fields.  Be 
aware - the categories are not necessarily in ascending order when 
you first get to this screen.  You can sort them in ascending order 
by category by double clicking in the Catg. column header. 

    A lump sum item rule is that every category must have a  
quantity of 1.0.  Because we have 2 categories and each  
has a quantity of 1, the result will be that $750 will be paid  
from each of them for the additional mobilization for a total  
of $1,500. 

  
  We still have another $750 to pay the contractor for additional  
mobilization for this project but in Category 2.  To do so we will need to add another 
line item to the contract.  This item can be the same item code and description as the 
one we just added.    
 
 
  Click the Add Item button 
  Click the OK button 
  Click the Item button  

 Highlight (‘LUMP SUM’ ITEM) in the item list 
Click the Select button or double click the item and the item will be  

December, 2013 Chapter 5
 Page 11 
 



entered in the contract modification and the description will appear  
to the right of the item number 

Press the Tab key once 
In the 1st line of Supplemental Description field type Additional  

Mobilization 
  Tab to the Item Type field and select Supplemental Agreement 
  In the Unit Price field enter 750 (no $ sign) 

Assign this new item to River City Barricade by selecting them in the drop  
 down list of contractors 

  Type “Contractor requested additional mobilization” in the Reason field 
  Select the Section 0002 to display Category 2 
   Use the down arrow on your keyboard to move quickly through the  

list 
  Enter 1 in the Proposed Quantity field 
  Click OK and you can view all the items added to this contract  

modification   Remember, whichever line is highlighted in the  
middle portion of the screen is detailed in the top portion.  Until the  
contract modification is approved, the quantity will be displayed in  
the Catg. Pending Chgs field 

  

 
 
If everything looks the way you want, click the Save button.  Even if you save the 
contract modification, you can still change it or delete it at a later date. 
 
 
 
Adding an Existing Contract Item to a Different Category – 
 If an item isn’t currently in an existing category, the only way the item can be 
added to that category is by adding it as a new item through a contract modification. 
 
The same item number (e.g. 2102—100100) that already exists in the contract can be 
added to the category where it currently doesn’t exist.  If, however, you do so, you’ll get 
the following warning. 
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This warning is simply a “wake up call” to alert you that the item already exists 
somewhere in the contract – not necessarily in the same project and/or category.  If 
you do get this warning, it’s a good idea to double check to be sure it doesn’t already 
exist in the same project and category where you’re attempting to add it.   
 
There is only one time when you would want to add an already existing item in a 
specific category to that same category again - that would be when the unit price 
is to be different.    
 
 
Adding an Item to a Non-Existent Category 

If you need to add an item by contract modification to a category that currently 
doesn’t exist, call or e-mail Janet (If Janet isn’t there, talk to Jen in the Creston Const 
Office 641-782-4518).  This could happen, for example, if the contract is 100% 
participating but you need to add an item to the contract that should be in a non 
participating category.  (The procedure is the same whether this item does or does not 
already exist in the contract.)  Details that you need to know before you call or e-mail -   
 ** Contract ID 
 ** Project Number needing the new category (especially important if there are  

multiple projects in the contract) 
 ** Funding Source for the new category (e.g. 100% STATE, 50% STATE & 50% 

 CITY of xxxxx) 
 ** Prime Contractor’s Name 
 -- Letting Date 
  --Bid Order Number 
If you furnish me with the ** items in the list, I can look up the 2- - items in the list.  
Then I’ll get the required codes from the Office of Contracts, create a download file, 
insert a new line with the additional category information, and send the new download 
file to you as an attachment to an e-mail. 
 
Once you receive the new download file, import it into FieldManager and then click the 
Items button, select the appropriate project, and then check the Category drop down 
list to be sure the new category is displayed.  If it is, great!!!  If it isn’t, call Janet or Jen!! 
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Time Extension Folder Tab 

Click the Time Extensions folder tab.  Use this tab to increase the number of 
working days allowed in any site on the contract. 

 
 

 
 
 
 
The top portion of the screen shows the days allowed, charged, and pending for 

the site that is highlighted in the middle portion of the screen.  The middle portion will 
list every site in the contract. 

  
Highlight Site 03 
If it isn’t there already, click so your cursor is in the Additional No. of Days field.  
Type 10 in the Additional No. of Days field  
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 YOU CANNOT ADD ½ DAYS – The program will not recognize a 
decimal  - only whole numbers. 
 

You enter just the additional number of days you want to add to the 
total.  Do NOT add the new grand total of working days allowed.   

Press the Tab key and the New No. of Days field will reflect the new total. 
Notice that the Days Allowed: Pending field shows the 10 we just 
entered.  Once this contract modification is approved, the increase will be 
reflected in the Authorized field and be blanked out of the Pending field. 

Type “Contractor requested 10 more days due to additional work that is 
required.“ in the Reason field.  This is a required field. 

 
Click the Save button. 

 
Attachments Tab - 
Photos, drawings, etc. can be attached to any contract modification.  Beware, however, 
that the size of the overall contract can increase dramatically depending on 
attachments no matter where they are located within the contract. 
   To create a new file and attach it – 
 Click the Add Attachment button 
 
 
 

 
 
 
 Enter the name and then Browse to locate the attachment. 

Enter a short descripton of the attachment 
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 Click the Add button 
 
 To see the attachment in FM, highlight and then click on the View   
  Attachment button 
 Click the red X to get out of the “view” mode 
 Save 
 
 
To change an attachment in the list – 
 Highlight the attachment iin the list and click Change Attachment 
 Make the appropriate changes in the name or description fields 
 Save 
 
 
To delete an attachment in the list – 
 Highlight the attachment name 
 Click the Delete Attachment button 
 

 
 
Be cautious here ……. 
 
 If you really wanted to delete the attachment, you would answer Yes to the “Are 
you sure…” question to delete.   
  This will delete the attachment everywhere.  To save it externally 
from FieldManager, follow the directions in the Delete Warning message as 
shown in the above graphic. 
 
Since we do NOT want to delete the attachment, answer “No” in the above graphic. 
 
 
View Folder Tab - 
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    Viewing and Printing - 
If you want to see the contract modification as you would if you printed it, 

click the View tab.  This is also one of the locations where you can print the 
contract modification in order to obtain signatures.  You can also print while at 
the contract modification list screen.  You’ll be given the option there to print 
either the list of cont mods or the report for each highlighted cont mod in the list.  

The number of pages for a contract modification is completely dependent 
on the amount of description typed and the number of items included in the cont 
mod. - it could be one page or many pages! 

There is a new field labeled “Entered By”.  The person’s name who is 
logged into the computer when the cont mod is first created and saved will 
automatically populate this field. 
 

Since this contract modification is still in draft status (has not been 
generated) the word “Draft” will be across the top portion of the first page 
whether it’s viewed or printed.  Once the contract modification has been 
generated (is in Pending Approval status) the word Draft will not print on the 
form.   Remember also that the date when the cont. mod. is generated, will 
become the Cont. Mod. Date on the General folder tab.  Up until then, that date 
was when the contract modification was created. 
 

Move between pages of the contract modification by using the Previous 
Page and Next Page buttons at the bottom of the screen.  The Zoom In and 
Zoom Out buttons are there for your viewing ease. 

 Current contract items that are being increased or decreased are listed 
first.  New items to the contract are listed following the current items.  Following 
the items is the Time Extension information.  Lastly are the signature labels. The 
labels should normally remain as they are.  If, for some reason, a label needs to 
be changed, it can be done on a contract by contract basis.  See Chapter (2) 
covering the Documentation button for details.  
 If the signature block has been changed, the next time you highlight a 
contract modification and click Change, you’ll be told that the signature block has 
been changed and will be asked if you want to update the contract modification.  
Answer Y or N, depending on the appropriate answer. 
 
 
Generating the Contract Modification - 

Before a contract modification can be generated, the Managing 
Office field must be completed.  This field is located on the General folder 
tab of the Docu button.  If you haven’t entered the Managing Office the 
following message will be displayed when you try to generate the contract 
modification. 
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 If you receive this warning, you must go to the Docu folder tab, enter the 

required information, and then Save/Close.  Since we have already entered this 
information, we’re “good to go”! 

 
When the contract modification has been checked by the appropriate 
person and is ready to be sent to the contractor for signature - 

Click the Generate button 
Generating can be done from any contract modification 
folder tab or from the contract modification list. 

Click Yes to the “Are you really sure..” question 
The print screen automatically opens when a contract modification 

is generated.   If you do not want to print it at this time, click 
Cancel.   

You can print the contract modification at any time.  
The increase/decrease report can be printed at any 
time by opening the inquiry, Item Increases and 
Decreases that are Pending. 

The contract modification will now show a status of Pending 
Approval in the cont mod list. 

 
Stay at the contract modification list 

 
 

 
Changing a Generated Contract Modification 

If the contract modification has been generated it CAN still be changed.  
Mighty helpful, don’t you think!!!  We’ll make a minor change to the contract 
modification we just created. 

You should still be at the contract modification list  
The cont mod should be highlighted.   
Click the Change button or double click the cont. mod. 
Put the cursor in the Description of Changes field and enter some XXXX’s 

just so you can see a change has taken place.  You can actually 
change or delete anything in this cont mod or add other items and 
information to it - we’re just adding the XXXX’s for ease!   

Press the Tab key or click in a different field so the information is 
“entered”.   

Immediately the Save and Save/Close buttons become available 
for use 

You will see a number in the Revision Number field. 
The Revision Number will increase each time the contract 
modification is changed and saved AFTER it has been 
generated.  

Click the Save button 
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Once you save the changes, the contract modification will be changed 

from a status of Generated to Draft.   
Since we want to send this changed contract modification to 
the contractor for signature, we must generate it again in 
order to print it without Draft on the first sheet. 

Click the Generate button  
Answer Yes to the “Are you sure” question about generating the cont mod. 
Once again, the print option is available.  You can print now or print later - 

just like before! 
Click the Cancel button for now 

 
Notice the status of the cont mod is once again Pending Approval.   
 
Also notice that there is a revision number in that field now.  If you 

changed the cont mod again, saved it, and closed out of the 
contract modification, the revision number would be increased by 
one more. 

 
 
 
Deleting a Contract Modification - 

A contract modification can be deleted if it has either Draft or Pending 
Approval status.  The process is the same for both but the result is different. 
 
Deleting a DRAFT contract modification - 

If this cont mod is the LAST one created it will simply be deleted from the 
list and that cont mod number will be used again for the next one created.   

If this cont mod was NOT the last one created, it will be shown with a 
Deleted status and that cont mod number will NOT be re-used.  
 
Deleting a Generated contract modification  

Once a contract modification has been generated a status of Deleted will 
be shown in the listing if that cont mod is deleted.  You cannot re-use this cont 
mod number.  In other words, once a contract modification has been generated, 
that number can never be used again if deleted. 
 

Even if the generated cont mod has been changed back to Draft and is the 
last one in the cont mod list, it will still be given a status of Deleted and that 
number will NOT be re-used since it had at one time been generated.   
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When you select the Delete button for this cont mod, you’ll get a warning stating 
that “The cont mod has been previously generated.  Are you sure you want to 
delete it?”    
 
We don’t want to delete this cont mod so if you’re at the question, answer No!! 
 
 
Approving a Contract Modification - 

Once a contract modification has been approved it CANNOT be changed 
or deleted.  Be sure you want to approve it BEFORE doing so.   

 
The approval date for substantial cont mods (both federal aid 

and non-federal aid) is the date of Central Construction 
Office signature. 

The approval date for non-substantial cont mods is the date of 
the DCE signature. 

 
A contract modification can only be approved from the Pending Approval 

status.  It cannot be approved if it’s in Draft status - in other words, you can’t skip 
the Pending Approval step and go directly from Draft to Approved. 
 

If you are not at the cont mod list, go there and highlight the cont mod we 
just created if it isn’t already 

Click the Approve button 
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Pertinent information is displayed concerning this contract modification so 
you can “double check” to be sure you’re approving the correct one. 

 
 
For our practice contract, we’ll use today’s date as the approval date. 
 
Click OK 

You will get the first of two approval warnings.   These are not 
to be taken lightly since a contract modification cannot be 
changed or deleted once it’s approved.  

 
 
 
 
 
 
 
 
 
 
 
Answer Yes to the first warning concerning receiving all the necessary 
approvals. 

 
 
 
 
 
 
 
 
 

Answer Yes to the second warning concerning not being able to make 
changes, etc. if the cont mod is approved. 

 
 Open Windows Explorer and expand the FieldMgr folder.  Highlight the 
Outbox folder and let’s check to see what’s in there!! 
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When a contract modification is approved a file is automatically created 
and put in the FieldMgr>Outbox folder.  The filename is 
CMAPRxxx.EXP with the x’s being a number dependent on the 
number of approved cont mod files already located in the Outbox. 

This approved file will be sent for processing along with the file that’s 
created when the estimate is generated.  More about that later!!! 

 Minimize Windows Explorer 
 
 
Another Contract Modification to Add a New Item-  
We’re going to create another contract modification to add a new item.  We 
added a lump sum item to multiple projects and categories in the previous 
exercise so this time we’ll add an item that does not have a unit of lump sum. 
 
If you are at the contract modification list for Contract 78-0061-114, great!  If 
you’re not, go there!!  You’re going to add any item of your choice – as long as 
it’s not a lump sum unit.  
  
Click the Add button (to add a new cont mod) 
At the General folder tab, type a short reason for adding your item 
Press the Tab key 
In the Description of Changes field, type a reason for adding the item 
Click the Spell Check button - and make adjustments accordingly!!! 
Click the New Items folder tab. 
Click the Add Item button 
Click OK 
 
Click the down arrow beside the Item field and select an item of your choice 
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Press the Tab key 
If you chose a “generic” item, enter a supplemental description  
Select Supplemental Agreement in the Item Type field 
Enter a Unit Price of your choice 
Enter a reason 
Select the Section where you want to add this new item 
Enter the new quantity in the Proposed Quantity field. 

 
Click OK 

If you added an item that already exists in the contract, you will get a  
similar  warning when you click OK.  This situation may happen  
when you need to add an existing item to the contract in order to get it into  
a category where it currently doesn’t exist.  It’s fine – just a “wake up call”  
in case you didn’t realize the item existed already and it should be  
increased instead. 

Click Save/Close 
 
 
Other Type of Contract Modification 
 

Sometimes a contract modification must be written that doesn’t affect 
either items or working days.  These might be mutual benefit type contract 
modifications which change the contract for the mutual benefit of both the IDOT 
and the contractor.  Another example might be documentation for approval of 
payment by external voucher to someone other than the prime contractor, such 
as a utility company.   

To create one of these types of contract modifications, complete only the 
General folder tab before sending it to the vendor for signature.  No items are 
involved in this type of contract modification. 
 
 This is the one time you might need to change a signature label.  If so, see 
how this can be done by reviewing Page 4 of Chapter 2 concerning the 
Documentation button. 
 

The recommendation by the Office of Construction for this type of 
cont mod is to create it in FieldManager and either send a copy of it to the 
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prime simply for their information since it is given a number in sequence 
with all the other cont mods, or alert them in another manner. 

 
 

Close back to the contracts list. 
 
 
 
Adding an item with a negative dollar amount - 
 Sometimes there is a need to add an item that will result in a negative 
dollar amount.  This can be done for any item except one with a lump sum unit.  
Lump sum items cannot have a negative quantity. 
 To add a negative item to a contract modification, the quantity must 
be a negative number and the dollar amount must be positive.  Other than 
the quantity being a negative amount, this type of item is added exactly the same 
as any other new item.   
 
Posting progress to the new negative item – 
 If the authorized quantity for an item is negative, the item postings for that 
item must also be negative.  In other words, if the Authorized Quantity is –1 
(minus one) and you want to post progress for the full amount, you’d enter –1 
(minus one) in the quantity field on the form.  If you wanted to post progress for 
only half the amount, you’d enter -.5 (minus point five or ½).   
EWO and Price Adjustment Items – 
 Some items cannot be found with the “regular” items when adding a new 
item by contract modification.  If, however, you sort the list by item description 
and type in EWO or Price Adj, or if you sort by item code and type in 6200 or 
6100, you might find what you’re looking for.  
 The graphic below shows a metric contract’s new item list sorted by item 
code and the first 2 numbers of the item code entered in the Find Item Code field. 
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The following graphic has the same master item list but sorted this time by item 
description and displaying some of the price adjustment items. 
 

December, 2013 Chapter 5 Page 25 
 



Stockpiles - 
 
Before you create a stockpile you need to know the following - 

1.  The description of the stockpile   
2.  The dollar amount of the invoice  
3.  Whether you’re to pay 100% or 90% of that invoice price (depending on 

whether it’s being stockpiled on site or off site.) 
4. The item(s) you want to link to the stockpile and, if more than one item is 

involved, how much of the stockpile you want to link to each item 
5.  The amount (quantity) of the linked item that the stockpile is to cover (if the 

stockpile is to be used for the entire authorized quantity, for only half of 
the authorized quantity, etc.)  e.g. how much of the linked item should be 
placed when the stockpile is used up. 

 
A stockpile wizard has been created to help set up stockpiles.  You may move both 
forward and backward through these screens.  Also, a stockpile may be deleted UP 
UNTIL it has been included in an estimate.  The program also allows you to change or 
delete a stockpile transaction if it has not been paid and it’s the most recent 
transaction.  Mighty fine features, right!!!! 
 

The theory of the stockpile payment is to pay the contractor (if he requests it) for 
material purchased for use on the.  As the contractor uses that material and is paid for 
the corresponding item(s), the stockpile dollars originally paid to the contractor are 
automatically reduced.  This automatic reduction should take place at a fair rate for 
both the IDOT and the contractor.    
 

If the line item the stockpile is linked to has been completed and there is still a 
balance in the stockpile, a manual adjusting entry can be made so the balance will 
become zero.  A semi-final type estimate has an option that allows the program to 
check all stockpiles to see if there’s a balance in any of them.  When the contract is 
finished, the balance in all stockpiles must be zero. 
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Highlight Contract 78-0061-114 in the contracts list if it isn’t already. 
Click the Stockpiles button 

A list of all stockpiles created to date for this contract is shown 
Click the Add button 
 
Let’s start through the screens you’ll see as you create a stockpile and discuss the 
fields before we actually begin. 
 
Screen 1 – SAMPLE  

This screen explains the process of creating a stockpile.  Nothing to do here 
except read the fine print!!  Click the Next button. 
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Screen 2 - SAMPLE 

Stockpile Description - You must select a description from this list.  If you know 
specifically what you want to select from the list, while the field is blue 
type in the first letter of the name, press the letter again to find the next 
description beginning with that letter and continue doing the same until 
you find your choice.  If you can’t find a type exactly what you want, get 
as close as possible.  Only 1 stockpile description record can be used for 
each contract.  This description can be changed up until the stockpile is 
included in an estimate. 

 
 Stockpile Comments - The comments you type here will be displayed with the 

stockpile when inquiries are done.  These comments will also show in the 
Comments column in the stockpile list.  This is not a required field - but a 
highly recommended one! 

 
Since we’re just viewing and not making entries, this is as far as we can go without 
getting error messages for not completing required fields.  The rest of this information 
will be available as a resource and will mean more once we start making entries. 
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Screen 3 - SAMPLE 

Transaction Date - This is by default today’s date - and is usually left that way 
Transaction Dollar Amount - The dollar amount you’ll be paying to the contractor 

on the next estimate.  You do not need to type the $ sign.  If the invoice is 
for $1,000 but you’re only paying 90%, you must enter $900 in this field.   

This dollar amount must be less than the remaining dollar amount 
to be placed of the item it’s linked to.  In other words, you cannot 
assign a larger amount of stockpile than what is left to place for 
that item.  

Transaction Comments - This is a required field so you MUST make comments 
here.  It is a real good place to indicate whether you’re paying 90% or 
100% of the invoice price.  Also a good place to indicate if it is a 
Shipment 1, Shipment 2, etc. 
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Screen 4 - SAMPLE 

Click the Add Item button 
Select the item(s) to link to this stockpile from the items list 
 
Assigned Dollar Amount - The dollar amount of the stockpile for which this line 

item will be responsible.  The entire amount of the stockpile must be 
distributed before you can leave this screen. 

The Catg Auth Amt of the item must be equal to or greater than 
the stockpile assigned dollar amount but you also must be aware 
and take into consideration any quantity already placed and or 
paid for this item. 
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Screen 5 – SAMPLE 
 

Recovery Factor - For each unit of item paid, the dollar amount of the stockpile 
that will be reduced.   

Recovery Quantity - The number of units of the linked line item you’ll be using to 
recover the stockpile payment.  This number must be between the 
Fastest and Slowest values shown. 

The slowest value is equal to the funded quantity of this line item.  
The fastest value is equal to the assigned dollar amount of the 
stockpile divided by the unit price of the item to which it’s linked.  If 
you enter the fastest value in the recovery quantity, the recovery 
factor will be the unit price. 
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The fastest recovery = the stockpile dollars divided by the item’s unit price 
 
The slowest recovery = the authorized quantity for the item less any quantity that has 
already been placed 
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 If you want to create a stockpile transaction but don’t want to have it reduced 
until a later time, put $0 in the Recovery Factor field.  When you do want it to start 
reducing the stockpile, change the recovery factor to the appropriate amount. 
 
 If you do choose to leave the recovery factor as zero, the following warning will 
be displayed.  Since it is just a warning, you can continue.  See the sample warning 
below. 
 
 

   
 
 
 If you leave the recovery factor as zero when you create the stockpile, don’t 
forget to change it at a later time so the stockpile balance is reduced as the 
linked item is paid. 
 
Also, be sure that the recovery takes into account any quantity that will be paid 
until the zero recovery factor is changed from zero. 
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Let’s create a stockpile -  
You should be at the stockpile list for Contract 78-0061-114.  If not, go there!! 
Click the Add button 

This brings up the first of the Stockpile Wizard screens.  Read it. 
Click the Next button 

 
 
Click the down arrow beside the Stockpile Description field to get a drop down list.  You 

must select a stockpile description from this list.  If you can’t find exactly what 
you want, select a description as close as possible.  As a last resort, there’s 
always the Misc. description at the bottom of the list! 

But, REMEMBER, you can use a stockpile description only once per 
contract.   

Scroll down and select 602A, Reinforcing Steel  
This is a blue and blank field with a drop down arrow beside it so you can type 
the letter R and the first item beginning with R will appear.  Continue pressing 
the letter until you have the selection of your choice. 
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Press the Tab key  
Type Reinforcing Steel in the Stockpile Comments field.  What you type here will be 

shown in the comments area of the stockpile list screen. 
Press the Next button 
 

 
 
The Transaction Date will be completed for you based on what date the computer 

thinks is today!  If that date is wrong or for some other reason you need a 
different date, you may change it to any previous date.  Press the Tab button. 

Transaction Dollar Amount = This is the amount you’ll be paying the contractor based 
on the invoice.  Whether it’s 100% or 90%, you should enter the amount you 
want to pay the contractor on the next estimate in this field. 

Enter 26200 for our dollar amount.  You do not need to enter the $ sign, 
commas, or zeroes to the right of the decimal.  They will all be entered for 
you as soon as you press the Tab button. 

Transaction Comments = This is for any comments that will help you concerning this 
transaction.   We’ll type “Pay 100% of invoice.”  (This indicates that the stockpile 
is on site and the invoice total price is $26,200)  
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Click the Next button. 
 
 
 
Now comes the screen where you link the stockpile to a line item(s) 
Click the Add Item button. 
A list of all items in this contract will be shown.  Notice that All for the project and All for 

the category are the default choices.  Based on what we learned already, we 
know that 1 project and more than 1 category exists in this contract  since All is 
shown in the Category field. 

  

 
 
Highlight Lines 0040 and 0290, Reinforcing Steel and click the Select button 

This line item is in only 1 project and category so only one line is brought into 
the next screen.  The top portion of this screen shows detailed 
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information about the highlighted line in the middle portion of the screen.  
Stockpile information is entered in the lower portion of the screen and 
reflected in the middle portion. 

Type 20000 in the Assigned Dollar Amount field in the lower portion for Line 0040 (Cat 
1).   
Press the Tab key and the number you just entered will be reflected in the like column 

in the middle area.  Also notice the Dollar Amount Left to Distribute is now 0.   
You cannot go forward from this screen until all stockpile dollars have 
been distributed.  If too many dollars have been distributed you will 
receive an error message as well and cannot go forward. 

Highlight the 0290 line and assign the balance of 6200 to this item then press the tab 
key 
 
Click the Next button. 
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You can enter either the Recovery Factor or the Recovery Quantity and the other will 
be automatically calculated and entered for you .   

As stated on the screen, the Recovery Factor is the dollar amount that the 
stockpile payment will be recovered per unit of item paid.  The Recovery 
Quantity is the number of units of the item that you want to use to recover the 
stockpile dollars.  Notice there is a range given for entering the Recovery 
Quantity from slowest to fastest.  The slowest is equal to the authorized quantity 
of this line item.  The fastest value is equal to the assigned dollar amount of the 
stockpile divided by the unit price of the item to which it’s linked. 

 
 

  We’re going to make this one easy.  Our stockpile amount will take care of half of each of the 
reinforcing steel line items.  We haven’t placed or paid any of those items yet so half 
the 0040 line item’s 46,594 authorized quantity which we could use for the slow 
recovery rate is about 23,200.  Since we want to give ourselves a bit of “fudge” in case 
we don’t place the entire line item’s quantity, we’re going to enter a bit smaller numbers 
instead.  Remember, the quantity you select must be between the slowest and the 
fastest rates of recovery displayed below the quantity field. 

 
Tab once so the cursor is in the Recovery Quantity field for Line 0040 
 
Since this stockpile should be used up by the time half of the item is placed, we could 
use approximately 23,300 for the recovery quantity EXCEPT that is not between the 
fastest and slowest parameters given.  So… enter 24000 for the Recovery Quantity 
and that will be close enough. 
 
Press the Tab key 

Notice the Recovery Factor is filled in automatically based on the Recovery 
Quantity you just entered. 

Highlight the other line (0290) and enter 7100 for the Recovery Quantity  
Click the Finish button and you’ll be returned to the stockpiles list. 
 
 
 
Another Stockpile - BUT some quantity has been placed and/or paid already 
Let’s create another stockpile but this time some of the authorized quantity has already 
been placed.   
 
When creating a stockpile, you must use for calculation only the portion of the 
authorized quantity that has NOT been placed.  In other words, if you have an item with 
a unit price of $1 and an authorized quantity of 10,000 but 3,000 of that amount has 
already been placed, when you create a stockpile, you cannot link $10,000 of the 
stockpile to that item since only $7,000 is left in it. 
 
You should be at the stockpiles list for Contract 78-0061-114 

December, 2013 Chapter 6 Page 13 
 



Click the Add button 
Stockpile Description = Miscellaneous Stockpiled Materials 

Notice that 602A which was used for the above stockpile is no longer in 
the list.  That is because each description can be used only once per 
contract. 

Stockpile Comments = Pile, Steel, HP 10x57 
Transaction Date = Today 
Transaction Dollar Amount = 32000  
Transaction Comment = Pay 100% of invoice 
Link to Line 0090, Pile, Steel HP 10 x 57  
 
Assigned Dollar Amount = 32000 
 
 
 

 
 
Click Next to assign a recovery quantity to each item. 
  

Reminder - 
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  The fastest recovery = the stockpile dollars divided by the item’s unit price 
 

The slowest recovery = the authorized quantity for the item less any quantity 
that has already been placed 

    
Click the Finish button and return to the stockpile list. 
  
 
 
 
 
 
Second Shipment for a Stockpile 
Sometimes the stockpile arrives in more than 1 shipment.  Earlier it was stated that you 
can have only 1 stockpile description per contract.  If we receive more of the same 
thing, we need to increase the original stockpile - and recalculate the recovery rate. 
 

Highlight the Misc stockpile   
Click the Change button 
 Since we haven’t paid the last transaction for this stockpile, we have an 

option to modify it.  If there was a mistake such as wrong invoice dollar amount or 
perhaps you entered an incorrect recovery quantity and need to change it, you could 
simple choose the “Modify the last unpaid transaction” option and click Next until you 
get to the screen you wish to change. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
Since we want to add an additional shipment and have a tracking record of  

adding that shipment, we’ll leave the choice as Add a new transaction  
and click OK. 

Click the Next button at the first screen 
Click the Next button at the second screen since we don’t want to change this 

information 
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Notice the Dollar Amount Remaining for this stockpile is shown above the 
Transaction Date on the third screen  

Leave today’s date for the Transaction Date  
Transaction Dollar Amount = 31000 which is the amount of the second invoice 

received for this stockpile.  This will take care of the rest of the line item. 
As soon as you press the Tab key the new amount will be added 
to the previous amount giving the new grand total for this stockpile. 

Transaction Comments - 2nd shipment, pay 100% of invoice 
Click the Next button 

 
Since we want to link this shipment to the same item as the first shipment, we 

only need to let the program know how much the stockpile will be 
increasing.  Type 31000 in the Change in Dollar Amount (+/-) field and 
press the Tab key. 

If you had wanted to link this second shipment to a different line 
item, click the Add Item button to bring up the list and make your 
selection there. 

Press the Next button 
 

The Recovery Rate and Recovery Quantity will be re-calculated automatically 
for the new dollar amount based on the original entries for Shipment 1.  
If, for some reason, the program calculates and enters a quantity 
larger than the slowest figure, you must reduce it.  The Recovery 
Quantity must be between the fastest and slowest rates displayed. 

 
The program automatically calculated a new recovery factor based on the two 
shipments but it can be changed if you wish. 
 
We’ll leave the recovery quantity as it is displayed = 1378.125 since that number 
is within the slowest and fastest parameters and still gives us some “fudge” in 
case the entire authorized quantity is not placed. 
 
Click the Finish button and you’ll be returned to the stockpile list  

 
If you want to look at the stockpile information you have entered – 
Highlight the stockpile you wish to view, click the Quick Query Flyout Toolbar 
Button (aka little down arrow) and select the SP Summary button.  The stockpile 
that was highlighted in the stockpile list will be detailed.  If you want to see both 
stockpiles, highlight each while holding down the Shift key before selecting the 
Stockpile Summary button. 

    OR 
 Click the Inquiries button , select Stockpile Summary by Stockpile, highlight the 

 stockpile(s) you wish to view, click the Select button. 
 
Close back to the contracts list. 
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If you need to link a stockpile to 2 different items, feel free to call for help. 
 
 
Deleting a Stockpile - 

If you have created a stockpile but you discover it isn’t correct, you CAN delete it 
under certain conditions!!!   Pretty awesome, huh!!!   IF the stockpile has already been 
included in an estimate (payment made) you CANNOT delete it.  Even if you can’t 
delete a stockpile, you can still make changes to it! 
 
 
Although we don’t really want to delete our stockpiles, following are the steps to do so 
if you did choose to do so another time.
To delete a stockpile - 

Highlight the stockpile to delete in the stockpile list 
Click the Delete button 
Answer Yes to the “Are you really sure” question (don’t really do this now!!) 
AND IT’S GONE!!!! 

 
 
Changing a Stockpile - 
Sometimes it’s necessary to change some information about the stockpile. If you want 
to change the last unpaid transaction for a stockpile, click the Change button then 
select Modify the Last Unpaid Transaction and click OK. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
You can move forward and backward through the screens, changing only the 
information you desire.  This can be a tremendous help but only if you discover an 
error in the LAST UNPAID transaction for the stockpile. 
 
If the contractor has already been paid for a stockpile, you can click on the Change 
button.   That’s what we’ll do now!! 
 
Highlight Contract 78-0061-114 in the contracts list if it isn’t already 
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Click the Stockpiles button 
Highlight the Reinforcing Steel stockpile  

We have just discovered that although we first thought this stockpile was to take 
care of a only a portion of this line item, it will really be enough for all of it.  
Because of this discovery we know our recovery factor is wrong!!  The first thing 
you’ll do (well, OK, the first thing after you quit muttering those nasty words) is 
change the recovery quantity.  We’ll do that now - not that you thought you’d get 
out of doing it or anything!! 

Click the Change button. 
Add a New Transaction 
 
Click the Next button at the first screen. 
Click the Next button at the second screen - we don’t want to change the description or 

make a comment.  OK, so you have plenty of comments - they’re just not ones 
you should type!! 

 
Transaction Date - leave it as today’s date 
Transaction Dollar Amount - Leave this as zeroes since we don’t want to change the 

amount of the transaction  
Transaction Comments – Type “Correcting recovery quantity” 

Any time you create or change a stockpile, you must give a reason in this field. 
Click the Next button 
 
Click the Next button again - We don’t want to change the transaction dollar amount  
Tab so the cursor moves to the Recovery Quantity field 
 
****************** 
Recovery Quantity - Type 45,500 and press the Tab key 

Remember:  The recovery quantity must fall between the fastest recovery 
quantity shown and the slowest quantity shown

Press the Tab key - Notice the Recovery Factor has now been updated based on the 
new entry in the Recovery Quantity field. 

Press the Finish button 
From this point on the stockpile will be recovered based on the new recovery 
figures. 

***************** 
 
Close back to the contracts list 
 
 
 
If you have multiple stockpiles for a given contract, you could possibly link the same 
item to different stockpiles and not realize you did so.  Doing so is fine if the item is 
large enough (worth enough dollars) to recover multiple stockpiles.   The program will 
alert you immediately via a warning similar to the following graphic when linking an 
item on a stockpile if that item has already been used on one or more other stockpiles 
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for the same contract.  It’s your choice whether you switch items or not if this warning 
occurs. 
 
 
 
 
 
 
 
 
 
 
  

 
 
 

Balancing a Stockpile 
Sometimes when the contract is finished there is still a balance left in the stockpile that 
must be zeroed out. 
 

If you select a Semi-Final type estimate when closing out a pay period, you will 
have the option to use the Balance Stockpiles button.  If you X this box, the program 
will automatically and immediately zero out the balance left in the stockpile and include 
that transaction dollar amount in the estimate.    

You will not be forced to use this feature - but it’s a mighty handy one if 
conditions warrant its use – and you would be very wise to use it. 

We’ll go through this in more detail when we create an estimate - for now just be 
aware this feature exists. 
 
 
 
More IDR Item Postings - 

We’re going to make some item posting entries in an IDR so you can see how 
and when they appear in the stockpile summary inquiry.  Once the IDR has been 
included in an estimate, the transaction will be included in the stockpile summary 
report.  
 

Highlight 78-0061-114 in the contracts list if it isn’t already 
Click the IDRs button 
Click Add 
Leave the date as today - it’s OK even if you’ve previously created one for today 
Your name should be in the Inspector field 
Make an entry of your choice in the weather, temperature, and/or comment 

field(s).  Remember, if there are no item postings there must be a 
comment; otherwise, you can have an entry in any of the fields. 

Click the Postings folder tab 
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Make the following entries using whatever stationing you wish 
 

Item 0040 = 23,000 quantity (roughly ½ of the authorized quantity) 
Item 0290 = 7,100 quantity (roughly ½ of the authorized quantity) 
Item 0090 = 1,600 quantity (an overrun of the authorized quantity) 

 
           Click OK 
           Click Yes to the overrun question 

Generate the IDR and Cancel at the print screen 
Return to the Stockpile list screen 
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Stockpile Summary 
The stockpile summary can be accessed two different ways but either way  

will show the initial payment made to the contractor as well as other transactions 
that affect that stockpile.  Item postings will NOT be displayed in this 
summary until they have been included in an estimate.  You may select to 
view details about only a specific stockpile or all stockpiles in the contract.  We’ll 
look at these, remembering the postings we just did will not be reflected in the 
summary at this time.  Later, we’ll come back to this inquiry and view it again. 
 
Using the Quick Query fly-out toolbar button – This method can be accessed only  

from the stockpiles list window. 
 

 
 
At the stockpiles list - 
  1.  Highlight the stockpile(s) you wish to view  
  2.  Click the Quick Query fly-out toolbar button (little down arrow) in the 

Window button bar 
  3.  Click the SP Summary button 

This shows transactions for ONLY the stockpile(s) highlighted   
4.  Close back to the contracts list, leaving Contract 78-0061-114 

highlighted 
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Using the Inquiries button - can be accessed at any time from any window 

 

 
 
At any window - 
  1.  Highlight the appropriate contract in the contracts list  
  2.  Click the Inquiries button 
  3.  Either highlight Stockpile Summary by Stockpile and click the View 

button or double click the Stockpile Summary by Stockpile choice. 
If you type the letter S in the Find field, it will bring up the first 
inquiry beginning with the letter S, which in this case gets 
you pretty close to the one you want!. 
 

  4.  Highlight the stockpile(s) you wish to view  
If you want to view more than one but not all, hold down the Control 

key  
as you highlight the stockpiles then click the Select button. 
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If you want to view all the stockpiles listed, click the Select All  
button. 

 
 
If you made your selection for a specific stockpile but now want to see a different 
one, click the Change Select button and you’ll return to the Stockpile list where 
you can select a different stockpile to view. 
 
You may print the stockpile summary by clicking the Print button when you’re 
viewing the stockpile summary inquiry. 
 
Close back to the contract list. 
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Contractor’s Performance Evaluation (CPE) 
 
 Evaluating EVERY contractor listed in FieldManager no matter the dollar 
amount of their work is now a required action.  These evaluations must be 
approved BEFORE a final estimate can be created.   
 Evaluations, like contract modifications, have status levels –  
 
Draft – The CPE has been added but can be changed and has not been 
generated.  The word DRAFT is across the top of the form and also across the 
signature line at the bottom of the form when viewed and printed. 
 
Pending Approval – The CPE has been generated but has not yet been 
approved.  It can be changed, saved and re-generated or deleted.  If deleted, it 
will be displayed with a Deleted status and no further changes can be made to it. 
 
Approved – No changes should be made.  Cannot be deleted.  If absolutely 
necessary, an approved CPE can be changed by a system administrator but this 
should NOT be done if the electronic file has already been sent to the Office of 
Contracts.  If necessary to change, check with Janet or Jen in the Creston Const 
Office (641-782-4518). 
 
If you delete a saved or generated evaluation, call Janet or Jen in the 
Creston Const Office (641-782-4518).  If the resulting file from the deleted 
evaluation is kept, it will cause major problems with the file we send to the 
Office of Contracts. 
 
Highlight Contract 78-0061-114 in the contracts list 
Click the Misc Rpts button 
Highlight Contractor’s Performance Evaluation and click the View button  
  Or 
Double click on Contractor’s Performance Evaluation 
 
A list of all previously created evaluations is displayed – none for us! 
Click the Add button 
 
Select Rupert Constr Co from the drop down list by the Contractor field 
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Always select Final for the Report Type – we will never use Interim for the 
Report Type 
Click OK 
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Click the Evaluation Instructions button at the bottom of the screen.  As seen in 
the following graphic, this explains that an evaluation for every contractor must 
be created and approved before a final estimate can be created.  The 
instructions, which are the same for every contract, can be printed if desired. 
 

 
 
Click Close to return to the General tab of the CPE 
By default the Evaluator field is populated with the name of the person logged 
 into FieldManager.  This name can be changed. 
The Report Starting Date is the Notice to Proceed Date (as can be seen in the 
 lower left of the Docu > General tab).  This starting date can be changed 
The Report Ending Date defaults to today’s date – this can be changed 
Comments – any appropriate comments can be made in this field – this is not a 
 required field.  These comments made on the General tab will be  

included with the ratings that go the Office of Contracts and become  
part of their database. 

 
Click the Ratings tab 
 There are 11 categories listed with Rating and Rating Remarks fields 
displayed to the right of the criteria under each category.  All ratings are based 
on a scale of 0-100.  A rating must be entered for each category whether it 
applies to the contract or not.  If the category is not applicable, a rating of 80 is to 
be entered for that category. 
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Guidelines for the ratings are given within the criteria for each category.  If the 
rating is 50 or less or is 100, rating remarks are required; otherwise, they are 
optional.  Remarks made for the individual ratings do NOT go to the Office 
of Contracts to become included in their database – only the comments 
made in the General tab > Comments field. 
 
Enter ratings for each of the 11 categories and remarks as needed.  Once all the 
ratings have been entered, click the Generate button.  This not only generates 
the CPE but also saves it.  As always, when you generate, you’re given the 
option to print the report.  For our purposes today, click Cancel at the print option. 
 
If ratings are entered by 1 individual but they need to be checked by a different 
person, the report can be saved and then generated and approved at a later 
date.   
 
If the ratings are incomplete and you attempt to save or generate the report, you 
will get the following error message.   
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The CPE cannot be saved or generated until all categories have a rating and, if 
required, a rating remark.   
 
Click the View tab to see the report as it would look if you printed it.  Notice that 
the word DRAFT is no longer on the report – this is because the report has been 
generated.  It’s status is now Pending Approval.   
 
Once the CPE has been generated (has a Pending Approval status), it can be 
approved.  (You cannot skip the generate step and jump from Draft status to 
Approved.)  Type the name of the person approving the ratings in the Final 
Approved By field.  This is a required field.  Click OK. 
 
The original approved CPE is to be sent to the contractor being evaluated and a 
copy is to be kept in the project files in the RCE Office.  It is totally up to your 
office and your district office as to whether a copy of each CPE is sent to the 
district office.  The Office of Construction does NOT need a copy of the CPE. 
 

 
 
. 
When you click the OK button to approve a CPE, you’ll be asked if all required 
approvals have been obtained – as can be seen in the following graphic.  Don’t 
approve the CPE unless you’re sure that you should! 
 

    
 
Once approved, a file is automatically created and put in the FieldMgr/Outbox.  
The file name is CPExxx.EXP with the xxx being the number of those files in the 
Outbox.  In other words, if this is the first file of that name in the Outbox, it will be 
CPE001.EXP. 
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When the evaluations have been completed and you’re ready to combine them 
into 1 file to send to the Office of Contracts – 
 Click Utilities > Combine Outbox 
 

    
 
Notice that, except for the heading, the above graphic looks very similar to the 
Combine Outbox step for estimates because we want the combined CPE file to 
be located in the C:\FieldMgr\Outbox location just as it is for estimates.   
 
Once the combine step has been completed, a new file is created and named 
similar to when estimates are combined except that the CPE combined file has a 
.CPE extension rather than .UPD. 
 
1.  Re-name the newly combined .CPE file to CPEINPUT.CPE 
2.  Either drag or Cut and Paste (NOT Copy) the newly named CPEINPUT.CPE 
 file to the C:\CPEINPUT folder and, if asked, overwrite what is there 
 already. 
3.  Double click on the CPEINPUT.XLS file that is also located in the CPEINPUT 
 folder 
4.  Enable Macros, if asked 
5.  Click on the “Click to Create ExcelEvals.xls” button 
 The macro will run (lots of jumping around!!!) and will display a message 
 that the ExcelEvals.xls has been created when the macro is finished.  (If 
 you want to look at the new file, it will contain 1 row for each evaluation 
 you approved.) 
6.  Close Excel 
7.  Attach the ExcelEvals.xls file to an e-mail and send to the Office of Contracts 
 with a subject line of CPE or Contractor Evaluation 
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8.  If there was a .UPD file created in Step 1, process it now just as you 
 normally would using the FM Xfer program. 
 
 
 
Contractor Read-Only copies of contracts do NOT include any contractor 
evaluation information. 
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Estimates vs Vouchers - and the closing out process 
 
A hard to understand concept –  
 A check is sent to the contractor for every PROJECT in a contract.  So, for 
example, if a contract has 5 tied projects and there was activity on each project, 
the contractor will receive 5 separate checks.  They are not combined into 1 
check.  Another way of saying this – every project stands on its own! 

 
Terminology is important!!!  An ESTIMATE is the amount of payment for 

the total CONTRACT.  A VOUCHER is the amount of payment for each 
PROJECT within the contract.  Individual checks are written to the contractor for 
each project – so, if the estimate total is made up of 4 vouchers, 4 checks are 
written to the contractor.  The total dollar amount of the vouchers equals the 
estimate dollar amount. 

    
THE RULE –  A contract can have ONLY ONE estimate processed PER 
WEEK  with the week beginning Friday morning.  If, for example, you process 
an estimate for a contract on Tuesday, you cannot process another for that same 
contract until Friday morning. 
 

A voucher for each project is not necessarily created just because an 
estimate has been produced.  If there is money to pay, a voucher will be created 
automatically.  If there is no money to pay, a voucher will not be created 
automatically but you can override that decision and create a zero voucher.   
Unless there is mobilization to pay we will NOT override that decision.   

When a semi-final estimate is generated for a contract with multiple 
projects, there will be a voucher line created in the upload file and processed for 
every project in that contract whether there was any activity or not.  In other 
words, when a semi-final estimate is selected, if Project A pays money but 
nothing is to be paid in Project B, because it’s a SF estimate there will be a 
VOUCHER, UPDATE line for both projects in the upload file resulting in BOTH 
being processed in CPS with one being a zero voucher.  There is nothing you 
should do to prevent this – it’s just an explanation in case Accounting calls 
wondering about the zero voucher. 

 
ANOTHER RULE  - If even one voucher in the estimate is for a negative 
dollar amount, you MUST NOT generate and process the estimate as it is 
UNLESS it is a semi-final estimate AND the following estimate will be a 
final.    Once you create and process a negative semi-final voucher, the next 
estimate for that contract must be a final.   No more item payments, stockpile 
transactions, or days charges are allowed once a negative semi-final voucher 
has been processed.    
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Even if the overall total for an estimate is positive, if even just one 

project has a negative voucher, that estimate must not be processed as it 
is unless it is a semi-final and will be followed by a final. 

 
If you get the above warning that there is at least 1 negative voucher on the 
estimate, do NOT process the estimate unless it is the semi-final, all audits 
have been completed, and you are positive that the following estimate will 
be the final.    If you aren’t sure what to do, call Janet or Jen in the Creston 
Const Office (641-782-4518) before continuing. 
 

In the above scenario, if payments must be made for one project and 
another has a negative balance, the voucher with the negative balance will need 
to be “put on hold”.  To do so –  

At the Estimate screen, click the Vouchers folder tab  
Click in the Create Voucher box to remove the checkmark for the  

negative voucher 
 By doing the above, all payment items pertaining to the project with the 
negative voucher will be withheld from this estimate.  The next time an estimate 
is created, the items will, once again, be included.  If you need to withhold them 
again, follow the same steps as explained above.   Finally when it’s time that the 
estimate will be a semi-final and will be followed by the final, leave the 
checkmark in the Create Voucher box. 
 
You should do everything possible to prevent having a negative voucher.  
Holding payment for an item is 1 possibility to accomplishing this.  Retainage is 
NOT intended to be used for offsetting negative vouches. 
 
Because of this negative voucher rule, it is highly suggested to wait until 
ALL audits are completed before processing an estimate with a negative 
voucher.  The negative estimate will stay in CPS until the final is processed and 
the retainage is released.  At that time the 2 estimates (negative semi-final and 
final) will be combined by Accounting and the remaining dollars (retainage less 
the negative voucher amount) will be paid to the contractor.  

 
 When you create a routine estimate, if you have not already entered the 

Time Charges Start date in the Docu > Site Times folder tab, you will get a 
message stating such.  

 
 
 
 
 
 
 
 

December, 2013 Chapter 7 Page 2 
 



If you get the above message, answer No and return to the Docu > Site 
Times tab and enter the date before you continue.  If, however, you have not 
started charging working days in that site, simply click the Yes button and 
continue creating the estimate.  When you do begin charging working days, be 
sure to enter that date in the Docu > Site Times tab > Time Charges Start Date 
field for that site. 
 

When generating a first estimate for paying only mobilization, no items will 
be involved and probably no days will be charged which means you’ll get the 
above warning stating these facts.   Click the OK button and the program will 
continue.  Since there are no item or stockpile payments, you must put a 
checkmark in the Create Voucher field on the Vouchers folder tab for each 
PROJECT (not contract) if 1% of the project value is equal to or greater 
than $1,000 AND 10% of the mobilization line item is equal to or greater 
than $1,000. 
 
****** 
Paying the Balance of the Mobilization Item at the End of the Project – 
 If the project is finished but the mobilization hasn’t been paid in full, it’s 
because the mobilization item value is more than 10% of the PROJECT value 
that its in.  Note that this is based on the PROJECT value, not the contract value. 
 Once the 435 date has been entered in CPS (this is done once a week) by 
the Accounting personnel, the balance of the mobilization item will be paid to the 
contractor the next time an estimate is processed.   
 Each Monday morning Janet and Tom Jacobson each receive an e-mail 
listing which projects now have a 435 date entered in CPS and the mobilization 
item is not paid in full.   That information is e-mailed to each residency involved. 
 Once the residency is notified, they should create a SM or SF estimate. If 
there are no other items to pay or stockpile transactions, you must put a 
checkmark in the Create Vchr box on the Vouchers tab – but only in the project 
noted in the e-mail.  If there are other items to pay and/or stockpile 
transactions,to include in the estimate, the checkmark will be entered 
automatically. 
 If the mobilization isn’t paid in full before the final estimate is processed, 
the contractor will be paid the retainage they are due and then in a separate 
check, they will be paid for the balance of the mobilization item. 
 
****** 
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As a part of the close out process, FieldManager will check item usage for 
all items that have not yet been paid but have been included in generated IDR’s.  
The program correctly calculates the quantity to pay if an overrun of an item is 
involved and also calculates the amount a stockpile should be reduced based on 
item usage.  It also adds new stockpile payments if needed.   
 

Also as part of the close out process, FieldManager calculates the number 
of working days to charge based on the Daily Diary entries that have been 
generated up to and including the date of the estimate but have not been 
included in an estimate already.   Although FieldManager allows working days to 
be charged in half day increments, it passes only whole days in the upload file for 
estimate processing at the mainframe.  The half day is held within FieldManager 
until another half is charged and then a whole day is sent.  

If working days charged overruns the number allowed in any site, you’ll 
receive a warning such as the example below when you create an estimate. 

  

 
If you receive the above warning, you will be required to enter an explanation in 
the Estimate Comments field before you can generate the estimate but it will not 
prevent you from continuing.  Any type of explanation is OK – it’s just an alert for 
you to realize that you have, in fact, overrun the number of working days allowed 
in a given site. 
 
 
Helpful Inquiries Before/During Estimate Creation - 

1.  Before an estimate is created, it is a very wise idea to check the 
inquiry, Item Postings by Item that are Marked for Attention for that contract.  
This will alert you to any item the inspector(s) want you to pay special attention to 
before including in an estimate. 

Choose Select All when the items list is displayed in this inquiry so the  
program searches through all items and displays only those having 
been marked for attention by the inspector. 

 
2.  If an estimate is created and an item(s) has a quantity withheld from 

payment due to an overrun, those items can be found by using a couple inquiries 
- 

A.   Items over authorized quantity at the contract level 
B.   Items over authorized quantity at the project/category level 
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3. Before creating the FINAL estimate – 
a. Check the inquiry, Items with Unpaid Placed Quantities.  If there 

are items shown, you need to determine what needs to be done 
with them before the estimate is created. 

b. Check the Stockpiles list to be sure all stockpile balances are  
zero 

 
Once you create an estimate, you must generate it in order to save it.   If 

you create an estimate to see what it’s going to pay and then decide you want to 
make some changes, exit that process and do NOT generate it.  You CANNOT 
save an estimate and generate it at a later time.   
 
 

Once an estimate is generated, FieldManager automatically creates a file 
and puts it in your FieldManager\Outbox folder.  The filename is VCHRxxx.EXP 
with the xxx’s being the number of VCHRxxx.EXP files already in your Outbox 
folder.  Along with the file that is created when an estimate is generated, 2 
reports are also created.  We’ll look at those in more detail later. 
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Adding an Estimate - 
Let’s create an estimate and then look at the fields in more detail. 

Highlight Contract 78-0061-114 in the contracts list 
Click the Estimates button - this shows a list of all estimates created to  

  date 
Click the Add button 
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You cannot create a new estimate if the previous one has a status of 
Exported.  If that is the case and you do need to create an estimate, you’ll delete 
the Exported estimate and re-create it which will include additional payments 
assuming the date of the estimate is later.  To accomplish this – 

Click OK at the message 
Highlight Estimate 2  
Click the Delete button 
Answer YES to the “Are you sure…” question 
Then click the Add button and create another estimate 
 

 
 

Select the Estimate Date  (We’ll leave it as today’s date.)   
Being able to select the date is extremely beneficial when you create an  
estimate that can’t be generated until a later time (perhaps someone 

else needs to look at and approve it).  The date of the estimate determines 
which generated IDR’s and diaries are included in that estimate. 

 
        Estimate Type – Semi-Monthly, which is the default, is OK 
        Click OK 
 

  
If you receive a warning when creating the estimate that 1 or more IDRs have not 
been generated, you have 2 options.   

1 = continue and leave out the ungenerated IDRs  
or  

2 = cancel the estimate process, go to the IDR list and generate the un-
generated IDRs 
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We receive the warning that a Time Charge Start Date has not been entered for 
Site 00.  We didn’t enter a starting time for that site since it has 0 authorized  
days.  Click OK and the estimate process will continue. 
 
Types of estimates and when they should be used are as follows – 
Final = There can be ONLY ONE Final  

A Final type Contractor Performance Evaluation must be APPROVED  
for EVERY contractor before a Final estimate can be created 

  It cannot have payments of any type, working days charged, or contract 
modifications approved.  This type of estimate strictly releases 
retainage - nothing else. 

 Every item must be marked complete  
A date must be entered in the All Contract Work Completed field in the 
 Docu > General Folder.  This date is NOT necessarily the project  
acceptance date 
 If there is a stockpile balance, a message will be displayed stating  

so.    If you receive this message when creating a final  
estimate, STOP.   Do NOT continue.  The stockpile balance must  
be zero BEFORE creating a final estimate. 

A date must be entered in the Time Charges Stop Date in the Docu > Site  
Times for EVERY site whether or not that site had authorized  
working days or days charged.  e.g. Even a site with 0 days allowed 
must have a stop date entered. 

 
Semi-Final =There can be more than one of these unless it includes a negative  

voucher – then it must be followed by a final  
  If there is a negative voucher, the estimate containing the negative  

voucher must be a semi-final and must be the last one 
processed prior to the final 

There must be a date in the All Contract Work Completed field  
before a semi-final can be created.   This date is NOT necessarily the  
project acceptance date 

If there is a stockpile balance, the Balance Stockpile option will be  
black.  Then you can put a checkmark in the Balance  
Stockpiles field to have the program reduce any/all  
balance(s) to zero on this SF estimate.  ALL stockpiles  
must be 0 PRIOR to the Final estimate being created 
A semi-final is not required before a final – it’s just an extremely  

good idea and highly recommended. 
 

 
Semi-Monthly = The one we use routinely. 
 
 
Retainage Release = Used strictly to release retainage to the contractor.   

   CANNOT have any type of payment, working days  
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charged, or contract modifications approved.  
      Prior to CREATING a RR estimate, the appropriate  

paperwork must have been completed and submitted  
to the Office of Construction. 
 

Before processing an RR type estimate, you must call Rhonda 
in the Construction Office (or call Janet if Rhonda’s gone for 
an extended period of time) so the appropriate entry can be 
made in CPS to release the requested amount of retainage 

 
As stated previously, all generated IDR’s and diaries with a date the same or 
prior to the estimate date that have not been included in previously created 
estimates will be included in this estimate.  If there are ungenerated IDR’s, you 
will receive the following warning.  It’s up to you whether or not to stop creating 
the estimate and go back and generate those IDR’s. 
 

 
 
 

If there are days charged and you have not entered a date in the Time 
Charges Start Date on the Docu > Site Times folder tab, you’ll 
receive the following warning.   This is the same warning we 
discussed a bit earlier. 

 
 
 

 
 

 
 
 
 
 
If that happens, Click No and return to the Docu > Site Times folder tab 
Enter the date in the appropriate field  
Click Save/Close 
Click the Estimate button and then the Add button 
Select the estimate date, semi-final type, and click OK again 
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Once the calculations are complete the General folder tab of the Add Estimate 
screen appears.  Let’s look at that one and also the other folder tabs. 
 

General Folder Tab - 
 
 

 
 

  Some of this screen is completed for you and is for your information only  
Estimate No. = The estimates are numbered automatically in  

sequential order each time you add one. 
Remember, the estimate number may or may not be the   
same as the voucher number.   

If there are multiple projects and project A pays 
Voucher 1 on May 1st, Estimate 1 is created.  If 
Project B pays Voucher 1 on May 8th, Estimate 2 is 
created.  If Project A and B each pay Voucher 2 on 
May 15, the estimate number will be 3. 

Item Dollar Amt = The dollar amount of this estimate that is the 
result of item postings. 

Stockpile Amt = The dollar amount of this estimate that is the 
result of a stockpile payment or reduction 

Total Dollar Amt = If viewed before the estimate has been 
processed, the dollar amount is the sum total of what the 
contractor will be paid NOT INCLUDING retainage withheld 
or mobilization paid.  If it’s viewed after the estimate has 
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been processed and the turn around file has been imported 
into FieldManager, the dollar amount is the sum total the 
contractor will be paid INCLUDING the retainage withheld 
and the mobilization paid. 

Current Contract Amount = The current value of this contract - 
including contract modifications. 

Amt Paid to Date (FM) = The total dollars paid including this 
estimate 

% Complete (Current) = The percent of the contract that is 
complete (including this estimate), based on the current 
contract amount which includes contract modifications. 

 
 
 Estimate Date = The date you selected on the previous screen.  

This determines which IDR’s and diaries are included in the 
estimate 

Entered By = The name of the person logged in at the time the 
estimate is created/generated 

Estimate Type = The type of estimate you selected on the previous  
screen 

Prime Contractor = The prime contractor for the contract 
 

Days Charged area = The number of days on each site that are 
being charged for this estimate and the total charged to date 
for each site.  Depending on the number of sites, you may 
need to scroll to see them all. 

 
The Estimate Comments field –  Comments are not required  

unless working days have overrun the allowed amount in 
any site.   

 
Notice that Balance Stockpiles is gray when Semi-Monthly is the estimate 

type selected.  If Semi-Final is the type of estimate selected, the Balance 
Stockpiles button will be dark and available for use.   If you click in the Balance 
Stockpiles field, immediately and automatically any stockpile balance for all 
stockpiles, if any, will be reduced to zero.   If you change your mind and remove 
the checkmark in the Balance Stockpiles box, the stockpile balance(s) will be put 
back in.  If you switch from Semi-Final to Semi-Monthly, the Balance Stockpiles 
option will be gray. 

 
 
Item Usage Folder Tab – Before the Estimate is Processed 

Click the Item Usage folder tab to view all items being paid.  Item 
quantities can be adjusted at this screen if needed.  Let’s check out the fields 
here – 
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The upper portion of the Item Usage folder tab screen shows information about 
the highlighted item - 

Item = The item number followed by the item description 
Prop Ln = The proposal line number of the item 
Type = This will indicate whether the item is an original item on the 

contract or was added by a contract modification.  If the type is 
unattached, do NOT continue.  Call Janet, Jen in the Creston 
Const Office (641-782-4518), or the Const. Office!  Unattached 
items can cause us big problems!!. 

Auth Qty = The rolled up authorized quantity for this item (All categories 
this item is in added together) 

Unit Price = The unit price for this item 
Auth Amt = The rolled up authorized dollar amount for this item (auth qty  

times unit price).  
Pending Chgs = Any changes to the authorized quantity being made by an 

unapproved contract modification. 
Qty Placed = The rolled up quantity of this item that has been placed to 

date, including quantities for this estimate 
Qty Paid = The rolled up qty paid to date for this item, not including this  

estimate 
 
The lower portion of the screen - 

Item Description = The description of the item being paid 
Item Code = The item code unique to this item  
Prop Line = The proposal line number of the item 
Insuff Matl = We’re not using the materials portion of this program so this 

column can be ignored. 
Overrun Flag = This will be checked if the item’s quantity placed is greater 

than the authorized quantity.  This does NOT necessarily mean a 
payment has been withheld - that’s dependent on the overrun rule.  
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It’s simply a notice that the current authorized quantity has been 
overrun to some degree. 

Atten = A checkmark will be displayed only if the contract is marked for 
attention on the Item > Documentation folder tab. 

** Qty This Estimate = The quantity for this item that FieldManager allows 
for payment.  This DOES take into consideration the overrun rule. 

Dollar Amount this Estimate = The amount to be paid for this item in this  
estimate.  

** Allowable Qty = Maximum quantity allowed for payment on this estimate 
for this item.  This DOES take into consideration the overrun rule. 

Allowable Dollar Amount = The maximum dollar amount allowed for 
payment on this estimate for this item 

** If some of the item quantity that’s been posted in IDR’s is withheld from 
payment due to the overrun rule, only the quantity and dollars allowed for 
payment will be shown in these fields.  The balance will be released for payment 
once a contract modification has been approved to increase the authorized 
quantity for that item. 
 
If there is a difference in the Qty This Estimate and the Allowable Qty, some 
of the quantity has been withheld from payment by a FieldManager user 
who reduced the quantity to be paid in the estimate process.   
 
To see more details about an item or to change a specific item - 

Highlight Item 0560, Rmvl of Pvmt 
Click the Review/Change button 

If the item is in more than 1 category, this will show it broken out by 
category totals as well what has been placed and paid for each category.   

 
To make changes to this item in the estimate - 

Put the cursor in the Quantity This Estimate field for the item  
Change the 72 quantity to 69  

 
You CANNOT change the quantity to an amount more than what is shown  
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in the Allowable Quantity column 
Press the Tab key 

Immediately the change in quantity will be reflected in the Dollar  
Amount This Estimate column.   The Allowable Quantity and  
Allowable Dollar Amount will NOT change since those are  
the quantities brought in from generated IDR’s. 

Changes made will immediately be reflected on the General folder tab  
totals 

Since we’re just experimenting and not doing, click the Cancel button 
 
 
Vouchers Folder Tab - 

To see the dollar amount to be paid for each project (voucher payment) 
click the Vouchers folder tab.   
   

 
 

This screen very simply shows the amount to be paid for each voucher 
(which represents each project) of the contract.  Since this contract has only 1 
project, there is only 1 line.  This dollar amount includes any stockpile 
transactions but does not include retainage or mobilization amounts until the 
estimate has been processed and the turn around file imported into 
FieldManager 

1.  If there is a positive dollar amount shown in the Estimated Payment 
column, there will be a checkmark in the Create Voucher field.  You cannot 
remove this checkmark - a voucher will be created for each project with a 
checkmark when you generate the estimate. 

2.  If the dollar amount of the voucher is zero, the Create Voucher field will 
not be checked but you can click that field which will insert a checkmark and a 
voucher will be created.  (You MUST insert this checkmark for estimates 
paying only mobilization as well as for retainage release estimates.  Final 
estimates will automatically check all voucher fields.) 

3. If the dollar amount of any voucher is negative, a warning will be 
displayed. 
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There will be a checkmark in the Create Voucher column for a negative 
voucher but you can and should remove it so a voucher is not created 
unless it is a semi-final estimate.  If you take out the checkmark, all item 
payments in that voucher will be withheld from this estimate but will be 
included the next time an estimate is created. 
 
Once you click OK to the above warning, the program will take you to the  
Vouchers tab where you can enter the checkmark for each appropriate 
project.  Once this estimate is processed and the turn around file imported 
into FieldManager, the amount paid will be reflected in the Construction 
Pay Estimate Report.   
 
You MUST NOT process a negative voucher unless it is a semi-final 
type and the following voucher is a final.  In other words, once you 
process a negative voucher, there can be no more item payments, 
days charged, stockpile transactions, or cont mods - - only the final 
estimate that simply releases retainage. 

 
If you need to create an estimate to pay mobilization only, create the 

estimate like normal and put a checkmark in the Create Voucher box for each 
project if 1% of the project value is equal to or more than $1,000 AND 10% of the 
mobilization item in that project is equal to or more than $1,000.  A checkmark 
will not be there already since it would be a zero voucher at this point.  If you 
forget to put in a checkmark and try to generate the estimate, you will get the 
following warning. 

 
 
 
 

View 

Estimate Folder Tab - 
The Construction Pay Estimate Report is a way to double check what will 

be paid if the estimate is processed.  This report is automatically created and 
offered for print when the estimate is generated.  It can, however, be viewed and 
printed before the estimate is generated.  The only difference between the two - 
the word Draft will be across the top of the un-generated report but will not be on 
the generated report. 

The Construction Pay Estimate Report does include stockpile information.  
It shows ONLY the items and the stockpile transaction(s) for THIS estimate.  It 
will not display mobilization payments until the estimate has been processed and 
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the turn around file (TAF) imported into FieldManager.  Retainage is never 
displayed on this report. 
     The report is divided up into several sections - 

Item Usage Summary - 
This lists each item being paid in this estimate    

Stockpile Summary - 
This lists the stockpiles, giving the quantity of payment or reduction 

being made for each and a total for all stockpiles (material 
allowances). 

Pre-Voucher Summary - 
This lists the voucher number, item payment total, stockpile 

adjustment, and the total dollar amount for each project as 
well as a total for all projects. 

Current Time Charges - 
This is displayed only if days are charged in this estimate. 
This shows the total days charged for each site for this estimate. 

   
 There is an option available (Docu button, General tab, Contract Level 
Settings button, General tab > Report Item Sort Order) to determine the order of 
the items in the reports.  There is also an option of how to group the data - 
  
If there is NOT a checkmark in the Group By Project/Category field - 
 The View Estimate report lists the voucher totals at the top of the report 
followed by all items being paid in the estimate, displayed in proposal line order.  
The Stockpile Summary (if any stockpiles) is displayed following items.  The 
report is sorted by proposal line number and they are displayed in this report. 
 
If there IS a checkmark in the Group By Project/Category field - 
 The View Estimate report first displays the items being paid, separated by 
project and category, giving a subtotal at the end of each and then a grand total 
at the bottom of the report.  The Stockpile Summary (if any stockpiles) is 
displayed below the items followed by the Pre-Voucher Summary – the totals 
listed for each project. 
 
 
 
View Amt Bal Folder Tab - 
 This report, like the Construction Pay Estimate Report (View Estimate 
folder tab) is created and offered for print automatically when the estimate is 
generated but can be viewed and printed before that by clicking the View Amt Bal 
folder tab.  The only difference between the generated and un-generated reports 
- the word Draft will be across the top of the un-generated report and not across 
the other one.  This report does not include stockpile, retainage, or site time 
charge information. 

All items on the contract are shown in this report, not just the items being 
paid this time but, as stated previously, it does not show any stockpile payment 
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information.  This is an excellent report to compare the Authorized Quantity to the 
placed and paid quantity  fields.  This is a report the contractors like because all 
items in the contract are displayed, not just the items being paid “this” time.   

Special note:  The mobilization item quantity that is displayed is behind 
one estimate.  In other words, even though mobilization is paid in this estimate, 
no mobilization is displayed in this report.  The amount paid in Estimate 1 will be 
displayed in the Estimate 2 report and so on. 
 
There is an option available (Docu button, General tab, Contract Level Settings 
button, General tab > Report Item Sort Order) to determine the order of the items 
in the reports.  There is also an option of how to group the data - 
  
If there is NOT a checkmark in the Group By Project/Category field - 
 The View Estimate report lists the voucher totals at the top of the report 
followed by all items being paid in the estimate, displayed in proposal line order.  
The Stockpile Summary (if any stockpiles) is displayed following items.  The 
report is sorted by proposal line number and they are displayed in this report. 
 
If there IS a checkmark in the Group By Project/Category field - 
 The View Estimate report first displays the items being paid, separated by 
project and category, giving a subtotal at the end of each and then a grand total 
at the bottom of the report.  The Stockpile Summary (if any stockpiles) is 
displayed below the items followed by the Pre-Voucher Summary – the totals 
listed for each project. 
 
Generating the Estimate - 

Once you have checked and double checked the item payment, the 
stockpile transaction (if any), and the amount of working days to be charged, it’s 
time to generate the estimate.  This simply means you’re “locking it” for 
processing.  An estimate cannot be processed until it has been generated.   

Any IDR’s with item postings and/or daily diaries with time charges for this 
contract that are generated after this “lock” of the estimate will be included in a 
future estimate - not this one!   You cannot create another estimate for this 
contract until the current one has been processed and the TAF imported. 
 

You can generate an estimate from any folder tab of the Estimates 
window by clicking the Generate button.  Answer Yes to the “Are you really 
sure?” question.  When the estimate is generated, the previously described 
reports, Construction Pay Estimate Report and Construction Pay Estimate 
Amount Balance Report, are created and offered for print.  Remember, these 
reports display gross figures (do NOT include retainage calculations) for each 
item.  If mobilization was paid, that line item is not displayed on the Construction 
Pay Estimate Report until the estimate’s turn around file has been imported into 
FieldManager.  As previously stated, mobilization is displayed one estimate late 
on the Construction Pay Estimate Amount Balance Report. 
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When the estimate is generated, a file is created, named and put in the 
FieldManager\Outbox folder automatically.  The filename is VCHRxxx.EXP with 
the xxx’s being a number that is dependent upon how many other files of the 
same name and type are already in the Outbox folder 

 
We talked previously and we’ll talk more about these files and the steps 

for processing an estimate later.  Now that’s a promise - not a threat!!!!!  
    

You should still be working with Contract 78-0061-114.  Let’s generate this 
estimate! 

Click the Generate button 
If you were in the midst of changing the quantity of an item, you’ll 
get a warning stating such and asking you to either finish that 
transaction or close it. 
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Answer Yes to the “Are you sure?” question about generating the estimate 
 

Both reports, Construction Pay Estimate Report and Construction Pay Amount 
Balance Report, are offered for print as soon as the estimate has been 
generated.  If you print these reports, do so  AFTER the estimate has 
been processed and the TAF is imported into FM in order to have a record 
of the mobilization paid. 

 
To view the amount of retainage withheld in the FieldManager program, you must 
go to the inquiry, Estimate Vouchers by Estimate, and select the specific 
estimate or select all the estimates.  Retainage is displayed for each estimate but 
there is no running total for the entire contract.  This inquiry is the only place 
retainage is displayed in FieldManager. Until the estimate turn around file is 
imported into FieldManager, many of the fields in this inquiry will be blank.  
(There is an Excel query that displays, among other things, retainage totals for 
each estimate as well as a total amount.  See Chapter 11 in this guide) 
 
Click Cancel for the print options since we’re not connected to printers at this 

time. 
 
The Estimate list screen now shows information for Estimate #1.  The percentage 

and total dollar amount will change once the estimate has been processed 
and imported back into FieldManager - then it will include all CPS 
(Contractor Pay System) transactions (mobilization & retainage). 

 
Notice that the status of Estimate #3 is Exported.  Once the estimate has been 
processed and the turn around file has been imported into FieldManager, the 
status of this estimate will be Refreshed.   You may create another estimate only 
if the status of the previous estimate is Refreshed.  If it isn’t, you’ll get the 
following warning – 

 
 
Close back to the contracts list. 
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Click the Cont Status button 
 

 
 

Notice in the graphic above that the Amount Paid to Date (FM) and the 
Amount Paid to Date (CAS) dollar amounts do not match.  That 
indicates to us that the estimate has been created and generated in 
FieldManager but it has either not been processed in CPS 
(Contractor Pay System) yet or it has been processed there but the 
turn around file (TAF) has not been imported back into 
FieldManager. 

 
 If the Amount Paid to Date (FM) and the Amount Paid To Date 

(CAS) are the same, the estimate has been created, processed, 
and the turn around file has been imported into FieldManager.  At 
that point, the estimate status is Refreshed. 

 
 The Total Unpaid Placed Dollar Amt displayed here is the amount 

of mobilization that has been paid since there are no item postings 
made for this item.  If postings had been made but not yet paid for 
other items, the total dollars for them would be included in this total.  

 
The Item Types area in the lower portion of the report (not shown in the 

above graphic) displays totals and percents for all original work, 
contract modification changes, and totals for each. 

Close back to the contracts list 
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We looked at the Stockpile Summary inquiry a bit earlier and it did not include the 
automatic reduction of the stockpile due to item postings.  Let’s look at it again 
now that we have created an estimate which includes some of those postings. 

Click the Inquiries button 
Select the Stockpile Summary by Stockpile inquiry 
Click the Select All button so we can see information about all the  

stockpiles, specifically the ones for Epoxy Coated Reinforcing Steel  
and Misc. 

 
If more than one stockpile was selected, each will be listed, one after the 

other, sometimes on separate pages.  Use the Next Page and the 
Previous Page buttons to move from one item to another. 

 
The Automatic Decrement entry in 602A, Reinforcing Steel, is due to the 

payment of item postings for items to which this stockpile is linked. 
 
Notice the Misc stockpile.  We made an item posting for this linked item 

that overran the authorized quantity.  FM  reduced the stockpile to 
zero.   At no time will the program reduce a stockpile to less than 0. 

 
Close back to the contracts list when finished viewing this inquiry. 

 
 
 
Files Automatically Created & Deleted 
Open Windows Explorer if it’s not already open and displayed in your taskbar 

(Right click on the Start button and left click on Explore) 
Expand the FieldManager file folder (click the plus in the box to the left of the  

FieldManager file) 
Highlight the Outbox folder 
See the file that was created due to generating the estimate.  
 VCHRxxx.EXP 

 
Minimize Explorer - we’ll be going back to it later 
 
 
Deleting an Estimate That Has Been Generated - BUT THAT’S ALL!!! 

Even though you checked and double checked the estimate information, 
sometimes the best plans must be changed a bit.  This is what happened to us 
and we no longer want to pay this estimate.  We will pay the contractor sometime 
in the future but not with the information in this estimate.   Here are some simple 
rules to use as guidelines. 

1.  You can delete ONLY the most recent estimate  
2.   If a generated estimate is deleted, the program will also delete the 

VCHRxxx.EXP file in the Outbox folder that was automatically 
created at the time the estimate was generated. 
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3 As long as you have only generated the estimate and have not done  
the Combine Outbox step, the delete is very simple.   

4 Once the estimate has been deleted, that same estimate number will 
 be used again. 

 
 

You should be at the contracts list with Contract 78-0061-114 
highlighted.   

Click the Estimates button 
Highlight Estimate No. 2 if it isn’t already 
Click the Delete button 

 
 
 
 
 
 
 
 

Answer Yes to the “Are you really sure?” question 
The estimate and any related files are gone!! 

 
Maximize Windows Explorer and notice the voucher file (VCHRxxx.EXP) 

that was in the FieldManager\Outbox is now gone.   
Minimize Explorer, we’ll come back to it again later. 

 
Close back to the contracts list in FieldManager 

 
 
Review - Generating a Cont. Mod. & an Estimate 

We’re going to go through the estimate generating process again since 
making a mistake here can prevent the contractor from receiving a payment.  
And we all know they wouldn’t be happy about that!!!  And if they’re not happy, 
they could ruin our day as well!!!! 

 
Remember, once an estimate has been generated, a contract modification 

has been approved, dates have been entered, and/or contractor performance 
evaluations have been approved, files are created and put in your 
FieldManager\Outbox folder to be processed.   

 
Contract 78-0061-114 should still be highlighted 
Click the Estimates button 

Since we deleted the estimate in a prior exercise, we’ll need to 
create another. 

Click the Add button 
Today’s date is OK to use for this estimate 
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Semi-Monthly should be the Estimate Type so click OK 
We’re going to assume we’ve checked everything and want to pay  
it. 

 Answer OK to the Time Charge Start Date warning 
Click the Generate button once the calculations are finished 
Answer Yes to the “Are you really sure” question 

When the estimate is generated, a file is created simultaneously 
and put in the FieldManager\Outbox folder- VCHRxxx.EXP  
 

The first of two report options will be offered for print.   
You must remember, these reports at this time do NOT include the 
calculations (retainage  and mobilization payments) done by the 
mainframe as the estimate is being processed.  (After the estimate 
has been processed and imported back into FieldManager, you 
definitely should print these reports if you want a hard copy of ALL 
payments and withholdings to the contractor.) 

For this training, cancel at the Print screens 
 
Close back to the contracts list 
Maximize Windows Explorer and look in your FieldManager\Outbox folder   

 
You should see a familiar file - VCHR001.EXP.  This file existed 

previously, then we deleted the estimate so it was also deleted.  Now that the 
estimate has been generated again, it’s back!! 
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Minimize Explorer instead of closing it, we’ll go back to it in a bit - again!!! 
If you create an estimate for another contract, the files created for 

that estimate will also be in the Outbox folder and will look exactly the 
same except for the number within the filename.) 

 
 
 
Continuing the Steps to Process the Estimate (& Approved 
Contract Modification & Dates) 
Now we’re ready to continue the steps to process the estimate! 

Click the Utilities button 
Click Combine Outbox Files 
 Contractor evaluation files are combined into 1 file with a .CPE 

extension.  Dates, approved cont mods, and estimates are combined into a 
different file with a .UPD extension.  So… if you are asked 2 times about 
combining the files when you click the Utilities > Combine Outbox Files, you have 
both types in the Outbox.  Notice the headings of the 2 following graphics – the 
first  is to create a .UPD combined file and the second is to create a .CPE 
combined. 

 
 

 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
Notice that this is for the file that combines vouchers, cont mods, & dates 
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Notice that this is for the file that combines the CPE files. 
 
For the location where you would like to place your export files, type 

C:\FIELDMGR\OUTBOX in the field if it’s not there already - it’s not 
case sensitive 

Once you enter the path, it will remain the selected choice 
until you change it but will, even after that, remain in the drop 
down list. 

Click the OK button 
 
 
 
 
 
 
 
 
FieldManager will find ALL appropriately named files in  

the FieldManager\Outbox with an .EXP extension and combine them into one 
upload file and save it in the location we specified (FieldManager\Outbox folder).  
Time charge start and stop dates, site events, and contract modification 
information are all included with the estimate information in this newly combined 
upload file.   

Also, if there were any contractor evaluation files with an .EXP  
extension in the Outbox, they are combined into a separate file as noted 
previously. 

The combined files’ names are based on the district number 
that was entered in the Utilities > System Management > System 
Configuration screen and the number of the .UPD and/or .CPE 
extension files already existing in the FieldManager/Outbox folder. 
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While at the estimate list screen, notice it is very difficult to determine 
whether the estimate has been processed or not.  We do know that as soon as 
the estimate is generated, it will have a status of Exported – but that status will 
remain Exported until the TAF is imported into FieldManager – at which time the 
status changes to Refreshed.  To help determine this -   

Check to see if you have a .TAF file in your FieldManager\Inbox 
corresponding to the combined filename you sent for processing.  If you do, you 
have probably completed all steps except importing the TAF into FieldManager.  
If you don’t, you probably haven’t downloaded the file yet from TSO.)  You 
cannot create another estimate in FieldManager unless the status is Refreshed.  

 
If you just plain don’t know, call Janet or Jen in the Creston Const Office 
(641-782-4518).  We can determine whether or not the estimate has been 
sent to CPS and what needs to be done next for you to finish the estimate 
process. 
 
To process a contract modification WITHOUT creating an estimate, you can 
simply do the Combine Outbox Files once you’ve approved the cont mod.  If you 
have not created an estimate for any contract, the combine process will combine 
only the cont mod file for processing.  Process that combined file as usual.   
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As previously stated, each time the Combine Outbox Files function is 
used, there will be only one combined file with a .UPD extension created for all 
vouchers, cont mods, and date files in the Outbox folder that had an .EXP 
extension.  If there were any CPE files in the Outbox, a different combined file 
with a CPE extension would be created. The combined files are given names 
automatically - DO NOT CHANGE THE NAME OR EXTENSION!!!    As 
previously stated, the file names are based on your district’s number, your cost 
center, and the number of these files that have already been created in the 
Outbox folder.  There will be up to 30 of these .UPD or .CPE files before the 
program begins to re-use the file names.  (Even if these files have been deleted 
in the Outbox and do not show, the number continues to increase if those files 
are still in the Outbox/Backup folder.)  The extension will always be .UPD for 
voucher, cont mod, and date combined files in the Outbox.   The extension will 
always be .CPE for evaluation files in the Outbox. 
 
 
 
Deleting an Estimate That HAS Been Combined in the Outbox And/Or 
Processed 

We previously deleted an estimate after it had been generated – and it 
was a fairly simple process.  Once you have done the “Combine Outbox” step, 
however, the delete is a whole different story - a more complicated one - and 
involves a rollback file.   Rather than getting the “Are you sure” question when 
you attempt to delete this type estimate, you’ll get the following warning. 

 
 
 
 
 
 
 
 
 

If you get this warning, do NOT continue without checking with Janet 
or Jen in Creston Construction Office (641-782-4518 first. 
 
 Even if you have not actually processed the estimate, but have done the 
Combine Outbox feature, the delete is no longer simple.  Call for help 
BEFORE continuing.  The combined file can involve much more than just an 
estimate.  If you miss even 1 step during this type of delete process, the next 
estimate you process could fail or the first time you try to pay for a new item, that 
process could fail. 
 
Close back to the contracts list. 
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Using the FM Xfer Program 
Once the Combine Outbox Files step has been completed, you can find the 

combined file you will send to CPS (Contractor Pay System) for processing in your 
Outbox.  In our case, that file name is D4524201.UPD.   Combined files with a .CPE 
extension are not processed using the FM Xfer program.  The combined file with a 
.UPD extension contains all information for site times, dates, events, contract 
modifications, estimates, etc. and does use the FM Xfer program to process information. 
 

The FM Xfer program makes life very easy to send and receive contracts.  In 
order to use this program, however, you must know the password for your office.   If you 
don’t know it, contact Janet or Jen in the Creston Construction Office (641-782-4518). 

Before you use the FM Xfer program for the first time, you must be sure it has the 
correct configuration.  To do so – 

Double click on your FM Xfer program icon 
Click on the Configuration button 
If you would feel more comfortable, call Janet orJen and have them talk you 

through this configuration. 
Your office’s TSO user ID (RCExx) should be displayed in that corresponding field 

Counties will be Cexxxyy with the xxx’x most often being the first 3 letters 
of the county name and the yy’s being the county number 

RCE offices will NOT have a checkmark in the Modem Connection 
 Counties may have a checkmark in the Modem Connection 

 
It is important when the FM program is upgraded that the location of the project files be 
directed to the appropriate path to match the FM Xfer program.  Look at the location of 
the backup file to give you an indication as to where those files are located. 
  
PC File paths for Win7 machines – 
 Upload Files – C:\PROGRAMDATAFIELDMANAGER\OUTBOX\*.UPD 
 Download Files – C:\ PROGRAMDATAFIELDMANAGER \INBOX\*.TAF 
 New Contracts – C:\ PROGRAMDATAFIELDMANAGER \INBOX\FMGRINIT 
 Reference Data – leave as is (you are not to use this to retrieve a reference file) 
 Status Msg – C:\ PROGRAMDATAFIELDMANAGER\INBOX\VCHRMSG.TXT 
 
Shown below are the paths for the Datasets for all operating systems - 
 Upload Files – PBAMS.RCExx.FIELDMGR.UPLOAD 
 Download Files – PBAMS.RCExx.FIELDMGR.DOWNLOAD 
 New Contracts – PBAMS.RCExx.FIELDMGR.INIT 
 Reference Data – leave as is (you are not to use this to retrieve a reference file) 
 Status Msg – PBAMS.RCExx.FIELDMGR.VCHRMSG 
  The xx’s are the RCE number, ie Des Moines is 12, Creston is 44, etc. 
  Counties would replace the RCE number with the CExxxyy shown in the  
   TSO User ID field 
 
Click the Update button and then the Done button. 
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To Send an Estimate to the CPS (Contractor Pay System) for 
Processing 

(Upload Process) 
 
 
You will be sending the file with the .UPD extension to the CPS (Contractor Pay System) 
that you combined in the “Combine Outbox” step.  If you aren’t sure of that specific file 
name, open Explorer and look in the FieldMgr\Outbox folder.   Check the date of the 
file to be sure it’s the correct one. 
 
 Double click on the FM Xfer icon  

Select Upload to TSO as the transfer type  (it’s the default) 
 Press the Transfer button 
 Enter your TSO password  
  If you forget what it is, call Janet.  She has all of them for the DOT Offices. 
  

Select the appropriate file (the 1 you just created in the Combine Outbox step) 
from the list .  This list displays all the files in your FieldMgr/Outbox folder 

 
 Press the Send button 
 
 Wait for a minute or two and then check the status message – directions on the 
following page. 
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To Check the Status of the Voucher Processing 
 
If you closed the FM Xfer program, double click on the icon  
Select Get Status Message as the transfer type 
Press the Transfer button 
If required, enter your TSO password 
 
A message similar to the following graphic will be displayed.  It will show the contract ID, 
project number, voucher number, dollar amount paid, and retainage withheld (if any) or 
retainage released for each voucher (project) processed.   
 

 
 
 

Notice that in the above example, there is a scroll bar which means there are 
more contracts listed than what are shown here.  In this example there are 3 contracts 
being paid and 1 of those contracts (56-0611-117-M) has 4 projects.  Each project has 
its own payment so in the above case, 4 checks will be issued for Contract 56-0611-117-
M.  Each of the other contracts have only 1 project so 1 check will be issued for each of 
them.    

If the number under “Retained” is a positive number, that amount of retainage  
was withheld from the voucher.  If that number is a negative as shown for Contract 29-
0349-200, that amount of retainage was released.   In the example above, the $30,000 
maximum withholding of retainage for Contract 56-0611-117-M was reached with the 56-
0611-117-M PROJECT so the other projects in that contract have no retainage withheld.   
Future payments for projects in this contract will not have retainage withheld. 
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If there is an error during processing, the error message will be displayed rather than the 
contract information.   
 
If there is no information displayed, you may have attempted to see the status message 
before the processing is complete – therefore, there is nothing to see yet.  Wait a bit and 
try again! 
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To Receive a Processed Estimate From The CPS (Contractor 

Pay System)  (Download Process) 
 
 If you closed the FM Xfer program, double click on the icon  
  Select Download from TSO as the transfer type 
 Press the Transfer button 
 If required, enter your TSO password  
 
 Select the appropriate file (the same one you just sent in the Upload to TSO  
  process) from the list.  This list displays all the files in your FieldMgr\Outbox  
  folder.  

 
The program will automatically keep the file name the same but change the .UPD  
 extension to .TAF and put the  turn-around-file in the FieldManager\Inbox. 

 
Press the Send button 
 
 

If you’re not sure whether the Download from TSO worked, you can always open 
Explorer and look in the FieldMgr\Inbox to see if the appropriate file with a .TAF 
extension is there.  (It should have “today’s” date).  
 

 If the file is there, great!!!  If it is not there, check the other .TAF files in the Inbox 
to see if they have “today’s” date – you might have selected the wrong file during the 
download process.  If that is the case, simply import the TAF file with ‘today’s” date into 
FM instead. 

  If there is no TAF file with “today’s” date in your FieldMgr\Inbox, you can repeat 
the Download from TSO steps again.  If that still doesn’t work, call Janet !  If she’s not 
there, talk to Jen in the Creston Construction Office (641-782-4518). 
 
 
If you import an old TAF file, you will bring in the paid quantities for every item in all the 
contracts in that TAF file as of the date of that TAF file.  Since it’s an old TAF file, the 
quantities paid could be greatly less than the placed quantities when you click the Items 
button and look at the quantities.  If you notice that has happened, give Janet a call.  A 
new download file for those contracts will quickly take care of that problem!! 
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Importing the Processed Estimate File Into FieldManager 

  
Once the estimate has been processed, the updated information must be 
imported into FieldManager so the latest pay information is available.  We’ll go 
through those steps now.  That wasn’t exactly a surprise statement, was it??!! 

 
Based on the previous pages, we know the processed filename, that it has a TAF 

extension and that it was put in your FieldMgr\Inbox folder on the C drive. 
 

If you’re not in FieldManager at the contracts list screen already, go there now 
 

Click File > Import > File 
 

  
   Sample only 
 

 
Make your selection so Inbox is displayed in the Look In field. 
Select either Contract Files(*.*) or All Files(*.*) in the Files of Type field 
Highlight the correct TAF file and click Open 

The correct file will be the one you downloaded as explained on the 
previous page.  With rare exception, it will always have the same name as 
the file with the .UPD extension you just sent for processing.  This .TAF 
extension lets you know that it’s a turn-around-file.  In other words, it has 
been processed and is ready to “come home”!!! 

 
Once the import is complete, the updated estimate information will be in 

FieldManager.  The estimate will then have a status of Refreshed and the Cont Status 
information will reflect the updated information - the (FM) field and the (CAS) field will 
have the same dollar amounts.   
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Safety Check: Once the processed file has been imported into 
FieldManager, highlight 1 contract that had an estimate processed, 
click the Estimates button and check to be sure the status has 
changed to Refreshed.  Also, click the Cont Status button and 
check to be sure the dollar amounts are the same for (FM) and 
(CAS).  If they are, great!!  If they are not, not so great - and call for 
help.  We’ll work it out!!  Repeat these checks for every contract 
that had an estimate processed. 

 
 
 
IF YOUR OFFICE KEEPS HARD COPIES OF THE ESTIMATES - 
Once the estimate has been processed and imported into FieldManager, you 
should – 
 

1. Highlight the appropriate contract 
2. Click the Estimates button 
3. Highlight the latest estimate if it isn’t already 
4. Click the Print button 
 

 
 

5. Select to “Print the 1 selected Pay Estimate Report” and click OK 
This will display all items, including mobilization, that were paid on 
the estimate 

6. Repeat Steps 3 through 5, this time selecting the “Print the 1 selected 
Amount Balance Report” 

This will display every item in the contract and the total paid on this  
estimate as well as the total paid to date for each item.  
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It’s up to each office’s or county’s wishes, but it’s a good idea to 
keep one copy of each report in the office and to give another copy to the 
inspector.  Some contractors who don’t have the FieldManager Read Only 
license also like to have these reports. 

For those contractors who do not have the Contractor Read Only 
license, the Pay Estimate Report is extremely helpful to them if stockpiles 
were increased or decreased on the estimate. 

 
 
The next time FieldBook imports a turn around file from FieldManager, the 
updated paid item information for that contract will be displayed. 
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If you got lost along the way and don’t know where you are!!! 

(Not that something like that would ever happen!!!!) 
 
 
If you started through the steps to process an estimate, got interrupted 

and now are not sure what step you’re at in the processing, this might help. 
 
1.  If there is a D?????XX.UPD type file with today’s date in your Outbox folder, 

you have already done the Combine Outbox Files step 
     It may or may not have yet been processed at the CPS (Contractor Pay 

System).  Either check in CPS, ask Janet, or Jen in Creston Const (641-
782-4518 to check for you 

   
2.  If there is a D?????XX.UPD in your FieldMgr\Outbox folder and the same file 

but with a .TAF extension and today’s date is in your FieldMgr\Inbox, the 
estimate HAS been processed in CPS (Contractor Pay System) and you 
have also done the Download from TSO step.  The file may or may not 
have been imported back into FieldManager.   

 
3.  If the status for the estimate just processed is Refreshed, it has been  

processed and imported into FieldManager. 
 
4. If the Amount Paid to Date (FM) and the Amount Paid to Date (CAS) fields in  

the Cont Status screen of FieldManager are the same, the latest estimate  
has been processed in CPS (Contractor Pay System) and has been  
imported back into FieldManager. 

 
5. If the Amount Paid to Date (FM) field is larger than the Amount Paid to Date  

(CAS) field, the estimate has either not been processed or it has been  
processed but has not yet been imported back into FieldManager.  Check  
to know for sure! 

 
6. If the estimate was a Final, click the Inquiry button and select the Estimate  

Vouchers by Estimate inquiry.  Select or double click on the final estimate.   
If there are negative dollars in the Current Retainage column and the  
same dollar amount but a positive amount in the Net Payment column, the  
estimate has been processed and the TAF has been imported into  
FieldManager. 
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Receiving New Contracts Into FieldManager  
(Init Process) 

 
When you receive notice that a new contract(s) has been signed and is ready for 
you to import into the FieldManager program - 
 
 If the FM Xfer program is not already open, double click on the icon  
 Select the Receive New Contracts transfer type 
 Press the Transfer button 
 If asked, enter your TSO password 
 
 The FM Xfer program will automatically put the new contract(s) in your 
FieldMgr\Inbox using the file name of FMGRINIT 
 To add the new contract(s) to FM, import that file, as described below 
 
At the FieldManager contracts list - 

Click File > Import > File 

 
 

Make your selection so the Inbox is displayed in the Look In field 
Select either All Files (*.*) or Contract Files (*.*) in the Files of type field 
Highlight the FMGRINIT file and click Open 
 
Once the import is complete, the new contract(s) will appear in the contracts list.  
 
**************************************** 
Once the new contract(s) have been imported into FM, click the Docu button and 
enter the appropriate information on the General tab then Save/Close.   
 
REMINDER - 

An initial mobilization payment should be created and processed for each  
PROJECT that meets the following criteria – 
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1% of the project value is equal to or more than $1,000. 
AND 

10% of that project’s mobilization line item is equal to or more than $1,000. 
 
If either one or the other of the above is not equal to or more than $1,000, an 
initial mobilization payment should NOT be made.  If one is processed, the 
voucher will be cancelled in CPS. 
 
 
 
 

Importing the SiteXchange Contractor File 
 
After the contract has been inited and you have imported it (File > Import > File) 
into the FieldManager program, if your contract has a .CON file, Janet will put it 
in your SiteXchange file on the W drive and notify you.  Once you import that file 
into FM all the subcontractors and their respective work items will be displayed.  
 
If the .CON file will not import into FM, that means your FM reference file needs 
to be updated.  Contact Janet and notify her of the contractor’s name and vendor 
ID and she’ll create an updated reference file for you.  Once you import that 
reference file you’ll be able to successfully import the .CON file. 
 
 1.  Import the inited contract 
 
2.  Import the SiteXchange file (File > Import > File), selecting 
SiteXchange(*.con) in the Files of Type field. 
 
3.  Highlight the appropriate contract and click the Contractors button.  The prime 
and all the subs should be listed. 
 
4.  Highlight 1 of the contractors and then click Change 
  
5. Enter the work type for each contractor on the General tab 
 
6. If desired, enter the address also on the General tab 
 
7. Click the Items tab and all contract items will be displayed.  Those associated 

to the highlighted sub will have a checkmark.    
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Backing up the Database 
 

FieldManager backups should be done daily. 
 
It’s crucial that backups are done daily since there is only 1 working copy 
of each contract and that’s on the FieldManager machine.  If your hard drive 
crashed, you’d lose every contract, not just one!! 
  
 FieldManager backs up by default to the C drive and then offers you the option 
to copy that backup to a different location.  The preferred location is a folder on 
the W drive that has been created specifically for your office’s back up files.   The 
backup file name is “today’s” date written in year-month-day order with an 
extension of BK.  If more than 1 backup is done for the same day, the extension 
will be BK2, BK3, etc.  An example of a backup file name for May 26, 2011 is 
20110526.BK. 
 
Backup Policy - 

1. Backups are to be done daily.   
 

2. Do NOT change the FM program’s default back up location so it backs  
up directly to the W drive.  We have had problems restoring the 
database from the backup file if this is done.  Instead, allow FM to back 
up to the C drive and then allow the program to copy that file to your 
backup folder located on the W drive or copy the backup file yourself to 
that location using the Copy > Paste procedure.   

 
3. The backup file should be copied to a location on the W drive that is 

accessible for your office’s FieldManager users. 
 

4. Only 3 or 4 days of backup files need to be kept in the backup folder 
on the W drive.   

 
The backup process makes a copy of the entire FieldManager database.  

This not only includes all contract information, it also includes users, passwords, 
preferences, etc. as well as the files in the FieldMgr/Inbox, FieldMgr/Outbox, and 
FieldMgr/Attach  folders.  You do NOT have to back up each contract 
individually. 
 If you are using more than 1 datasource (database) in FieldManager, 
each must be backed up individually.   In other words, if you back up 1 
datasource, it will NOT back up anything in the other datasource. 
 

All windows in FieldManager must be closed before the backup process 
will occur.  If you forget to do so, you will be warned as soon as you click 
the Backup button, the program will close the open window(s) for you, and 
continue from there. 
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Let’s do a backup of the database just as you should on a daily basis. 

If you’re not already at the contracts list, go there 
Click File 
Click Backup Database... 
 

 
 

 
The upper portion of the screen displays the previous backups and 
the dates they were done for this database.  The Backup to File 
field will default to a location.   DO NOT CHANGE THIS BACKUP 
TO FILE LOCATION. You can see this location if you click Utilities> 
User Preferences.  The file name will be the date and will have a 
.BK extension.  If this is not the first back up done for today, the 
extension will reflect that.  In the above graphic, it is the 2nd backup 
(BK2) done on May 13, 2011.  The date is listed year-month-day   

 
Click the Backup button. 

If you forget to close a window, you’ll get a warning giving you the 
option to have the program close it for you before continuing. 
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Once the windows are closed, the backup will begin 
 

 
 

 
 
 
 
 

 
You’ll get a notice when the backup is complete 

 

 
 
 

When the backup to the C:\ drive is complete you’ll be asked if you want to 
copy the backup to another location. 

 
Answer Yes and then select the appropriate location of your office’s 

backup folder on the W drive. 
 
The backup file that is being copied is the one you just created. 

 
DO NOT CONTINUE OR SHUT DOWN THE PROGRAM UNTIL YOU RECEIVE 
THE MESSAGE THAT THE BACKUP FILE WAS COPIED SUCCESSFULLY. 
 
 

As stated previously, each office has a folder on the W drive already 
designated to hold their FM backup files.  If you don’t know the location, ask 
someone in your office.  If they don’t know the location, contact Janet or Jen in 
Creston Const (641-782-4518).  The reason the backup file is copied to the W 
drive is because that drive is backed up on a daily basis. 
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You need to keep only the latest 3 or 4 backup files on the server – 
we wouldn’t want to restore from anything older and that would just use up 
space on the W drive foolishly.   
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Restoring the FieldManager Database & Files 

 
Be aware – The restore process gives you an option to restore from a 

location other than the hard drive but we have NOT had good luck restoring 
directly from the W drive.  Please contact Janet or Jen in Creston Const 
(641-782-4518) before beginning the restore process! 
 
*********** 

Because the datasource in the FB program is determined by the computer 
exporting the contract, the restore process in FM is even more critical than in 
previous releases.  If the original FM machine crashes, the only way to be certain 
that FB will allow the import of a contract or IDR turn around file from that original 
office’s computer into the “new” FM computer is to restore the database from the 
“old” FM computer.   If that is not done, a new datasource will need to be created 
in every FB machine for contracts they already have. 

 
************ 

Also be aware that if you had multiple datasources in FM, this restore 
process will restore ONLY the datasource in the backup file you are working with. 
 
*********** 
 

The FM restore process ELIMINATES whatever is in the FieldManager 
database (contract information, user ID’s, passwords, files in the Inbox and the 
Outbox, etc.) on the computer you are restoring to and REPLACES it with the 
information in the backup file. 

As part of the restore process, the program first backs up the database on 
the computer receiving the restored file so if, for some reason, the restore 
process fails, FieldManager will reconnect to the original database. 
 
PLEASE CALL BEFORE beginning the restore process.  It’s much easier to 
take a bit of time and help than to have a problem to solve after the fact.   
 
Do not restore if you have anything in the FieldManager program on the 
computer you are restoring to that you wish saved. 
 
We’ll go through the steps to restore - just so they’re familiar. 

Click File 
Click Restore Database 
Now you have a choice - great, more confusion, huh!!!! 
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To restore from a backup that’s on the hard drive of the same computer 
Highlight the appropriate backup in the middle area of the screen.  
You would rarely ever use this option.   I would be VERY 
selective and cautious about using this.   I won’t continue showing 
the steps for this process since it will rarely, if ever, be used. 

 
To restore when the backup file is not on the hard drive –  
 To speed up the restore process, copy the backup file from the 

location on the W drive where you keep your backup files to the backup folder on 
your C drive or to another location on your C drive. 

 Click the Browse button and locate the backup file.   
  
Do not restore unless you have contacted Janet or Jen in Creston 

Const (641-782-4518).  The restore process involves not only the contracts but 
user ID’s, passwords, and files in the Outbox and Inbox.  
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 The above graphic is the first of two warnings that appear.  This warning 
states what the process will do and highly recommends you call for help before 
continuing.  Good advice!! 
 

Click OK to continue - but if you do this without help, at least feel guilty for 
not calling first!!!  And if you have a problem, you’d better feel really 
guilty!!!! 

 
 

 
 
 
 
 
 
The second warning advises you that this option will replace the current 

database and asks if you wish to continue .  
Based on the number of warnings during the restore process, you 
should be very aware of the seriousness involved.   

 
Answer Yes to continue 
 

 
 

 
 
 
 
 
 
 
 
Another message appears stating that all windows must be closed before 

the process of restoring can continue.  If the windows are not 
closed already, the program will close them if you answer Yes to 
continue. 
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The final message - that the restore was successful - will appear when the 
process is complete.   
 

 
 

 
 
 
 
 

 
 
Click OK 
 
Click Close at the Restore screen. 
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Exporting a Contract for a FieldBook Laptop 
 
Be sure you have entered the inspectors’ names and passwords in the FieldManager 
program BEFORE you export a contract for use in FieldBook.  User ID’s and passwords 
are passed along with the contract information to FieldBook as long as they have first 
been entered in the FieldManager program. 
 
A suggested method when adding user ID’s in FieldManager is to enter the same 
password such as the word password (remember there is a 5 character minimum 
requirement) for everyone.  Once the user enters the program whether it’s FB or FM, 
they can change their password to one of their choice.   
 
Exporting Using the Flash Drive - 
At the Contracts list in FM - 

Click the Export-FB button  (It does NOT matter what contract is highlighted right  
now) 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
A list of all contracts appears.   

(If the contract does not appear in bold print, it is a read-only copy and cannot be 
exported.) 

Highlight the contract(s) you wish to export 
Click so there is a checkmark in the Include Reference Files in the Export 
Click the Select button 
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Since we’re going to transfer by flash drive, E:\ should be shown in the location to 
place the export files.  Once you have typed in the location, it will be saved.  
If it doesn’t show the next time, click the down arrow and select it from the 
drop down list.  

 
Click the OK button and an export file will be created, named, and placed on the 

flash drive. 
 
This export file will automatically be named according to the contract being exported.  If 

more than 1 contract is exported, the file name is based on 1 of the contracts.   
The extension will always be .EBL.    Do NOT change the name or the 
extension. 

 
Once this file is on the flash drive, put a label on it with the contract ID number (e.g. 44-
2182-0057-M) so you will know to give it to the correct inspector at the appropriate time.   
 
When it’s time for the inspector to import the file, the inspector will just need to enter the 
location of the file (E:\), not the name of the file. 
 
Once the file containing the contract (remember it’s an .EBL file) has been imported into 
the FieldBook program it will disappear from the source which, in this case, is the flash 
drive. 
 
 
Exporting Using the Server Instead of the Flash Drive - 
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If the inspector has a folder on the W drive, you can export the contract (with or without 
the reference file)  directly to that folder.   The inspector can import the contract directly 
from there – remember, it will disappear from that folder once the import is complete. 
 
 
 

Moving Contracts to A Different FieldManager Machine 
 
There will be times when a working copy of a contract must be moved to a 

different FieldManager machine, when another individual needs to have a read only 
contract for review purposes, or when the contractor has requested a read only copy of 
the contract.  The same basic process will accomplish all of these needs!!!   
 
You should be back at the contracts list by now so... 

Click File 
Highlight Export 
Click Transfer Contracts... 
A list of all contracts in this FieldManager program will be displayed. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

If you see a contract listed but it is “grayed out”, this means it is a read-only 
copy and you cannot use this transfer process for it. 

 
Highlight the contract(s) you wish to transfer 
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If you want to highlight more than one at a time, hold the Control key down 
and click on each contract ID number(s) 

Click the Select button 
 
 

There are 3 options available for transferring a contract.  You must choose one of 
them.  

REMEMBER, if you highlighted more than one contract, the option you choose 
will apply to all of them.  To allow different options for different contracts, you must 
transfer them separately.  In other words, if you want to transfer the working copy for 
Contract A but you want to transfer a read-only copy of Contract B, you must do so one 
at a time - not together. 

 
You must have system administrative authority to transfer a working copy 

of a contract. 
 

 
 

The options available are - 
1.  Create a regular read-only copy of the contract - This will transfer a read-only 

copy of the contract so it can be imported into another FieldManager 
machine.  The contract can be viewed on that machine but not modified.  
There can be many read-only copies.  The working copy is still on the 
original machine.  There will be R/O in the header and ReadOnly displayed 
in the Access column of the contracts list for a read-only contract .  The 
extension for this type of file is .001. 

 
2.  Transfer the contract  - This will transfer the working copy of the contract so it 

can be imported into another FieldManager machine  and will leave a read-
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only copy on the original machine.  Once the transfer has taken place, you 
can no longer modify the copy on the original machine.  The date the 
working copy was transferred will be displayed in the Access column of the 
contracts list.  The extension for this type of file is .001. 

 
3.   Create a contractor read-only copy of the contract – This will create a special  

type of read only copy of the contract.  This is the only type of transfer that  
is to be given to the contractor since it withholds data from certain fields  
such as the diary comments.  The extension for this type of file is .CRO. 

 
  If you want to include attachments in the transfer of your choice, click so there is a 
checkmark in front of the Include attachments option.  Be aware, depending on the 
number of attachments, the size of the file could increase dramatically.  (Including 
attachments is not an option available for the contractor read only type of transfer.) 
 
Click so a dot is in front of the transfer of your choice. 
 
 Remember, only system administrators can transfer a working copy of the  

contract. 
 
Click OK 
 
It’s your choice where to place the contract being transferred, but many times we’ll be 
using a flash drive. 
 
If you want to transfer by using a flash drive, select that option as shown below.  
 

 
The program automatically assigns the name FMCONTS.001 to every contract being 

transferred except the contractor read-only.  If you must change this name, do 
NOT change the extension .001.   
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If you do change the name, the recommended naming convention is 8 
digits in length with the first 2 digits being the county, the next 3 being the 
highway number (with leading zeroes if necessary), and the last 3 being 
the parenthesis number (with leading zeroes if necessary). 

 
FYI – Contractor read only files will be named FMCONT01.CRO.  Do not change this 
name or extension. 
 
Click OK 
A message will appear when the export is finished. 
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Deleting a Read-Only Contract from FieldManager - 

 
If you have a read-only copy of a contract you may want to delete it from your 

FieldManager program.  Because this is not a working copy the steps to do so are much 
easier!!     
 

Highlight the contract in the contracts list 
Click Edit 
Click Delete 

If you’re really sure, answer Yes to the “Are you really sure” question 
It’s gone!!!! 

 
If you had selected an active contract by mistake, the Edit>Delete steps would not have 
been successful.  You would have received the following message instead. 
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Archiving a Contract 
 
When a contract has been included in the list of contracts to be archived sent monthly by 
Janet, then and only then can the contract be archived.  When a contract is archived, it is 
put into the FieldMgr\Archive folder, removed from the contracts list, and then you will be 
given the option to copy the archived contract to another location. 
 
To archive a contract – 

1. Click File > Archive Contracts 
 

 
 
2. Click Yes to the archive message 

 
3. Highlight the contract to archive – only those contracts having a final estimate 

with a status of Refreshed are in this list 
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4. If you want printed reports, put a checkmark in the Print Final History box 

   You can select to print any one or more of the following reports.  If you want 
to print the report shown in the heading of the print screen, click OK.  If you 
don’t want to print the report shown in the heading, click Cancel and the next 
report option will be offered. 

a. Item History -  Prints every item progress posting for every item in the 
contract.  Could print many, many pages.   Not a good plan to print this! 

 
b. Final Materials By Item – Since we aren’t using the materials portion of 

the contract, no need to print this! 
 
c. Contract Modifications Summary – A summary list of all the cont mods 

created for the contract.  This report could be very handy to print and 
keep with the final papers when the contract is boxed up for storage. 

 
5. Click Select 

 
6. Click OK when the archive process is finished. 

 Once this process is finished, the contract will be removed from the 
contracts list and put in the FieldManager\Archive folder.  The filename will 
be the contract ID and an extension of .FMA 

 
7. Next, you will be given the option to copy the file in the FieldManager\Archive 

folder  
to another location. 

 

  
 

Answer Yes to the above question.  Copy the file to a location your office has  
designated on the W drive for finaled contracts. 

 
8. Repeat Step 7 to copy the file to any other location required by your office. 

 
9. Once you have all the copies needed, answer No and the archive process will  

be finished. 
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Restoring an Archived Contract 
 

Do not restore and leave an archived contract on the FieldManager 
computer that processes estimates.  Restore to a different FieldManager computer 
if you have that option.  If you don’t have that option, remove the archived 
contract from the processing FM machine as soon as possible.    

Having an archived contract in the FM machine at the time I create monthly 
reports really messes them up – and I start muttering and talking to myself – not a 
good situation or a pretty sight!!!!!!!!!  
 
 
To restore a contract that has been archived – 
 

1. Click File > Restore Archived Contract 
 
 

 
  
  A list of contracts in the FieldManager\Archive folder will be displayed. 
 

2.  Highlight the appropriate contract and click Select 
 
This process will remove the contract from the FieldManager\Archive folder and 
put it back into the contracts list.  The only way to get the contract back into the 
FieldManager\Archive folder is to go through the archive process again. 
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If the contract is no longer in the FieldManager\Archive folder, you can still restore it.  
Instead of highlighting the contract in the list, however, click the Restore From File 
button.   
 

1.  Select the appropriate location in the Look In field 
 (Do NOT restore directly from the W drive.  Copy the file first to the  

A location on your C drive or flash drive and restore from there.) 
 

2.  Highlight the contract you wish to restore and click Open 
 

  
 
 
Remember, once the contract is restored, it is no longer in the source location.  To 
get it back into the FieldManager\Archive folder, you must archive the contract 
again. 
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Getting a New Reference File  
 (Ref File Process) 

 
The reference file will be periodically updated for you and put in the 
W:\Highway\Construction\FieldManagerInformation\FM_Files folder.  The 
file name is FMGRREF.REF. 
 
I will also send a note to everyone with the reference file attached each time I 
create a new one.  You can either save the attached reference file to a flash 
drive, or hard drive and import it into FieldManager or go to the W drive and 
import it directly from there.   
 
Counties – You will be included in my e-mail that has the reference file attached 
 
When you are notified that a new reference file exists, simply import it into the 
FieldManager program.  As stated above, you can either import from a flash 
drive, your hard drive (e.g. FieldMgr\Inbox), or from the W drive.     
 
 At the contracts list in FieldManager 
 Click File > Import > File 
 Select the appropriate drive and file name 
 Click the Open button 
 
If you have multiple datasources, you need to import the reference file into 
each datasource. 
 
If you attempt to import a contract without having a current reference file in 
FM, you’ll be notified that you must update your reference file before the 
contract can be imported. 
 
After the reference file has been updated in FieldManager and an IDR turn 
around file has been imported into FB, the FB user will get a message stating 
their reference file is outdated.  To prevent the FB user from getting that warning, 
you can export one of their contracts (Export-FB) and include the reference file 
and they can import it (Import–FM).  If the FB user has several contracts, you 
need to select only 1 and include the reference file. 
 
Another option is for them to import the reference file directly into their FB 
program (File > Import > Reference From FieldManager) themselves, very similar 
to importing it into the FieldManager program.   
 
    Once the contract is imported by either method into FieldBook, that will do 
the trick and they will no longer get the “out of date reference file” message – and 
they’ll be happy people once again!!! 
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FieldManager Reports, Inquiries, & Queries 
 

There are only 3 reports that we use in the FieldManager program but 
there are over 50 inquiries available.  The major difference between reports and 
inquiries is that reports can be saved and inquiries cannot.   Both can be printed. 

 Inquiries are simply a “snapshot” of the specific area requested at the 
specific time it was requested.  If you did an item inquiry first thing in the morning, 
made item postings, and then did the same item inquiry later that same day, the 
two inquiries would be different.  You could no longer go back and get an inquiry 
with information like the one created in the morning. 

Reports can be created and saved but inquiries cannot.  Let’s look first at 
the 3 reports available. 
 
 
Reports - 

Highlight Contract 78-0061-114 
Click the Misc Rpts button 
 

  
 
Three reports are listed.   We’ll look at each one.  

Since you’ll be using the Weekly Report most often, if you would 
like it at the top of the list so the program automatically defaults to 
it, double click in the Reports header. 

 
 
FieldBook Import Report 

  
 Highlight FieldBook Import Report 
 Click the View button or double click on it 
  A list of all imports to date for this contract will be listed. 
   (none for the contract in our machine) 
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If you highlight the import date that you would like to view in more detail 
then click the View button, details concerning the import selected will be 
displayed such as the sample below. 
 

 
 
 
This report will probably be more helpful to Janet than the “normal” user – but if 
you receive an error during the IDR import process, check out this report for the 
contract mentioned in the error.  It should be very helpful to you. 
 
Close back to the Misc Reports list. 
 
 
Weekly Report of Time Charges 

Before you create a weekly report, you MUST FIRST have 
GENERATED diaries for the days included in the week of the report.  If you 
don’t, the fields in the weekly report will be blank! 

 
You will be using this report a lot which is why you may want this at the 

top of the Misc Reports list - just to make life a bit easier!! 
 
The details of creating a weekly report of time charges are explained in 

Chapter 4.   Return there for more details 
 
 

Close back to the Misc Reports list if you’re not there already. 
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Contractor’s Performance Evaluation Report – 
Highlight the Contractor’s Performance Evaluation and click the View button  
  OR 
Double click on the Contractor’s Performance Evaluation report 
 
As stated in Chapter 6.5, a Contractor Performance Evaluation report MUST be 
approved for EVERY contractor BEFORE a Final estimate can be created.  
Return to Chapter 6.5 for more details. 
 
 
Close back to the contracts list 
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Inquiries - 
Inquiries are snapshots of data requested and cannot be saved.   
 
Highlight Contract 78-0066-114 
Click the Inquiries button. 
An alphabetical list of over 50 inquiries appears (this is a partial list) 

    
  
 The inquiries that have the word “material” in the title will be of no use to 
us since we are not using the materials portion of this program. 
  

Highlight an inquiry of your choice 
Either double click the highlighted choice or click the View button 

The zoom buttons are available for your viewing convenience 
Click the Print button if you wish to print the inquiry 

 
Notice there is neither a Save nor a Save/Close button since inquiries 

cannot be saved. 
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To view all the time charges made to date, select the inquiry titled Daily 

Diary Time Charges by Site 
 
To view all entries made for an item as well as any changes in authorized 

quantity and what estimates contained the payments, select the inquiry titled Item 
History to Date 

 
To view details about the stockpiles, select the inquiry titled Stockpile 

Summary by Stockpile 
 
To view the retainage withheld from payment, select the inquiry titled 

Estimate Vouchers by Estimate 
 
To view all items that have a placed quantity that has not been paid, select 

the inquiry titled Items With Unpaid Placed Quantities 
 
There are many other helpful inquries but the above 5 are my favorites!  

The best way to learn about all the inquiries is to look at them on your own at 
your own speed.   Jot down notes as to which inquiries might be helpful for you in 
your work.  
 
 
  Close back to the contracts list when finished viewing inquiries. 
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FieldManager Queries and Spreadsheets 
 
All the queries and spreadsheets available are located in either the 
W:\Highway\Construction\FieldManagerInformation\FMFiles\QueriesFiles folder 
or the W:\Highway\Construction\FieldManagerInformation\FMFiles\2007 Query 
Files.  If you do not have access to this folder, contact Janet, or Jen in Creston 
Construction (641-782-4518) to have the files e-mailed to you. 
 
Instructions for Using Queries and Spreadsheets – 

The queries and spreadsheets with a file name NOT beginning with 
FB or FB2 are strictly for FieldManager and must be used only in the FM 
program.  Likewise, the files beginning with FB or FB2 must be used only 
in the FieldBook program.    
 
Before the queries and spreadsheets can be used, the files must be copied into 
the appropriate place in your C drive.   

Copy both the .XLS and the .DQY file to a location on your C drive that will 
be handy for you to access.  The .XLS file is the spreadsheet and the .DQY is the 
file that allows the spreadsheet to refresh.  You must have both files to make the 
queries work. 
  
Once the files are copied to the appropriate places, to use the query  – 
 
     1.  Open spreadsheet 
 

2.  Click on Enable Macros if that message is displayed 
  If you are using Office 2007 and open a spreadsheet and there is a 
“Security Warning – macros have been disabled” warning displayed, click the 
Office Button > Excel Options > Trust Center > Trust Center Settings . Macro 
Settings and put the dot in front of “Enable All macros…” ,.  Then highlight 
External Content and put the dot in front of both Enable options (Enable all 
Data Connections and Enable automatic update for all workbook links).  Then 
click OK and then OK again.  Close the spreadsheet and then re-open it 
again. 
 
3.  Click on Enable Automatic Refresh if that message is displayed 
 
4.  To Refresh - - 
       A.  If the contract ID and/or proposal line number is in red and in Row 
   1 or 2, type in the contract ID and/or proposal line number in the  
  appropriate cell(s) then press the Tab or the Enter key.   
       
    OR 
 

B. Put cursor in a populated cell below the row containing the “goofy 
name” headings (e.g. CONTID, PCN, CN, PIPRLINE to name a few) 
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and right click once to display a drop down list.  Left click once on 
Refresh Data  

Do NOT put a checkmark in the “Use this Value/reference for future refreshes” if 
it is displayed. 
 
If you receive a message stating “[Microsoft][ODBC Driver Manager]Data 
source name not found and no default driver specified”, contact Janet.  
This will take some “extra doing” the first time it’s refreshed but can be set 
up so it won’t give you that message again in the future. 

 
5. Once the spreadsheet is refreshed, click the “Copy Formula” macro 
button if one is present on the worksheet 

 
6.  To change contracts and/or proposal line numbers and query again, 
 repeat Steps 4 and 5 above 
 
7.  When finished, close and do NOT save the spreadsheet  

 
      OR     
 
 close and SAVE AS, using a different file name 
 
 
 
 
To Filter Information in the Spreadsheet 
1. Put the cursor in a populated cell under the heading row 
2. Click on the Data tab and then the Filter icon 
3. Click on the arrow in front of (Select All) so the checkmark disappears  
4. Then click so there is a checkmark in front of your choice 
5. If totals were previously displayed, they will now be displayed for only that  
  selection 
6. To change the filter, click on the arrow and select something else 
7. To see all, click on the arrow and select (ALL) 

 
To remove the filter, click on the Data tab and then the Filter icon 
 
 
 
 
 
 
 

Query and Spreadsheet Explanations 
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This list should give you an idea of some existing queries and spreadsheets as 
well as what type of information can be displayed.  Many additional queries have 
been created and more can be created if requested. 
 
 
CL 10 & 12.XLS    (Contract specific) 
CL 10 & 12.DQY    
 If asked, type ReadOnly (exactly as shown in the user ID field) for the 
password even though there are asterisks there. 

Enter Contract ID in Cell C1 and enter Proposal Line No in Cell G1 then 
 press the Enter key.   
Project Number 
Category 
IDR Date 
Hauled From 
Hauled From 
Side 
Hauled To 
Hauled To 
Side 
Load Count 
Load Size 
Quantity Posted  - total at bottom of this column 
Remarks 
 This query is especially helpful for any item that uses Form M006 or 006 
since fields on that form are displayed in this spreadsheet.   

The total quantity is displayed in red at the bottom of Column L 
 
  
 
COLD WEATHERQUERY.XLS    (Global) 
COLDWEATHERQUERY.DQY   
Contract ID 
Project No 
Proposal Line No. 
Category 
Protection 
Quantity 
 Refresh the spreadsheet 

If asked, type ReadOnly (exactly as shown in the user ID field) for the  
 password even though there are asterisks already there. 

 Results will be displayed for every contract listed in FieldManager 
 Will display whether cold weather protection is Y or N and the quantity 
 The total quantity is displayed at the bottom of Column E 
 To reduce the view to a specific contract – 
  Click the Data tab and then the Filter icon.   
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Click on the down arrow in Column A and take the checkmark out  
 of Select All and put it in front of the contract(s) of your  
 choice. 

 
 
 
CONTRACTORS ON SITE.XLS      (Contract specific) 
CONTRACTORS ON SITE.DQY 
 The value of this is dependent on whether or not the inspector  

checks the “on site” field in his IDRs 
IDR Date 
Contractor’s Name 
Beginning Date 
Ending Date 
Contract ID 

If asked, type ReadOnly (exactly as shown in the user ID field) for the 
password even though there are asterisks already displayed. 
 Enter the Contract ID, Beginning Date, and Ending Dates then press Enter 
for an automatic refresh.  To break the list into separate days of the week, click 
the Separate Days of the Week button.   
 Will display contractors working along with the IDR date for each day 
during the beginning and ending dates that were entered.  Columns exist for – 
IDR date 
Contractor name  
Comments 
Payroll Rec’d Date* 
Reminder Sent Date* 
Comments* 

*-  the last 3 columns must be hand entered, they do not refresh 
  
 
 
CONTRACTORSWORKING.XLS    (Contractor specific) 
CONTRACTORSWORKING.DQY  
Contractor’s Name  
IDR Date 
There are also columns where you can enter comments, the date the payroll was 
received, the date a reminder was sent to the contractor about payrolls, and 
another comments area. 
 
   Enter contract ID in Cell C2.  Enter Beginning Date (in yearmonthdate 
format) in C4.  Enter Ending Date (e.g. 20081210) in C6 and then press the Enter 
key to refresh the spreadsheet  
 Will display all contractor(s) who were marked in IDR(s) as being on-site 
between the dates in Cells C4 & C6. 
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 To see only the first day each subcontractor was marked as being on-site, 
click the Delete Duplicates button 
  
 This can be used to see the dates throughout the life of the contract that 
the contractor was on site.  It can also be used to submit the weekly report 
required for payrolls on federal contracts although the ContractosOnSite query 
works excellent for that. 
 
 
 
DAYS ALLOWED.XLS    (Global) 
DAYS ALLOWED.DQY 
 This displays the number of days (original, current, & charged) for each 
site on every contract in your contract list.  It also shows the LD rate per day and, 
if the days charged are more than currently allowed, the total LD dollars due are 
shown and the number of days charged are displayed in blue. 
 
 Open the Worksheet tab 
 Refresh the spreadsheet 

Click the Copy/Paste/Delete Duplicates macro button 
Contract ID 
Site 
Site Description 
Original Number of Days 
Current Number of Days 
Number of Days Charged to Date 
LD Rate Per Day 
Total LD $s Due 
 
 
 
 
FINAL QUANTITIES.XLS   (Contract specific) 
FINAL QUANTITIES.DQY   
  This is still available but not as useful since we no longer are 
concerned about a 125% overrun.  The new QtyTotals.xls is much better 
since it is based on the $50,000 overrun rule and also displays more 
information. 
   
 With the cursor in a populated cell below Row 3 in Column A through G,   
 right click once and then  left click on Refresh.  Enter the contract ID 
 and press Enter.  Once refreshed, click the Copy Formulas button in  
 Columns M-N 
Project No. 
Category 
Proposal Line No. 
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Item Description 
Funded Quantity 
Paid Quantity 
Item Price 
Gross Item Payment 
Over/Under Run % 
Authorized Dollar Amount 
Qty Paid Above or Below Funded Quantity 
Total Gross Dollars Paid for All Items 
 This displays only paid items, not placed. 
 Enter the contract ID and then click on the Copy Formulas macro button 
 Column I – If less than 75% is in red 
   If more than 125% is in blue 
   If is equal to 125% is in green 
    Payment for this item might be held because of the  

125%  overrun rule 
This query displays only PAID items, not placed 
 
 
 
FLAGGER.XLS     (Contract specific) 
FLAGGER.DQY  

Enter Contract ID in Cell A2 and Prop. Line No. of flagger or pilot car in C2  
 and then press Enter 

Project Number 
Category 
IDR date where the posting was done 
Quantity less than 4 hours – total for this column 
Quantity more than 4 hours – total for this column 
Quantity posted – total for this column 
Location 
Contractor 
Voucher No – where posting was paid 
  
To filter in order to view and get totals for a specific contractor – 
 Put the cursor in a populated cell below Row 6 
 Click the Data tab and then the Filter icon 

Click the down arrow in the column beside the contractor heading 
 Take the checkmark out of SelectAll and then put it in the contractor(s) of  
  your choice 
 To see all contractors again – click the Filter icon 
 
This can be used for either the flagger or the pilot car line item.  For items that 
use a different form for documentation this query is not nearly so helpful. 
FUELADJ_&_INCENTIVES.XLS   (Contract specific) 
FUELADJ_&_INCENTIVES.DQY 
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 Enter the appropriate information in the red cells in Column O, then right  
 click in a populated cell below Row 3 in Column A through I and choose  
 Refresh Data to refresh the spreadsheet.   Once refreshed, click the Copy 
 Formulas button in Column M. 
Contract ID 
Project No. 
Category 
Proposal Line No 
Item Code 
Item Description 
IDR Date 
Qty Posted 
Unit Price 
$ Amt for this Posting 
Cells M18-M27 = Quantities for the item in each specific category 
Cells N18-27 = Dollars for the item in each specific category 
Cells O18-27 = % of the item in that category 
Cell M1 = Total dollars paid for the item 
Cell M2 = Total quantity for the item 
Columns R-AK are strictly worksheet columns 
 This query displays all data needed to complete the fuel adjustment 
worksheet. 
 
 
 
HISTORIC VOUCHER ITEM INFO.XLS    (Contract specific)  
HISTORIC VOUCHER ITEM INFO.DQY   
 This can be used but is easier found in the FieldManager program 
Project No. 
Estimate No. 
Category 
Proposal Line No. 
Item Description 
Type of Unit 
Unit Price 
Authorized Quantity 
Qty Paid This Estimate 
Cum Qty Paid as of this Estimate 
% of Authorized Qty Paid 
Dollars Paid This Estimate 
Total Gross Paid This Estimate Not Including Mobilization 

Data displayed will be dependent on the estimate number entered.  
Cumulative amounts are only up to and including the estimate number entered.   

Asks for contract ID and estimate number.  Once refreshed, click the Copy 
Formulas macro button 
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HMA PAVING.XLS     (Contract specific) 
HMA PAVING.DQY     
 Refresh spreadsheet  

If asked, type ReadOnly (exactly as shown in the user ID field) for the 
password even though there are asterisks already displayed 
 Enter Contract ID in Cell A1 & Proposal Line No. in Cell C1 press Enter 
Item Description 
IDR Date 
Inspector’s Initials 
Station From 
Station To 
Side 
Length 
Width 
Depth 
Plan 
Delivered 
Waste 
% Yield 
Lift No 
Quantity – also totals this column 
Remarks 

This should be good for all HMA items, specifically those using Form 
 M019 or 019.  All fields on these forms are displayed in this  
spreadsheet.   

This contains the information needed for the Asphalt Paving History 
reports 
 
 

ITEM INCR-DECR.XLS    (Contract specific) 
ITEM INCR-DECR.DQY   
Enter contract ID in Cell D1 then press Tab or Enter to refresh 
 
If asked, type ReadOnly (exactly as shown in the user ID field) for the password 
even though there are asterisks already displayed there 
  
Project No. 
Category 
Proposal Line No. 
Item Description 
Contract Modification No. 
Initial Authorized Quantity  
Quantity Changed – as per the cont mod 
Current Authorized Quantity 
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Contract Modification Description 
 Only items in the contract specified that have been increased or 
decreased due to approved contract modifications will be displayed.   
  
  
LENGTH-WIDTH-HEIGHT.XLS    (Contract specific) 
LENGTH-WIDTH-HEIGHT.DQY  
 If asked, type ReadOnly (exactly as shown in the user ID field) for the 
password even though there are asterisks already displayed there 
 

   Enter Contract ID in Cell B1, Proposal Line No. in Cell E1, press Enter 
Item Description 
IDR Date 
Initials of the Inspector who created the IDR 
Station From 
Station To 
Height 
Length 
Width 
Quantity – also totals this column 
Remarks 
 
 Good for seeing details and checking calculations for any item that has a 
form with the height, length, and/or width fields.   
 
 
 
PVMT MARKINGS & RMVLS.XLS    (Contract specific) 
PVMT MARKINGS & RMVLS.DQY   
 If asked, type ReadOnly (exactly as shown in the user ID field) for the 
password even though there are asterisks already displayed there 
 
 Put the Contract ID in Cell A1, Proposal Line No in C1 and press Enter 
Item Description 
IDR Date 
Inspector’s Initials who created the IDR 
Sta From 
Sta To 
Side 
Length 
Plan Identification. 
Meas. Factor 
Quantity – totals this column 
Remarks 
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PLAN QUANTITY.XLS   (Contract specific) 
PLAN QUANTITY.DQY 
There are specifically named spreadsheets for months and years so the 
plan quantity items for that time period are as accurate as possible.  These 
spreadsheets are in the 
W:\Highway\Construction\FieldManagerInformation\Plan Quantity Query 
Files folder 
 
If asked, type ReadOnly (exactly as shown in the user ID field) for the password 
even though there are asterisks already displayed there 
 
 Enter the contract ID in Cell B1 and press Enter.   

Once refreshed, click the Copy Formulas button in Columns M-N. 
Item Code 
Item Description 
Category 
Project No 
Authorized Qty 
Proposal Line No 
Placed Qty 
Pending Qty – changes in cont mods not yet approved 
Column K = Listed here only if the item is either a Plan Qty or LS Item for the  
 time period covered by that spreadsheet 
Column L = Dif Between Authorized and Placed Quantity 
 If placed is less than authorized quantity = red 
 If placed is more than authorized quantity = blue 
Columns O and P = LS Items or items considered plan quantity for the time 
period covered by that spreadsheet. 
  
  
  
QTY PL PD TO DATE.XLS   (Contract specific) 
QTY PL PD TO DATE.DQY 
 If asked, type ReadOnly (exactly as shown in the user ID field) for the 
password even though there are asterisks already displayed there 
 
 Enter contract ID in Cell C2 and press Enter 

Once refreshed, click the Copy Formulas & Formats button 
Project Number 
Category 
Item Description 
Proposal Line No. 
Current Auth Qty 
Total Qty PLACED 
Total Qty PAID 
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Pending Changes 
Item Price 
Current Auth $ Amount 
Gross Item Payment 
Qty PLACED Above/Below Auth Qty 
PLACED % Over/Under Authorized 
Qty PAID Above/Below Auth Qty 
PAID % Over/Under Authorized 
 
 
QTY TOTALS.XLS   (Contract specific) 
QTY TOTALS.DQY 
 If asked, type ReadOnly (exactly as shown in the user ID field) for the 
password even though there are asterisks already displayed there 
 
 Enter Contract ID in Cell A1 & press Enter 

Once refreshed, click the Copy Formulas button 
Project Number  
Category 
Proposal Line Number 
Item Description 
Unit Price 
Funded Quantity 
Placed Quantity 
Paid Quantity 
Funded $ Amount 
Placed $ Amount 
Paid $ Amount 
Difference Between Placed and Funded $ 
Diference Between Paid and Funded $ 
$ Amount Unpaid 
Mobilization $  (if is a mobilization item) 
 
Columns Q & R – 
 Total Item Placed $ 
 Mobilization Paid $ 
 TOTAL $ Paid 
 Total Funded $ 
 % of Contract Complete (based on current funded quantity) 
 
 
 
 
 
RETAINAGE.XLS     (Contract Specific) 
RETAINAGE.DQY     
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 Enter Contract ID in Cell A1 and press Enter 
 

If asked, type ReadOnly (exactly as shown in the user ID field) for the 
password even though there are asterisks already displayed there 

 
Project Number 
Voucher Number 
Voucher Date 
Participating Payment for the Voucher – total for this column 
Non-Participating Payment for the Voucher – total for this column 
Stockpile Total for the Voucher – total for this column 
Retainage Withheld for the Voucher – total for this column 
Net Payment for the Voucher – total for this column 
 If the contract has multiple projects, can  filter, if desired, to get totals for a 
specific project only 
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AUDIT & FINAL ESTIMATE PROCEDURES FOR 
FIELDMANAGER CONTRACTS 

When the contract work is finished - 
When all physical work on a contract is finished, a semi-final estimate should be 

processed to pay for any items that haven’t been paid already and/or to charge any 
additional working days that should be.  

** If the semi-final estimate is for a POSITIVE dollar amount, it can be 
processed before the resident audit begins.  (multiple positive dollar amount 
SF estimates can be created and processed if needed) 

** If the semi-final estimate is for a NEGATIVE dollar amount, wait 
until all audits are completed before processing it.  (only 1 negative SF 
estimate can be processed) 

The “All Contract Work Completed” date field in the General folder tab of the Docu 
button must be completed before a semi-final estimate can be generated.  This is the 
date that all physical work on the project is completed.  This date is NOT necessarily 
the project acceptance date.  
 
Final Quantities to the Contractor - 

After the 435 has been signed and once you are comfortable that you have 
determined the final quantities, the resident office should print a list of the items that 
have been paid to date and send to the contractor so they can begin their own audit.  
By doing so, if there is a discrepancy it could be resolved before all audits are 
completed and the final estimate is prepared.   

This list of items can be printed by any of the following methods - 
1.  Create an estimate (you won’t generate it) and print the View Amt Bal report 

which lists every item in the contract as well as what has been paid in both 
quantity and dollar amounts.  The items will be displayed in proposal line 
number order broken out by project and category with totals for each.   

or  
2.  Highlighting the contract in the contracts list, clicking the Items button and 

clicking the Print button.  As long as All is the choice when there are 
multiple projects and categories this will print a “rolled up” list of items.  
You should change the page setup to Landscape (Start > Printers & 
Faxes > highlight the printer > Select printing preferences > Landscape > 
OK) before printing this. 

     or 
3. Opening the QtyTotals spreadsheet in Excel, refreshing the data by  

entering the Cont ID in Cell A1 and pressing the Enter key, then clicking 
the Copy Formulas macro button.  All contract items and their placed and 
paid quantities will be listed by proposal line number. 
 

Enter the date you send the final quantities to the contractor in the Docu > 
Administrators > Final Quantities to Contractor field in FieldManager. 
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The office can wait until all the audits are completed before sending a list of the final 
quantities to the contractor if they prefer.  The option described has, however, been 
successfully used to speed up the process of getting the final estimate signed by the 
contractor since the contractor has already had a chance to check the item final 
quantities.   Another advantage is that the number of days between the date the 435 
was signed and the date the final quantities were sent to the contractor is less.  
 
During this chapter we are going to assume we are transferring files by flash 
drive and that drive is the E: drive. 
 
The Resident Audit 
If the resident auditor is using the regular FieldManager computer - 

To perform the audit, the resident auditor will log on to the resident’s 
FieldManager computer and program using their own ID.  The resident auditor 
should be considered a FieldManager user in this scenario. 

 
If the resident auditor is using a different computer to perform the audit, they should 
have someone with System Administrator security transfer a working copy of the 
contract from the FM machine so they can enter their audit trail information.  To do so -  

On the residency’s FieldManager computer - 
1.  Click File > Export > Transfer Contracts 
2.  Highlight the appropriate contract 
3.  Press the Select button 
4.  Click so the dot is in front of “Transfer the contract” choice 
5.  Press the OK button 
6.  Select the E drive 
7.  Press the OK button (The file is automatically named for you but you  
 can change the file name as long as you leave the extension of  
 .001 as it is) and the contract is transferred to the flash drive 

(This will leave a read only copy of the contract on the residency’s 
FieldManager computer and transfer a working copy to the flash 
drive.) 

On the audit computer - 
1.  Click File > Import > File 
2.  Select the E drive 
3.  Choose All Files(*.*) or Contract Files(*.*) in the List files of type field 
4.  Highlight the filename  
5.  Click the OK button and the contract will be imported immediately 

(Once the file is imported into FM, it is deleted from the flash drive) 
If there is a problem importing due to not having the current reference file, import the 
reference file first and then try again to import the contract.  The reference file is called 
FMGRREF.REF and is located in the W:\Highway\Construction\FieldManager 
Information\FMFiles folder. 
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The resident auditor should leave an audit trail (the date the audit was done and 

comments concerning the audit) by creating an IDR or a diary for that contract and 
making an entry in the comments field of the general folder tab.  These comments 
should include their name and that they are the resident auditor so it can be used in the 
future to identify who performed the audit.  The auditor may add any additional 
comments they would like as documentation of the audit.  This IDR or diary should be 
generated when the resident audit is completed. 

To make a comment about each individual item -  
  Click the Items button 
  Highlight the item and then click the Change button (or double click on the  

item) 
  Click the Documentation folder tab 
  Make an entry in either the Documentation or the Notes field 
  Click the Save/Close  
  Repeat the process for the next item(s) 
   
 
The resident auditor will print a list of the final quantities and make out the standard 
Materials List or Materials Audit List and send to District Materials for them to start their 
audit. This list of items can be printed by any of the following methods - 

1.  Create an estimate (you won’t generate it) and print the View Amt Bal report 
which lists every item in the contract as well as what has been paid in both 
quantity and dollar amounts.  The items will be displayed in proposal line 
number order broken out by project and category with totals for each.   

or  
2.  Highlighting the contract in the contracts list, clicking the Items button and 

clicking the Print button.  As long as All is the choice when there are 
multiple projects and categories this will print a “rolled up” list of items.  
You should change the page setup to Landscape (Start > Printers & 
Faxes > highlight the printer > Select printing preferences > Landscape > 
OK) before printing this. 

     or 
3.  Opening the QtyTotals spreadsheet in Excel, refreshing the data by  

entering the Cont ID in Cell A1 and pressing the Enter key, then clicking 
the Copy Formulas macro button.  All contract items and their placed and 
paid quantities will be listed by proposal line number. 

 
As a part of the resident audit, each item must be marked as completed.   
     To do this for items, one at a time -- 

1.  Highlight the correct contract in the contracts list 
2.  Click the Items button 
3.  Highlight an item and either double click or click the Change button 
4.  Click the Documentation folder tab 
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5.  Click so the radio button is in front of Yes 
6.  Save/Close 
7. Repeat Steps 3-5 for additional items as desired 

     To do this for several items at once – 
1. Highlight the correct contract in the contracts list 
2. Click the Items button 
3. Highlight all items to be marked complete 

(Click the 1st item, press the Shift key, click the last item to highlight all 
items in a row) 
 or 
(Hold down the Control key and click on specific items if they’re not in a 
row) 

 
 
 
 
 
 
 
 
 
 
 
4.  Click Edit > Mark Items Completed 

 
 
 
 
 
 
 
 
A final estimate cannot be created until all items are marked as being completed, 
a date is entered in the “All Work Completed” date field in the General folder tab 
of the Docu button, and all Final type contractor performance evaluations are 
approved. 
 
 
If the resident auditor used a computer other than the residency’s FieldManager 
computer to perform the audit, they must transfer the working copy of the contract back 
to the residency’s FM computer following the audit.  (Remember, you must be a system 
administrator to transfer a working copy of a contract)  To do so - 

On the audit computer - 
1.  Click File > Export > Transfer Contracts 
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2.  Highlight the contract to audit 
3.  Press the Select button 
4. Click so the dot is in front of “Transfer the contract” choice 
5.  Press the OK button 
6.  Select the E drive 
7.  Press the OK button (The file is automatically named for you 

and the contract is transferred to the flash drive) 
(This will leave a read only copy of the contract on the audit 
computer and transfer a working copy to the flash drive.) 

On the residency’s FieldManager computer - 
1.  Click File > Import > File 
2.  Select the E drive 
3.  Choose All Files(*.*) or Contract Files(*.*) in the List files of type field 
4.  Highlight the filename  
5.  Click the OK button and the contract will be imported immediately 

(Once the file is transferred, it is deleted from the flash drive) 
 

Once the working copy of the contract is safely back in the residency’s 
FieldManager computer as a working copy, that contract can be deleted from the 
audit computer.  To do so - 

1.  Highlight the contract in the contracts list 
2.  Click Edit > Delete 
3.  Answer Yes to the “Are you sure” question 

(Since it’s now a read-only contract it can be deleted this way.) 
 
 
When the resident audit is complete, the District Engineering Tech Sr. (ETS) will begin 
their audit. 
 
 
The District Center Audit 
District Audit Preview 
If the Engineering Tech Sr. (ETS) wishes to use their own computer and look at the 
contract PRIOR to their actual audit procedure, they should request a read-only copy of 
the contract from the residency.  To do so a FM user from the residency should - 

On the residency’s FieldManager computer - 
1.  Click File > Export > Transfer Contracts 
2.  Highlight the contract requested 
3.  Press the Select button 
4. Leave the dot in front of “Create a read-only copy of the contract” 

choice 
5.  Press the OK button 
6.  Select the E drive 
7.  Press the OK button and the contract is transferred to the flash drive. 
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The file is automatically named for you.  If this name is changed, 
be sure to leave the .001 extension as part of the name. 

 8. Copy the file to the W drive 
 
 
 
On the ETS’s computer – 
 1.  Copy the file from the W drive to a flash drive  

2.  Click File > Import > File 
3.  Select the location of the file  (E drive in our example) 
4.  Choose All Files(*.*) in the List files of type field 
5.  Highlight the filename  
6.  Click the OK button and the contract will be imported immediately 

(Once the file is transferred, it is deleted from the source.) 
 
District audit on the Residency’s FieldManager Computer 
Once the ETS begins the actual audit at the residency’s location, they will log on to the 
FieldManager computer using their ID.   
 
If the district audit will be on a computer other than the residency’s FieldManager 
computer, they must request a working copy of the contract.  To do so - 

On the residency’s FieldManager computer - 
1.  Click File > Export > Transfer Contracts 
2.  Highlight the contract to audit 
3.  Press the Select button 
4. Click so the dot is in front of “Transfer the contract” choice 
5.  Press the OK button 
6.  Select the E drive 
7.  Press the OK button (The file is automatically named for you) 

and the contract is transferred to the flash drive 
(This will leave a read only copy of the contract on the residency’s 
FieldManager computer and transfer a working copy to the flash 
drive.) 

On the audit computer - 
1.  Click File > Import > File 
2.  Select the E drive 
3.  Choose All Files(*.*) in the List files of type field 
4.  Highlight the filename  
5.  Click the OK button and the contract will be imported immediately 

(Once the file is transferred, it is deleted from the flash drive) 
 
The Engineering Tech Sr should leave an audit trail (the date the audit was done and 
comments concerning the audit)  by creating an IDR or a diary for that contract and 
making an entry in the comments field of the general folder tab.  These comments 
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should state their name and that they are performing the district audit so this entry can 
be used in the future to identify who performed the audit.  The auditor may add any 
additional comments they would like as documentation of the audit.  This IDR or diary 
should be generated when the district audit is completed. 

 
If the district auditor wishes to make a comment about each individual item, to do so – 
 Click the Items button 
 Highlight the item and then click the Change button (or double click on the  

item) 
 Click the Documentation folder tab 
 Make and entry in either the Documentation or the Notes field 
 Click the Save/Close  
  Repeat the process for the next item(s) 
 
When the ETS has completed the audit any corrections that were to be made are to be 
documented in the comments field of an IDR or a diary entry and/or on Audit Form 
830301.  A hard copy of either of these will serve as proof to the ETS that changes 
were made and should be included in the final paper work. 
 
If any changes are made to the quantities due to the audit, those changes must be 
accomplished by the resident office by creating and generating an IDR in the 
FieldManager program and then creating and processing another semi-final estimate.  
This is why it’s important NOT to process a negative semi-final prior to all audits being 
completed. 
 
If the items were not marked as complete during the resident audit, that procedure must 
be done during the district audit.  (See the steps for doing so in the resident audit 
section.) 
 
If the ETS used a computer other than the residency’s FieldManager computer, they 
must transfer the working copy back to it.  To do so - 
(Remember, you must have system administrative status to transfer a working copy) 

On the audit computer - 
1.  Click File > Export > Transfer Contracts 
2.  Highlight the contract 
3.  Press the Select button 
4. Click so the dot is in front of “Transfer the contract” choice 
5.  Press the OK button 
6.  Select the E drive 
7.  Press the OK button (The file is automatically named for you) 

and the contract is transferred to the flash drive 
(This will leave a read only copy of the contract on the audit 
computer and will transfer a working copy to the flash drive.) 

On the residency’s FieldManager computer - 
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1.  Click File > Import > File 
2.  Select the E drive 
3.  Choose All Files(*.*) in the List files of type field 
4.  Highlight the filename  
5.  Click the OK button and the contract will be imported immediately 

(Once the file is transferred, it is deleted from the flash drive) 
 

Once the working copy of the contract is safely back in the residency’s 
FieldManager computer that contract can be deleted from the audit computer.  
To do so - 

1.  Highlight the contract in the contracts list 
2.  Click Edit > Delete 
3.  Answer Yes to the “Are you sure” question 

(Since it’s now a read-only contract in this computer, it can be 
deleted this way.) 

 
 
 
 Creating the Final Estimate - 

After the auditing procedures are completed, the resident office will create a final 
estimate.  There can be NO item payments, working days charged, or contract 
modifications for this contract included in this estimate.  The final estimate strictly 
releases the retainage.  

In order to prevent the word Draft from printing, the estimate must be generated 
which automatically creates a file (VCHRxxx.EXP) in your FieldMgr\Outbox folder.   This 
file must be moved from the Outbox and saved elsewhere to prevent accidental 
payment before all signatures have been obtained.    

If you don’t remove this file, the next time you combine the Outbox files, 
this final estimate will be included and will be sent for processing - 
whether you intended it to be or not!!   

 
To prevent premature payment of a final estimate - 

1.  Create a new folder (if you don’t already have one) named Final Vouchers  
under the C drive – but NOT under the FieldMgr folder  
A.  Highlight the Local C folder on the left side of the screen 
B.  Click File > New > Folder and a “New Folder” folder will appear on the 

right side of the screen 
C.  Type Final Vouchers in for the name of the new folder and press Enter  

(We’ll use this folder in a bit) 
2.  MOVE (not copy) the file created from the final estimate from the Outbox 

folder and put in the Final Vouchers folder.  To accomplish this - 
A.  Highlight the Outbox folder and find on the right side of the screen the 

file created from the final estimate 
B. Highlight that file  
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C. Right click on the file and select (left click) Cut 
D. Right click on the Final Vouchers folder and select (left click) Paste 
 

3.  Once moved, re-name the file in the Final Vouchers folder so the numbers in 
the current filename become 9xx, with the xx’s being incremental beginning with 
01.  The same number should not be used for any other filenames in that folder. 

A. To re-name, right click on the filename and select Rename from the 
drop down list.  Type in the appropriate new name 

(If you re-name the file any other name than 9xx, be sure to keep the 
extension of .EXP) 

 
4.  Copy this re-named file in the Final Vouchers folder to a flash drive or to your 

office’s predetermined location on the W drive which is being used for 
“storing” final vouchers.  This is a “safety net” so there is a second place 
the files are located in case the hard drive should crash. 

5.  Be sure this file is no longer in the FieldMgr\Outbox folder 
 

Even though it won’t have any quantities, print the final estimate (View Estimate 
folder tab) to send to the contractor for signature.  Type or write in the number of 
working days charged for each site in the sentence located in the area just above the 
signature block.  A claimant’s certification no longer needs to be added to this final 
estimate since the wording in the signature block on the estimate takes care of 
that. 
 
A list of final quantities for all items should be submitted to the contractor along with the 
final estimate.  This list can be printed by any of the following methods - 

 1.  Highlighting the final estimate in the estimate list, clicking the Print button, 
and selecting the “Print the 1 selected Amount Balance Report” option.  
This will print all items in proposal line number order broken out by project 
and category with totals for each.  Even though the report is sorted by 
proposal line number, they will not be displayed. 

or  
2.  Highlighting the contract in the contracts list, clicking the Items button and 

clicking the Print button.  As long as All is the choice when there are 
multiple projects and categories this will print a “rolled up” list of items.  
You should change the page setup to Landscape (Start > Printers & 
Faxes > highlight the printer > Select printing preferences > Landscape > 
OK) before printing this.. 

     or 
4.  3.  Opening the QtyTotals spreadsheet in Excel, refreshing the data by  

  entering the Cont ID in Cell A1 and pressing the Enter key, then clicking 
 the Copy Formulas macro button.  All contract items and their placed and 
 paid quantities will be listed by proposal line number. 
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If the contractor does not agree with the quantities, the resident office must reconcile 
the difference and if changes are made, the entire process described above must begin 
again.  The resident auditor must and the ETS may audit those items that have been 
changed. 
 
 
 Processing the Final Estimate - 

When both audits have been performed and the contractor has signed the final 
estimate, the final paperwork packet, including the final estimate and item quantities, 
shall be sent to the District Office. 
 

After the DCE has signed the final estimate, they are to notify the resident office 
that the final paperwork has all required signatures (including materials) and processing 
of the final estimate can take place. 
 
To process the final estimate - 

MOVE (not Copy) the file (VCHR9xx.EXP) back into the FieldMgr\Outbox folder 
on your C drive from the Final Vouchers folder.  There should not already be files in that 
location with the same name (e.g. vchr901.exp) since this file was specially named BUT 
IF THERE ARE, rename yours using a higher number (e.g. vchr905.exp).  Do NOT 
change the extension – it must remain .EXP.  

Once you have done the Combine Outbox step, process the estimate as you 
normally would.  When the processing is complete, import the turn-around-file (TAF) 
into FieldManager.   
 
Finance will process the final payment when appropriate. 
 
Once the final turn-around-file file has been imported into FieldManager, the resident 

office will keep the contract in their contract list until notified that they may 
archive the contract.  Janet will notify the resident offices of such once each 
month.  When a contract can be archived, follow directions for doing so 
beginning on Page 10-8. 
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